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ABSTRACT
This thesis aims to examine the issues involved in utilising digital images and
assess whether image processing techniques can be used as a cost-effective
method of reconstructing the image found in a deteriorated cellulose acetate
negative.

Negatives affected by the vinegar syndrome are found in large numbers within
Australian institutions. This was confirmed by a survey (using a questionnaire)
undertaken at the National Library of Australia in 2000. The survey also found
that although these collections are large, and hence the level of deterioration
variable, little could be done to restore any of the negatives once deterioration had
begun.

Storing negatives at low temperature and low relative humidity slows down the
breakdown of cellulose acetate; however, it cannot reverse the process once it has
commenced. Although removing the gelatine pellicular from the deteriorated
cellulose acetate support (making the image easier to view) a possible method of
restoration, this becomes unfeasible when dealing with a large collection. As a
result, how to manage cellulose acetate negatives once they have deteriorated
becomes problematic.

Image-processing techniques used to digitally restore these negatives were
examined via a series of case studies. These examinations were undertaken using
two software packages−the Image Processing Tool kit (IPTK) and OPTIMAS.
Deteriorated cellulose acetate negatives were scanned, then a number of program
filters were applied to the digital image to determine whether disfiguring elements
(referred to as channelling elements) resulting from the deteriorated support could
be digitally removed.

IPTK and OPTIMAS were not completely successful in removing the deteriorated
elements from the digital version. The results highlighted that a number of issues
relating to the use of digital technology needed to be addressed. These issues
included knowledge of basic technical terms, an understanding of digital
i

language, and how to include the use of digital technology into a long-term
strategy for archiving a digitised collection.

This thesis showed that issues relating to utilising digital systems could be
addressed by implementing a preservation management plan. A preservation
management plan can be used to incorporate the goals of digitising, the long-term
issues of retaining digital files, ongoing access relating to the digital file, hardware
and software, and the importance of having the relevant expertise when
undertaking such a project.

Due to the limitations of the printed hardcopy displaying features in a number of
the images (figures) outlined in this thesis, a compact disk (CD) has been included
with this submission and can be found at the end of this document.
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CHAPTER ONE
INTRODUCTION
This research project was undertaken to address problems associated with the
instability of cellulose acetate, a substrate used to produce photographic negatives.
Cellulose acetate negatives deteriorate over time, causing the image to become
physically distorted and making the image difficult to view.

Many institutions in Australia hold large numbers of negatives at risk of
deteriorating as a result of problems associated with the breakdown of the
cellulose acetate substrate. Once negatives have reached the stage of physical
distortion, the problem of what to do with these collections becomes pressing:
treatment or reconstructing the distorted image, as the options (these are discussed
in section 4.2) are limited. At the time this research was conducted the main
options available for managing cellulose acetate negative collections included the
use of low-temperature and low-relative humidity (RH) storage to slow down
deterioration. These options have met with only limited success. A questionnaire
undertaken as part of this research was able to determine the extent of
deterioration in Australia and the strategies being used by institutions.

The use of digital technology was investigated to determine whether it could be
used as a cost-effective method of digitally reconstructing the image of
deteriorated cellulose acetate negatives. A number of case studies were
undertaken to examine image-processing techniques. These case studies were
carried out in order to gain an understanding of the issues involved in using digital
technology.

The scope of the case study research included:
•

A literature review outlining the history of cellulose acetate and its
deterioration.

•

A literature review to determine the options currently available for managing
cellulose acetate negatives at risk of deteriorating.
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•

Determining the extent of cellulose acetate deterioration within Australia. This
was undertaken in collaboration with the National Library of Australia’s
(NLA) Cellulose Acetate Project via a questionnaire.

•

Examining current issues relating to the use of digital technology within
institutions through a literature review, and a series of case studies.

•

Undertaking case studies using image-processing techniques to examine their
usefulness as a digital strategy for deteriorating negatives.

•

Devise guidelines for a preservation management plan, incorporating the
issues explored and determined through a number of case studies using digital
technology, for deteriorating negative collection in Australia. These were
considered as part of a preservation management plan.

By using image-processing techniques during the case studies, it was possible to
gain an understanding of the issues involved in utilising digital image files as a
conservation or/and preservation tool. The aim of the case studies was also to:
!

Determine whether image-processing techniques could be used as a costeffective tool to digitally reconstruct the image affected by deteriorated
cellulose acetate. Deteriorated 4x5 inch format cellulose acetate negatives
were used for the case studies. Available image processing software
programs−the Image Processing Tool Kit V.3and OPTIMAS 6.5 were used to
determine whether image-processing tools could be used successfully.

!

Determine the basic terminology or language required by conservators when
using digital technology as a strategy for managing deteriorating cellulose
acetate negatives.

This research only investigates the possibility of digitally reconstructing the
image, it does not consider the problem of how to conserve the original physical
material.

The scope of the research included:
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•

A literature review regarding the history of cellulose acetate and its
deterioration.

•

Undertaking a questionnaire as part of the National Library of Australia’s
Cellulose Acetate Project to determine the extent of deterioration in Australia.

•

Examining the current issues relating to the use of digital technology within
institutions through the literature, and undertaking a case study using imageprocessing techniques to determine how these issues arise.

•

Listing a set of guidelines, incorporating this information, to be included in a
preservation management plan established to deal with deteriorating cellulose
acetate collections in this manner.

This thesis is divided into three parts. The first part, Chapters 2-6, gives
background information regarding the history, chemical composition, and
deterioration of cellulose acetate, the extent of deterioration and strategies
currently available for managing deteriorating collections. Terms associated with
the use of digital images, image processing, and issues regarding the management
of digital images are discussed in Chapters 5 and 6. The second part, Chapters 710, outlines the questionnaire devised as part of this research to determine the
extent of deterioration within collections in Australia and the case studies
undertaken using image processing. The final part, Chapters 11 and 12, discusses
the issues involved in using digital images and incorporates this information into a
Preservation Management Plan.
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CHAPTER TWO
CELLULOSE ACETATE NEGATIVES
Cellulose acetate, the generic name used to describe a variety of acetylated
cellulose polymers, has been used as a substrate since the 1920s for motion
picture film and photographic negatives.

The polymers include cellulose diacetate (CDA), cellulose triacetate (CTA)
(which was introduced later) and mixed esters known as cellulose acetate
propionate (CAP) and cellulose acetate butyrate (CAB). When CAP and CAB
were introduced they were thought to have better physical properties than
cellulose diacetate (Ram & McCrea 1988, pp.474-483). However, all of these
polymers show signs of deterioration at some time. Due to the distinctive vinegar
odour (acetic acid) that becomes apparent once deterioration has set in, the term
vinegar syndrome is now commonly used to describe negatives affected by
cellulose acetate deterioration.

2.1

Chemistry

Cellulose acetate is derived from the chemical modification of cellulose, a
naturally occurring polymer. Cellulose is a polysaccharide based on the D-glucose
unit with a 1-4 linkage (Dick 1987, p.37). Substituting hydroxyl groups in the
glycosidic cellulose ring with acetyl groups forms cellulose acetate.

Cellulose acetate is manufactured by treating cotton linters or alpha cellulose
(from wood pulp) with acetic acid (or acetic anhydride in the case of cellulose
triacetate) and with a catalyst such as sulfuric acid. The type of acetate produced
is dependent on the type of anhydride used (Dick 1987, p.39).

In a process known as esterification, hydroxyl groups are substituted with acetyl
groups on each of the glucose units of the cellulose molecule. The number of
substituted hydroxyl groups (the degree of substitution), the molecular weight,
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and the plasticiser also determines the type of acetate produced (Dick 1987,
pp.37-39 & Horie 1999 p.132).

Cellulose triacetate is produced via a process known as acetylation. Triacetate has
all three of its hydroxyl groups substituted, and is ‘fully esterified’. Diacetate is
partially hydrolysed and contains approximately two and a half acetyl groups per
glucose unit (Horvath 1987, pp.4-5). By treating cotton linters with acetic and
butyric anhydride cellulose acetate butyrate is produced (Dick 1987, p.39).

Anti-halation dyes are incorporated into the cellulose acetate substrate (film) at
the time of manufacturer to absorb light in order to prevent halos appearing on the
film. Over time, in some cases, the anti-halation layer or dye may reform. These
dyes which were decolourises during processing and colourless, may reform and
appear when acids are generated. This results in a tinted colour (usually pink or
blue) forming on the negatives (Horvath 1987, pp.12-13).

The substrate or negative consists of a number of layers. These are outlined in the
diagram below.

Gelatine
Metallic silver
Chemical compounds
Silver halide emulsion

Gelatine

Subbing layer

Cellulose derivatives

Cellulose Triacetate support
Backing layer

Plasticisers
CTA
Alkali soluble

Dyes i.e. Anti-halation

polymers

Remaining solvent

Figure 2.1. Cross sectional view of CTA photographic film (Shinagawa et al. 1992, p.139).
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2.2

The History and Instability of Cellulose Acetate

In 1925 Kodak was the first manufacturing company to introduce cellulose acetate
‘safety’ film, in sheet form on a commercial scale (Horvath 1987, p.5). These
early negatives were produced on cellulose diacetate. Later, other companies such
as Agfa, Defender, Dupont Defender, and Hammer began manufacturing film
supports on cellulose diacetate (Horvath 1987, p.5). Cellulose acetate was
introduced to replace the unstable cellulose nitrate substrate, which had replaced
glass plate negatives. Cellulose acetate negatives were marketed and sold as safety
film, because it was generally considered that it would overcome the problems of
cellulose nitrate, which was known for its degradation and high flammability. The
stability of cellulose nitrate became the prime focus of research (Adelstein et al.
1992a, pp.336-346) during the first 50 years of film history, and it became
common for images on cellulose nitrate to be duplicated onto ‘safety’ cellulose
triacetate or polyester. However in spite of the conviction in the ‘safe’ nature of
the alternative, cases emerged where cellulose triacetate degraded whilst cellulose
nitrate remained in good condition. Within a short period, cellulose acetate also
developed instability problems (Adelstein et al. 1992a, pp.336).

Many archivists believed that the vinegar syndrome (discussed in section 3.1)
only affected cellulose diacetate produced before the 1920s, but studies have also
shown problems also associated with cellulose triacetate (Adelstein et al. 1992a,
p.337). Deteriorating cellulose triacetate was reported to the Eastman Kodak
Company within 10 years of its introduction in 1948 (Adelstein et al. 1992a,
p.336). These reports came from places where motion picture film had been stored
in environments with high temperature and relative humidity (RH) levels. For
example, the government of India reported problems with cellulose triacetate film
to the Eastman Kodak Company, which followed other complaints from places
with similar conditions (Adelstein et al. 1992a, p.336).

Later, reports found deteriorating cellulose acetate collections that were stored in
areas where the temperature and RH were high for prolonged periods of time.
These included places such as Singapore, Manilla, Hawaii, India, and Florida
(Ram & McCrea 1988, p.482).
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2.3

Cellulose Nitrate

The need for long lengths of transparent flexible film coated with light sensitive
emulsion was recognised with the introduction of motion picture projectors in the
late 1880s (Fordyce 1976, p495). These early films were on a substrate made of
cellulose nitrate.

Replacing cellulose nitrate with cellulose acetate in a systematic way was
problematic due to the technological limitations at the time in producing a
cellulose acetate substrate. The machine production rates with acetate solutions
were approximately 25% slower than that required for nitrate (Fordyce 1976,
p.495). However, between 1944-48 an intensive effort was made by the Eastman
Kodak Company to make safety film capable of replacing cellulose nitrate
(Fordyce 1976, p.494).

The first production method of manufacturing cellulose nitrate film involved
coating a glass top table with a cellulose nitrate substrate. After allowing volatile
solvents in the substrate to evaporate, the support was stripped from the tables and
coated in a separate step with photographic emulsion (Fordyce 1976, p.493).
These were then cut into strips and perforations placed along the edges and the
film spliced together to produce the required length. Later, continuous coating
machines were developed which consisted of a large wheel on which the coating
solution was cast. The solvent evaporated during the rotation of the wheel and the
support stripped off before the rotation was complete. More curing of the support
occurred and then surface coatings were applied (Fordyce 1976, pp.493).

Cellulose nitrate sheet film ceased to be manufactured by Kodak in 1939 (135-roll
film stopped in 1938, film packs in 1949, and roll film sizes 120 and 620 in 1950)
(Reed 1980).

2.4

Discovery of Cellulose Acetate

Cellulose acetate was discovered by Schutzenberger in 1869 (Aubier 1996, pp.
130-143), but was not used in the photographic film industry until 1909. The
Eastman Kodak Company experimented with the production of a small quantity
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of cellulose acetate film, which was reported in the local newspaper as a
replacement for cellulose nitrate as a film substrate. However, production of this
type of cellulose acetate ceased due to unspecified ‘difficulties’ with production of
cellulose acetate not resuming until the 1920s (Fordyce 1976, p.494).

Cellulose acetate was manufactured by reacting cellulose with acetic anhydride
using a catalyst−sulphuric acid. It was used in limited quantities for cellulose
acetate rayon around 1902. At the time it was not successful for two main reasons.
Firstly, only the fully esterified (or triacetate) could be produced and at the time
was limited in its solubility in practical solvents available. Secondly, cellulose
acetate produced at the time contained traces of chemically bonded sulphuric acid
which resulted in poor heat stability and slow decomposition when aged (Fordyce
1976, p.494).

In 1905 a process was developed and patented that subjected triacetate solution to
partial hydrolysis to produce acetates of lower acetyl content. These were referred
to as ‘secondary acetates’ or acetone soluble acetate. The secondary acetates
contained an acetyl content from 38% to 41% compared to that of 44.8% for
triacetate. The hydrolysis step also removed the use of the combined sulphuric
acid, thus giving it good stability (Fordyce 1976, p.494).

Although production discontinued, due to technological limitations at the time,
manufacturing techniques improved and in 1923 16mm amateur motion picture
film was produced on cellulose diacetate. Cellulose diacetate was the first acetate
to be used commercially. This was due to its ability to be soluble in solvents that
were readily available and less expensive than those required for cellulose
triacetate (Horvath 1987, pp. 4-5).

Cellulose acetate, introduced for home 16mm movies by Eastman Kodak in 1923,
contained a monochloronapthalene plasticiser. This made it a safer material for
home use due to its reduced flammability. Later it was used for x-ray film, by
which time the plasticiser was replaced with triphenyl phosphate. Triphenyl
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phosphate was better retained by the film, improved distortion and shrinkage and
was a better fire retardant (Fordyce 1976, pp.494).

Due to the physical problems associated with early cellulose diacetate, the
expense of production and the slow speed required to manufacture the material,
alternatives were sought. During the 1930s Eastman Kodak developed modified
types of cellulose acetate by reacting cellulose with mixtures of acetic anhydride
and propionic acid or butyric acid. These were known as the mixed
esters−cellulose propionate and cellulose acetate butyrate. They had lower
moisture absorption, and less curl with better flexibility (Fordyce 1976, p.494).

In 1937 cellulose acetate propionate was used for 16mm and 8mm film, and
cellulose acetate butyrate used for X-Ray film and other sheet products, including
graphic arts film. Between 1941-1945 a large amount of 35mm motion picture
film was made on cellulose acetate propionate for the entertainment industry.
Kodak was not producing diacetate after 1940, and was using mixed
esters−cellulose propionate, for motion picture film and cellulose butyrate, for
sheet film (Fordyce 1976, pp.494-495).

The desirable properties required for cellulose acetate film was that it had to have
the stability and solubility of secondary acetate, with the strength and stiffness of
triacetate. This was accomplished by improving the manufacturing process,
making it possible to make acetate with very close properties to triacetate. This
was known as high acetyl cellulose and had a high percentage of acetyl content
(similar to triacetate). It was also free of combined sulfuric acid and therefore
stable against heat and age decomposition (Fordyce 1976, p.494).

In the 1950s, polyester was introduced and used for the production of
photographic negatives. Polyester was used due to its stability, when compared to
the acetylated polymers. Although polyester was considered a relatively
successful alternative, today a number of negative formats continue to be
produced on a cellulose triacetate substrate. This is most likely due to economic
reasons.
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2.5

Summary of Chapter 2

Cellulose acetate is the generic name used to describe cellulose diacetate (CDA),
cellulose triacetate (CTA), cellulose acetate propionate (CAP), and cellulose
acetate butyrate (CAB). It was introduced in the 1920s as a substrate for negatives
and motion picture film to replace the unstable (flammable) cellulose nitrate
substrate.

Cellulose acetate negatives were marketed and sold as safety film. It was thought
that cellulose acetate had better physical properties than cellulose nitrate.
However, this belief was dispelled when cases of cellulose acetate deterioration
appeared in areas with elevated temperatures and relative humidity. Although
cellulose acetate was not flammable (like cellulose nitrate), its physical properties
were problematic. The stability of cellulose nitrate was the prime focus of
research until it became evident that cellulose acetate was suffering from severe
physical deterioration, known as the vinegar syndrome.
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CHAPTER THREE
STUDIES INTO CELLULOSE ACETATE DETERIORATION
The 1930s saw considerable research on the stability of cellulose nitrate (as
opposed to cellulose acetate) by the film manufacturers and the National Bureau
of Standards in the USA. On the basis of the work by Hill and Webber in (Ram &
McCrea 1988, p.476) they (Hill and Webber) found that:
While it is not possible to predict the life of acetate film from these results, the
data show that the chemical stability of the film, with respect to oven aging, is
greater than that of papers of maximum purity for permanent records (cited in
Ram & McCrea 1988, p.476).

However, by 1948 the deterioration of cellulose acetate was being reported
(Adelstein et al. 1992a, p.336), and research commenced into its instability. Early
studies into cellulose triacetate deterioration resulted in the estimation that
negatives on a cellulose triacetate substrate would last up to 200 years, although
this was later proved to be unrealistic (Allen et al. 1992, pp.4-12).

In the early 1960s, Kodak laboratories conducted studies into the stability of
cellulose triacetate (Adelstein et al. 1991, pp.78-90). Kodak’s early research into
the deterioration of cellulose triacetate showed that deterioration could be
determined by measuring the base viscosity, base acidity, tensile elongation,
breaking strength of the film, wet strength of the emulsion, and visual observation
of the emulsion melting point (Adelstein et al. 1992a pp.336-346).

The late 1980s and early 1990s saw an increase in research into the cause of
cellulose acetate deterioration. Valuable and extensive research was conducted by
a number of researchers, including Adelstein, Reilly, Nishimura, Erbland, and
Bigourdan, (1995), Shinagawa, Muarayama, and Sakaino (1992), and Edge and
Allen (1992).

Studies over the last ten years have focused on the impact of intrinsic factors, such
as composition and nature of the plastic, and extrinsic factors, such as climate
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conditions and enclosures. However, other intrinsic contributions to the
deterioration of cellulose acetate have been addressed, such as the effect of
gelatine, the subbing layer, and plasticisers.

Although negatives vary slightly between manufacturers, tests conducted on the
stability of the various cellulose acetates did not support the argument that
cellulose diacetate was any less stable than any of the other cellulose acetates,
such as acetate butyrate, or acetate propionate. Nor did they support any
differences in stability between acetate produced by different manufacturers or
during different years. Although the acetates can have similar behaviours,
differences were found amongst negatives within various collections (Adelstein et
al 1991, pp.78-90).

These differences may be a result of the variations of how cellulose acetates are
developed by manufacturers. For example, Kodak negatives on a cellulose acetate
support have small traces of cellulose nitrate dispersed within the gelatine located
in the subbing layer as seen in Figure 2.1. This subbing layer consists of a mixture
of gelatine, cellulose nitrate or acetate dissolved in water and organic solvents
(Horvath 1987, p.12). The cellulose nitrate ensures good adhesion of the subbing
layer to the film substrate, and the gelatine (in the subbing layer) ensures good
adhesion of the emulsion (Ram and McCrea 1988, p.475).

This has prompted questions over the years about the affect that the cellulose
nitrate subbing layer has on stability, and its potential to trigger off hydrolysis of
the cellulose acetate film, causing it to work in it being a catalyst. However tests
conducted by Ram and McCrea (1988) indicated that this was not the case.

Despite the belief that there are differences between manufacturers and the
various cellulose acetates, one study by Adelstein et al in 1992 found that, from
tested samples, none of the cellulose esters displayed a significant difference in
the amount of acid generated. All the results from the test conducted gave
approximately the same extrapolated times to reach a predetermined acidity level
of 0.5ml (Adelstein et al. 1992b, p.347). This study also found no variation
between films produced by two different manufacturers nor between cellulose
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acetate butyrate film made in 1958 and 1988 (Adelstein et al. 1992b, p.347).
Adelstein (1992b) concluded that, although observations had been made on the
stability of film made by one manufacturer over another, different types of film
have very similar behaviours. Adelstein (1992b) also found no evidence to
support the conclusion that cellulose diacetate was less stable than cellulose
triacetate. The study found that cellulose nitrate was just as stable as cellulose
triacetate when stored in optimal environmental conditions, dispelling the
common belief that cellulose nitrate should be the highest priority for duplication.
However, these results should be viewed cautiously, given that the conclusions
were based only on one film tested.

3.1

How cellulose acetate deteriorates

When cellulose acetate deteriorates, the smell of acetic acid is usually present
before any significant change is visible. Before the change becomes visible, a
chemical change has by this time already occurred (Ram & McCrea 1988, p.475),
and the noticeable odour has lead to the deterioration of cellulose acetate,
commonly known as the vinegar syndrome.

The vinegar syndrome is a chemical reaction that results in acetic acid (or other
organic acids) being released causing distortion to cellulose acetate negatives.
This distortion is caused by the acetyl groups splitting off from the main polymer
chain and reacting with moisture to form acetic acid. The generation of acetic acid
causes an autocatalytic reaction to occur (Horvath 1987, p.23).

At or near room temperature conditions, significant acetate degradation may occur
within three to four decades or less, if storage conditions are adverse (Bigourdan
& Reilly 1998, p.28). ‘Temperature plays a key role in determining the rate of
chemical reactions’ (Reilly 1993, p.16) as heat quickens the chemical reaction.

The mechanism of deterioration involves two separate reactions, deacetylation
(determined by acidity build up) and chain scission (measured by intrinsic
viscosity loss):
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1.

Acid-catalysed hydrolytic deacetylation produces acetic acid. This reaction
is acid-catalysed and once it has started proceeds at an increasing rate.
This is known as autocatalytic behaviour.

2.

Acid-catalysed hydrolytic oxidative chain scission of the main cellulose
chain results in a lower base viscosity and low physical properties. This
affects the physical condition of the substrate, resulting in the substrate
becoming brittle and distorted.
(Adelstein et al. 1992a pp.336-346. Allen et al. 1992, p.4-12).

According to Ram and McCrea (1988 p.474) ‘hydrolysis, common to all organic
esters, requires moisture and is accelerated by heat and acidity or alkalinity’. Dry
heat favours oxidative degradation, and heat in the presence of moisture favours
hydrolytic degradation (or deacetylation). Both of these reactions produce similar
products and cause the polymer chains to be broken. These reactions are acid or
base catalysed and autocatalytic in nature (Ram & McCrea 1988, p.475).

These two reactions do not occur at the same relative rates. Deacetylation occurs
at a faster rate relative to chain scission, as the relative humidity (RH) increases.
Based on observations (for uncoated cellulose triacetate at a given acidity level) it
was found that there was a greater viscosity retention at 80%RH than at 20%RH
(Adelstein et al. 1992a, p.342). This would be expected as deacetylation involves
moisture being present.

When cellulose acetate degrades, it loses acetyl groups and its solubility
characteristics change (Adelstein et al. 1995, pp.281-291). Changes in acidity
relates to the deacetylation of the cellulose ester, and acetic acid to form as the
acetate side groups split from the polymer chain (Adelstein et al. 1995, p.282).

The generation of acid has been identified as the first and most sensitive indicator
of acetate degradation. This is followed by the autocatalytic mechanism where
acetic acid (a by-product of deacetylation) catalyses further decay of the polymer
(Bigourdan & Reilly 1998, pp.28-37).
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3.2

Autocatalytic nature of cellulose acetate deterioration

Measuring the amount of free acidity in the cellulose acetate substrate is the most
sensitive indicator to the onset of cellulose acetate deterioration (Reilly 1993,
p.14). Free acidity or base acidity represents the total amount of acid present in
the substrate (Adelstein et al. 1992a, p.346). Acidity increases prior to the
deterioration of the substrate’s physical properties (Adelstein et al. 1995, p.290).

Increases in base acidity during the early stages of cellulose acetate deterioration
is known as the induction period. Acidity continues to increase and affects the rate
of deterioration. Changes in heat, moisture, and acid also contribute to these
changes. This is due to the relationship between deterioration and temperature and
relative humidity.

First, there is an induction period and then a period of rapid change beyond this
induction period, known as the autocatalytic point. This is the point at which the
reaction feeds itself, acting as a catalyst (Reilly 1993, p.13). Large-scale studies
have quantified the relationship between climate conditions (temperature and RH)
and the chemical stability of cellulose acetate (Bigourdan & Reilly 1998, pp.2837).

The complex nature of cellulose acetate negatives means that apart from this
initiation process other factors affect the deterioration process. These factors are:
•

the presence of moisture,

•

the emulsion layer- gelatine and subbing layers,

•

plasticisers; and

•

storage conditions and enclosures.

3.3

Moisture

Relative humidity (moisture) is a decisive factor in the deterioration of cellulose
acetate, and is a necessary reactant in vinegar syndrome. However, not all
moisture should be removed, in an attempt to ward off the vinegar syndrome, as
some must be retained in the gelatine emulsion to prevent the film or negative
from becoming brittle (Reilly 1993, pp.16-17).
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Although the gelatine emulsion contains moisture, studies into the physical
characteristics of cellulose acetate indicate that the gelatine layer gives some
degree of stability to the film base. This is done through its ability to scavenge and
neutralise acetic acid and partially prevent the diffusion of oxygen into the film
(Allen et al. 1992, pp.4-12).

Hydrolysis, which is common to all organic esters, needs moisture and is
accelerated by heat and acidity or alkalinity. Therefore, dry heat favours oxidative
degradation, and heat in the presence of moisture favours hydrolytic degradation.
Both reactions produce the same decomposition products and are followed by the
break up of the polymer chain, resulting in a decrease in molecular weight. These
degradation reactions are acid or base catalysed (gelatine can be a base or an acid)
and are autocatalytic (Ram & McCrea 1988, pp.475-477).

Hydrolysis is a zero order reaction with respect to acetyl content. Tests conducted
by Allen (1992) showed that deacetylation (in contrast to depolymerisation by
hydrolysis) is independent on moisture concentration and proceeds by first-order
kinetics in the removal of acetate groups (Allen et al. 1992, pp.4-12).

3.4

Effect of the Gelatine and Subbing Layers

The presence of gelatine favours deacetylation over chain scission (Adelstein et
al. 1992a p.342). Gelatine is amphoteric and therefore can resist pH changes by
acting as a buffer from acid or alkali products, which can generate during natural
aging. Acids generated by the degradation of cellulose acetate supports, triphenyl
phosphate plasticiser, and the cellulose nitrate subbing layer, are all buffered by
the gelatine (Ram & McCrea 1988, p.477).

Adelstein (1992) and Ram and McCrea (1988) found that the presence of the
gelatine emulsion may have a beneficial effect in buffering the acids generated by
cellulose ester based films. Under high temperature and RH the gelatine in the
emulsion layer can itself degrade, producing ammonium hydroxide as a byproduct. This reaction helps to further neutralise the acids produced during the
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degradation of cellulose acetate. This results in an increase in the support’s
stability (Ram & McCrea 1988, p.478).

In 1987, Pollakowski suggested that cellulose acetate degradation was caused by
cellulose nitrate used as the adhesive (subbing) layer between the emulsion and
the base (cited in Adelstein et al. 1992a, p.336). However, this was disputed the
following year by Ram and McCrea (1988) who presented data showing that trace
quantities of cellulose nitrate had no significant effect on the permanence of
cellulose acetate (cited in Adelstein et al. 1992a, p.336).

3.5

Plasticisers

Plasticisers are incorporated into cellulose acetate as a fire retardant during the
time of manufacturing. Triphenyl phosphate was the most commonly used
plasticiser (Ram & McCrea, 1988, p.475). Tests conducted at Fuji found that
triphenyl phosphate was the most popular plasticiser of photographic cellulose
triacetate supports (Shinagawa, Murayama & Skaino 1992, p.142).

The type of plasticiser used and its properties can affect the extent of viscosity
retention in the film. For example, phosphate plasticisers caused significant
degradation, whilst phthalate plasticisers had little effect on deterioration. HDDP
(di-phenyl phosphate) was found to initiate the degradation at a very early stage in
accelerated aging tests (Shinagawa, Murayama & Skaino 1992, p.142).

Shinagagawa, Murayama and Skaino’s (1992) study also found that viscosity did
not accurately reflect a decrease in molecular weight as it is also dependent on the
degree of substitution of the acetate. It was however convenient in helping to
detect overall deterioration.

Another study found that cellulose triacetate without triphenyl phosphate was very
stable even in wet conditions but triphenyl phosphate was stable in dry conditions.
Triphenyl phosphate releases di-phenyl phosphate (in wet aging conditions) which
is a strong acid, causing the cellulose triacetate support to decrease in pH
(Shinagawa, Murayama & Skaino 1992, p.142).
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3.6

Storage and Enclosures

Storage of degraded or partially degraded film at lower temperatures and RH has
only a limited beneficial effect in slowing down deterioration. Particularly as
already degraded films can initiate the mechanism of deterioration. Negatives are
susceptible to degradation when the temperature runs ‘significantly’ above 24° C
for prolonged periods of time. At around 27° C, shrinkage and distortion is likely
to occur. Storing negatives for 2-3 weeks between 32° C-38° C is not a serious
problem unless the RH increases above the recommended (50%RH) level (Ram &
McCrea 1988, p.481).

Most of the tests conducted to determine the effect of storage conditions were
usually carried out using vapour-tight packaging, which does not allow the acids
to escape. Rather, they remain in the film and are retained, to catalyse further
deterioration as a result of the small volume of free air in the package. This is not
the case in a real life situation where air is able to circulate more freely in the
enclosure, particularly in the manner that negatives are usually stored. If other
materials are enclosed with the film, such as card or packaging, this also absorbs
some of the acids, resulting in lower acidity (Adelstein et al. 1992a, p.344).

Ram reported greater stability amongst cellulose triacetate film incubated in an
open oven (thus allowing acetic acid to escape) compared to samples in sealed
glass tubes (cited in Adelstein et al. 1992a, p.344). In ‘real life’ situations acids
escape into the atmosphere and adjacent materials (Adelstein et al. 1992b, p.347).

Allen (1992) states that other degradation processes are associated with the
plasticiser and the emulsion layer, both which impart some stability to the film
base. The emulsion layer may neutralise acetic acid and act as an oxygen barrier,
preventing hydroperoxide formation (Allen et at. 1992, p.12). Frequent exposure
to oxygen and release of acetic acid vapours will play a major role in controlling
the equilibrium and rate of reactions involved (Allen et al. 1992, pp. 4-12).

Iron absorbed into cellulose acetate from metal enclosures (during storage) can
also act as a catalyst, accelerating the degradation and deacetylation process
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(Allen et at. 1992, pp.4-12). This is a result of the iron causing acid-catalysed
oxidation of the cellulose backbone. The key initiator (the hydroperoxide groups)
causes an acceleration of the decomposition rate by the iron from the container.
(Allen et at. 1992, p.12).

The stability of the film substrate is affected when negatives are stored in sealed
metal or plastic boxes, resulting in the levels of acidity increasing. In closed
enclosures acids are unable to be released, and the acid content cannot be reduced
to a level where the vinegar syndrome will not be initiated. Further decay will
continue, with partially degraded film at or near room temperature. Negatives
stored in closed enclosures (rather than paper envelopes) will also not allow gases
to be released (Bigourdan & Reilly 1998, pp.28-29).
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3.7

Examples of deteriorated negatives

The vinegar syndrome physically affects the cellulose acetate substrate and results
in physical distortion. This process referred to as channelling throughout this
research thesis. The manner in which negatives deteriorate is dependent on a
number of factors. These include how the negatives were manufactured, the size
of the negative, and the environmental conditions the negatives have been stored
in since their production. Since it is impossible to identify all these factors for any
negative not produced and stored under controlled conditions, predicting how and
when a negative will deteriorate over time is difficult.

Figures 3.1-3.3 illustrate how three separate deteriorating negatives are physically
affected and distorted in different ways. The negatives depict the same subject and
were produced and processed at the same time (during the 1980s) on the same
format (4x5″ film) by the same manufacturer. They had been stored under the
same environmental conditions, yet when the same area of the image was
examined, the manner in which the image was affected by the deteriorating
substrate differed. The size and distribution of the channelled areas are not
uniform, and therefore affect the pictorial content or image in a different way.

Figure 3.1. Detail area taken of sample 1.

Figure 3.2. Detail area of sample 2.

Figure 3.3. Detail area of sample 3.
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Figures 3.4 and 3.5 illustrate the irregular affects of cellulose acetate deterioration.
These negatives were produced between 1940 and 1950 and the manufacturer was
unknown. These negatives also had other forms of deterioration, including
blistering, discolouration (due to the anti-halation dyes reforming), and were
stained. Figure 3.5 had a brown coloured stain down the centre of the image,
which may have been caused by adhesive on the seam of the envelope (used to
store the negative at one time) which had been in direct contact with the negative.

Figure 3.4. Area of deteriorating negative showing a different type of channelling.

Figure 3.5. Another form of channelling. The spotted areas in the image are a result of blisters
being formed on the negative. The brown stain is not visible.
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3.8

Summary of Chapter 3

Studies were conducted on the stability of cellulose triacetate in the 1960s and
through the late 1980s and early 1990s. These studies showed that the
deterioration of cellulose triacetate could be determined by measuring the base
viscosity, base acidity, tensile elongation and breaking strength of the film.
Studies also examined the impact of intrinsic factors such as composition and the
nature of the cellulose acetate substrate, and the effects of extrinsic factors such as
climate conditions, the effect of the gelatine, subbing layer, and plasticisers.

Cellulose acetates, used as a substrate for negatives, have similar behaviours.
There are no differences in stability between substrates produced by different
manufacturers. There was no evidence to support the argument that cellulose
diacetate was less stable than any of the other cellulose acetates, nor that the
cellulose nitrate incorporated into the subbing layer effected the stability of the
substrate.

Cellulose acetate deterioration is commonly known as the vinegar syndrome, due
to the smell of acetic acid associated with it when it degrades. This odour is
usually present before visible deterioration is evident. Deterioration involves a
chemical reaction where the acetyl groups (of the cellulose chain) break off from
the main polymer chain and react with moisture to form acetic acid. The
mechanism of deterioration involves two separate reactions−deacetylation and
chain scission. These reactions cause acetic acid to be released, resulting in the
negatives distorting and channelling.

The generation of acetic acid causes an autocatalytic reaction to occur. This
initiates the mechanism of deterioration, an ongoing process, accompanied by a
continuous (but not linear) increase in acidity. As a result, the stability of the
cellulose acetate substrate is improved when negatives are stored in an
environment where the relative humidity is below 50%, and when stored in
enclosures that enable acetic acid vapours to be released. Reducing the build-up of
acetic acid slows down the onset of the vinegar syndrome.
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Cellulose acetate deterioration is characterised by the odour of acetic acid, the
presence of crystalline deposits (bubbles) on the film, and physical distortion of
the substrate, known as channelling. The affects of deterioration manifests
differently, even when negatives produced at the same time are stored in the same
environmental conditions. The substrate can distort and channel in a nonpredictable random pattern.
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CHAPTER FOUR
EXTENT OF DETERIORATION AND STRATEGIES FOR
MANAGING DETERIORATING COLLECTIONS
‘…fifty years after the introduction of CTA film base, partially degraded film is
common in a large number of film archives’.
(Bigourdan & Reilly 1998, p.29)

As a result of the instability problems associated with cellulose acetate and
knowledge of the research that has been conducted (particularly since the 1980s),
a number of institutions have examined their holdings of cellulose acetate. They
have been keen to determine if their collections were deteriorating as a result of
the vinegar syndrome, as well as to determine the extent of deterioration.

In February 1987, David Horvath of the University of Louisville’s Ekstrom
Library Photographic Archives published a report on the findings of a survey he
conducted on the university’s holdings of negatives, along with the holdings of a
number of other collections within the USA. The report found there were many
examples of deteriorated cellulose acetate in a high percentage of the collections
surveyed in the USA (Adelstein et al. 1992a, p.336). It found that ‘many
collections with safety negatives dating from 1925-1955 are finding problem of
deterioration’ (Horvath, 1987, p.1).

In Australia, although anecdotal evidence suggested that a number of individual
institutions had also found examples of deteriorating cellulose acetate, it was
difficult to determine how extensive this problem was or if it was isolated to just a
few institutions. This was until 2000, when the National Library of Australia
(NLA) initiated the Cellulose Acetate Project to determine the extent of cellulose
acetate deterioration in Australia. The author of this thesis was employed as the
principal researcher in the first stage of this project. The role of the author was to
locate possible stakeholders for the project, devise a questionnaire (with input
from a work group team at the National Library of Australia) to scope the extent
of cellulose acetate deterioration in Australia, collate the information and analyse
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the data. Further information regarding the methodology of the project and the
role of the author is outlined in section 7.1.

4.1

Extent of deterioration in Australia

As part of the NLA Cellulose Acetate Project, forty questionnaires (see Appendix
1) were sent to institutions around Australia to determine the extent of
deterioration (‘Cellulose acetate project stage one: final report’ 2000, p.9). These
institutions (see Appendix 2) were chosen randomly on the criteria that that they
were likely to hold cellulose acetate materials.

From the thirty questionnaires returned from twenty-nine institutions (one
institution returned two questionnaires), twenty-eight had holdings of cellulose
acetate material within their collections. These included negatives, motion picture
film, microfilm, microfiche, and reel to reel sound (‘Cellulose acetate project:
stage one: final report’ 2000, p.11). Appendix 3 outlines these results.

The NLA report found that twenty-five institutions had holdings of negatives
produced between 1925 and 1970 (‘Cellulose acetate project stage one: final
report’ 2000, p.12). Fifteen institutions had conducted surveys on parts of their
cellulose acetate collections, with nine surveying their negative collections. Most
of the surveys had been conducted by larger institutions, and of those surveyed
only estimates on the number of negatives held within the collection could be
given. Twenty-two of the respondents noted (in the questionnaire) one or more
signs of deterioration pertaining to cellulose acetate. These included the vinegar
odour, and distortion to the negative including waviness, channels, or wrinkles
(‘Cellulose acetate project stage one: final report’ 2000, p.10).

The NLA questionnaire provided a general range of numbers for the respondents
to choose from, and it was estimated that there were between 3.6-6.5 million
negatives in total within these collections. Of these, it was estimated that 1.0-2.0
million were likely to be cellulose acetate (‘Cellulose acetate project stage one:
final report’ 2000, p.12). By calculating midpoints from these estimated ranges it
is estimated that of the 1.1million cellulose acetate negatives, 0.18million, or 15%
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were showing signs of deterioration. However, it was recognised by the NLA that
this was only ‘the tip of the iceberg’ and that the number of negatives affected is
likely to be greater (‘Cellulose acetate project stage one: final report’ 2000, p.36).

The NLA report found that of those who reported signs of deterioration, problems
were mostly associated with black and white (silver halide) negatives. Seventeen
respondents had noticed problems only with silver halide negatives, and not
colour of negatives. Of the silver halide negatives, 4x5" format negatives were
most problematic, showing the greatest signs of deterioration (‘Cellulose acetate
project stage one: final report’ 2000, p.12).

The results from the NLA questionnaire suggested that collections of cellulose
acetate negatives in Australia were displaying similar deterioration problems
found by Horvath (1987) in the USA.

4.2

Strategies for deteriorating collections

The results from the NLA questionnaire indicated large holdings of cellulose
acetate negatives in collections around Australia, with a large number of various
stages of deterioration. The size and role of individual institutions would
determine the option or strategy used to manage these collections, particularly
once deterioration had begun. Managing large collections, regardless of the option
chosen, would be expensive, and therefore any solution needs to be cost-effective
and accessible to a range of collecting institutions around Australia. This became
even more apparent after speaking to a number of people at various institutions
(included in the NLA Final report) who had completed the questionnaire.

Although the NLA questionnaire was too general to determine precise strategies
that were most commonly used to manage deteriorating collections, it did indicate
that many institutions followed one or more of the following options or strategies
for managing cellulose acetate negative collections, which may or may not be
deteriorating:
•

Monitoring the collection for deterioration,
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•

Prevention, through the use of low-temperature and low relative humidity
(RH) storage,

•

Producing a surrogate, either by copying the negative to produce a high
quality ‘archival’ copy, or by scanning and utilising image-editing software to
reduce the affects of deterioration; and

•

Treatment; removing or ‘stripping’ the emulsion for a deteriorated cellulose
acetate support and printing in the image or reapplying it to another support.

Early implementation of these strategies become particularly important since
cellulose acetate deterioration can not be reversed once it has begun. The most
effective option available is to reduce the onset of the vinegar syndrome, because
once negatives have started to deteriorate the treatment options become limited.

Treatment options are limited by considerations such as on the type of collection,
size of the collection, and the resources available (including funding and staff).
The following sections (4.3-4.7) briefly outline the options currently utilised for
cellulose acetate collections in Australia and overseas.

For this research thesis, the physical condition of the cellulose acetate negative
was the reason for digitising and performing image processing. As such the
priority in this case was based on the level of physical deterioration. Although not
in the scope of this thesis there are other means by which priority is based,
including the ability to access and use the collection and the significance of the
collection to the institution. These will not be discussed in this thesis, although it
is acknowledged that these factors along with the physical condition of the
collection must be considered by the institution when determining priorities.

4.3

Monitoring for cellulose acetate deterioration

Monitors enable the effects of the vinegar syndrome in cellulose acetate
collections to be detected. Passive indicators or detectors are acid-base indicators
that change colour in the presence of acetic acid by lowering the pH of the
indicator in the presence of the acid vapour. These detection devices are readily
available, and are a cost-effective method of determining whether the collection is
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in the early stages of deteriorating. For example the A-D (Acid-Detection strips
by the Image Permanence Institute) cost $45.00US for a pack of 100 strips, which
is a cheap way of assessing the condition of the collection. These (A-D) monitors
were devised by measuring acidity using the water leaching method (Bigourdan &
Reilly 1998, p.29) and are intended to be used as a short-term detector, rather than
a long-term vault monitor.

Passive indicators were developed after it was found that existing air monitors
(such as the oddy test) used to detect acetic acid in wooden display cases by
tarnishing lead coupons could not be used for cellulose acetate negatives. This
was because of the toxicity of the lead coupons used to conduct the test (Adelstein
et al. 1995, p.289).

A significant colour change occurs when acetic acid is placed in an appropriate
solvent, such as cobalt (II) hydroxide. It oxidises when it reacts with acetic acid,
turning from pink to dark green in colour. However, as it was not soluble in any
practical solvent, the solvent could not be absorbed into paper and therefore did
not have an appreciable colour change in the presence of acetic acid (Adelstein et
al. 1995, p.289). An alternative (to identify increases in acidity of the cellulose
acetate substrate) was developed using an acid-base indicator. This changes colour
through the acetic acid lowering the pH of the indicator (Adelstein et al. 1995,
p.289).

These indicators or detectors contain a dye which changes colour depending on
the level of acidity present. Levels of acidity increase before physical signs of
deterioration become evident. Signs of cellulose acetate deterioration reaching an
advanced stage may include an odour (of acetic acid or vinegar) being present.
However, this odour can be overlooked if there is a good movement of air in the
area where the material is stored. The ability to smell an odour is also dependent
on the concentration of acetic acid in the air at a particular time (Adelstein et al.
1995, p.290).

Passive indicators and detectors are useful tools to determine the level of
deterioration among cellulose acetate collections. They provide information that
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can assist in setting out priorities for managing deteriorating cellulose acetate
collections. Being able to set priorities is useful when deciding on whether a
surrogate should be produced to replace a deteriorating negative, or when
determining negatives at risk of affecting other collection material, which should
be stored separately.

4.4

Prevention

Low-temperature and low relative humidity storage is commonly used to reduce
the onset of the vinegar syndrome, as it increases the lifespan of cellulose acetate,
by slowing down the chemical mechanism involved in its deterioration. When
cellulose acetate is stored at room temperature, the deterioration of partially
degraded negatives continues (Bigourdan & Reilly 1998, p.29). Significant
deterioration occurs when exposed to high humidity; such as above 50%RH or
temperatures above 20 °C for even relatively short periods of time (Adelstein
1992b, p.349-352). Adelstein (1992b, p.351) states that ‘just a 10 °F decrease in
storage temperature will increase the film life by a factor of 2’. A study
undertaken by Ram and McCrea (1988) that also showed the benefits of lowering
the storage humidity to reduce chain scission occurring. This is due to
deterioration of cellulose acetate being temperature dependent and the greater
activation energy associated with an acid-catalysed reaction (Ram & McCrea
1988, p.479).

As such, a decrease in temperature will decrease the reaction and the level of
degradation, to a much larger extent than deacetylation (Ram & McCrea 1988,
p.480). The current ISO (International Standards Organisation) standard−ISO
18911:2000 recommends a storage temperature with a range of storage
conditions. The highest temperature recommended is 7 °C with 20% to 30%RH.
However, decreasing the storage environment even a few degrees below the
current storage conditions, will have a beneficial effect (Reilly 1993, p.16). This is
why low-temperature and low relative humidity storage is commonly used to
reduce deterioration of cellulose acetate negatives.
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4.5

Enclosures and Acid Scavengers

Enclosures protect cellulose acetate negatives from physical damage, however
some studies (Allen and Edge as cited in Adelstein et al. 1992a, p.336) suggest
that the choice of enclosure may be a factor in cellulose acetate deterioration. The
effects of enclosure materials on cellulose acetate deterioration have been
examined, particularly in relation to the storage of motion picture films.

Acid scavengers remove catalysing acids, thereby slowing down deterioration, but
do not reverse the process once deterioration has begun. Acid scavengers (such as
molecular sieves) use zeolites to trap moisture and acetic acid vapours (Bigourdan
& Reilly 1998, p.31). By placing the acid adsorbent inside the enclosure (within a
microenvironment) acids are reduced.

Studies have shown that the chemical reaction rate involved in the deterioration of
cellulose acetate is increased in the presence of strong acids (Allen et al. 1992,
pp.4-12). To reduce the reaction rate, acetic acid vapours (a by-product) should be
removed from the film. This is achieved either by releasing the vapours in the
enclosure, or by using an acid scavenger to slow down the autocatalytic nature of
hydrolysis. However, Allen (1992) suggests this is only relevant after the
deterioration mechanism has already started.

Due to the rate at which acid diffuses, removing catalysing acids from storage
enclosures can slow down the vinegar syndrome. Reducing the amount of air
stored within the enclosure will slow down catalysing acids. As acid diffusion is
temperature dependent, incubation temperatures should be used for
microenvironmental studies at close to room conditions to reflect real life
situations. Bigourdan & Reilly (1998) found that at temperatures between 21 °C
and 40 °C, the acid diffusion rate was slower for roll film than for sheet film,
taking several months to reduce acid content in the film although it was loosely
rolled.

Studies by Bigourdan & Reilly (1998) also suggest that opening enclosures will
promote the removal of vapours. Theoretically, selected enclosures and controlled
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microenvironments can facilitate ventilation, neutralise acid, adsorb acid vapours,
and reduce moisture content (Bigourdan & Reilly 1998, pp.28-37).

4.6

Surrogates

Producing a surrogate (or copy) is one of the most common strategies used to
manage deteriorated cellulose acetate negatives in Australia (‘Cellulose acetate
project stage one: final report’ 2000, p.20). Producing surrogates or copies ensures
that the image can still be viewed, even if the original negative deteriorates.

Copying or duplicating cellulose acetate negatives involves the following:
•

Producing a negative by copying the original negative to another more stable
substrate or support, such as polyester. This copy may or may not be the same
size as the original negative. Copying can be carried out either by using an
optical system (an enlarger) or by ‘direct’ or ‘contact’ duplication. Interpositive negatives (where a negative is produced from a positive) produced
from the original negative may also be used. These can be produced either by
direct contact or via the use of an optical system, such as a camera.

•

Printing the negative onto sensitised photographic paper to produce a positive
(print) of the image. This can be effected either by using an optical system,
such as an enlarger, or by ‘direct’ or ‘contact’ printing.

To ensure long-term stability, surrogate negatives and prints should be processed,
washed, and toned according to archival standards (ANSI/ISO 10602-1995).
•

Scanning the original negative to produce a digital image, which can be either
a positive or negative. The advantage of a digital image file is that if the
original negative has deteriorated, the digital surrogate can be ‘restored’ using
image-editing software such as Adobe Photoshop.

To ensure that the optimum image quality is retained, surrogates or copies should
be produced prior to the negative becoming physically distorted. A number of
factors that will determine the type of surrogate include:
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•

the intended use of the surrogate and whether it is to be regularly accessed or
to put aside as a preservation copy,

•

the size of the collection,

•

funds and resources available; and

•

expertise available.

Although some discussion on various surrogate options available were included in
the NLA Cellulose Acetate Project Final Report: Stage One (2000, pp.28-31), the
data obtained from the questionnaires did not provide a clear indication of what
surrogate options had been chosen by various institutions around Australia. Nor
did the report indicate what factors the institutions considered when a copying
option or strategy was chosen. It was also difficult to determine the level, quality,
or amount of digitisation being undertaken by respondents who indicated that they
were digitising. However, five of the respondents who stated they were copying
for access only, were also digitising (‘Cellulose acetate project stage one: final
report’ 2000, p.28). This suggests that the level of digitising being undertaken
may only be adequate for access purposes only, and not as a long-term
preservation tool.

Although the questionnaire did not provide any further information, the results do
suggest that the highest technical level of digitisation was not being undertaken.
This suggestions arises from the lack of expertise, knowledge, and funding that
the respondents listed as being the main constraints in dealing with the
institutions’ cellulose acetate collections (‘Cellulose acetate project stage one:
final report’ 2000 p.35).
4.7

Treatment

Treatment is an option for original cellulose acetate negatives severely affected by
the vinegar syndrome. Treatment involves separating the silver gelatine emulsion
(known as a pellicle), where the image is formed, from the deteriorating cellulose
acetate substrate (known as emulsion stripping). It involves the use of organic
solvents to dissolve the cellulose nitrate subbing layer, located between the
emulsion and the anti-curl layers and the cellulose acetate substrate (Munson
1997, pp.56-57). Once the emulsion has been separated it can be copied (as is) or
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re-supported onto a stable substrate. Due to the risk involved with this type of
treatment, copying is recommended prior to attempting either of these treatments.

None of the respondents undertaking the NLA questionnaire stated they were
undertaking this treatment for their cellulose acetate collections (‘Cellulose
acetate project stage one: final report’ 2000 p.33). This suggests that this option is
not considered a viable solution, due to the cost, time, and risk involved. The lack
of knowledge and expertise (in Australia) in this area may also be another
contributing factor. The treatment would not be considered a cost-effective and
viable option, particularly for large collections or those (small or large) with
limited funding to deal with deteriorating cellulose acetate.

Commercial firms offering this service were investigated, during the course of this
research to determine whether, if undertaken on a large scale, treatment may be
cost-effective. There were no firms in Australia offering this service, and only one
firm−the Chicago Albumen Works, in the USA was located. According to Doug
Munson from the Chicago Albumen Works, they had a very good success rate
with their acetate stripping and recovery service. At the time the research for this
thesis was conducted, this treatment was only performed for six-months of the
year (winter months), during which time one thousand negatives were treated
(stripped) (D Munson 2000, pers. comm., 25 April).

4.8

Summary of Chapter 4

The findings from the National Library of Australia’s Cellulose Acetate Project
determined a need for cost-effective and accessible solutions for managing
deteriorated cellulose acetate negatives within Australian cultural institutions.
Respondents indicated that although the need for low temperature and low RH
storage was seen as a priority, the costs involved in building and maintaining the
storage was perceived as prohibitive, particularly for smaller institutions. This
indicated that a strategy for dealing with these collections needed to be practical
(in terms of being implemented) and cost effective. The majority of institutions
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who had access to, or were using low temperature storage for their cellulose
acetate negative, were predominantly larger state and national institutions.

The NLA report determined that a number of institutions in Australia were using
or supportive of the use, of low temperature and low RH storage for cellulose
acetate negatives. Many thought the best solution would be to use this strategy in
combination with a copying program, by producing surrogates of cellulose acetate
negatives (at risk of deteriorating) prior to them being physically affected by the
vinegar syndrome.

The use of passive monitors, to determine the level of deterioration (if any) within
the collection, is a useful tool to assist with setting priorities for copying. These
monitors can be used to determine whether cellulose acetate negatives have
reached the autocatalytic point, the point at which cellulose acetate rapidly shows
physical changes of deterioration.

In Australia the strategies most commonly used for deteriorating cellulose acetate
collections were to store them separately from other parts of the collection, which
may include low temperature and low RH storage. This is carried out in
combination with copying the material, using either traditional analogue copying
or digitising.

This research thesis wanted to examine whether using image processing for
digitally restoring the deteriorated negatives could possibly be used as another
strategy.

34

CHAPTER FIVE
USE OF IMAGE PROCESSING AS A TOOL FOR IMAGE
RESTORATION
‘Human vision is primarily qualitative and comparative, rather than quantitative’
(Russ 1999, p.4)

The options outlined in the previous chapter show that there are currently a
number of strategies available for preserving and managing cellulose acetate
negatives. However, none of the options reverse the affects of the vinegar
syndrome or provide a cost-effective solution for viewing the image once it
becomes obscured by distorted wrinkles caused by physical deterioration.

Image processing is the term used for altering the appearance of an image
(D’Amato 2000, p.6) by using typically available image processing tools and
filters (see section 5.1 for more information regarding the use of these tools).

The current means of digitally reconstructing images is through the use of a
manual operator to perform image editing (such as Adobe Photoshop). This
procedure is time consuming and expensive, making it unfeasible for a large
collection of negatives. Although manual operation is also required to use imageprocessing techniques, the application of a software program (for example the
Image Processing Tool Kit) is less labour intensive, and therefore less time
consuming than image editing. Further information is outlined in section 5.1,
regarding the use of image processing.

Prior to undertaking the research for this thesis, a search was undertaken for
anyone using or researching the use of image processing to digitally restore
negatives. Digital image restoration (Chong 1998, pp.1-7) was being used for
motion picture film, however no one was using it for cellulose acetate negatives.
Mark Henry (from Kodak USA) who was involved with digital restoring motion
picture film, was contacted and asked whether he was aware of any commercial
firms undertaking the use of image processing techniques to digitally restore
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image files of deteriorated cellulose acetate negatives. His response was that he
was unaware of any firms working with negatives, and that although there were
some techniques available for digitally restoring motion picture film, they were
not ‘fully applicable to still image’. His feeling was that this was predominantly
because they do not have the same ‘economy of scale’ (M Henry 2000, pers.
comm., 3 May).

To determine whether image-processing techniques could be used to digitally
restore the images found in deteriorating negatives, a series of case studies
examining the use of image processing applications were undertaken. The aim of
these case studies was to examine and explore the issues involved in utilising
digital technology. In particular the case studies were designed to determine:
•

whether readily available software could be used to restore a digital image
file, with less manual operation than that required for image editing software
(ie. Adobe Photoshop),

•

the issues involved in creating and utilising digital image files,

•

the knowledge required by conservators when undertaking the use of digital
technology (as a strategy) for managing deteriorating cellulose acetate
negatives; and

•

how to incorporate these issues into a cost-effective preservation management
plan.

This chapter outlines the issues and terminology the conservator must understand
when utilising image-processing techniques. It is only a brief summary of a
number of key issues and terms, which have been widely published and are
readily available. These are located at the National Library of Australia’s
Preserving Access to Digital Information (PADI) website1.

An understanding of these terms was necessary to perform the functions outlined
in chapter 9 and 10 in the case studies. It is assumed in this chapter that the
conservator does not have an Information Technology (IT) background or any

1

http://www.nla.gov.au/padi/
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basic understanding of the use of digital technology. This chapter examines
whether the digital image could be reconstructed to enable it to be viewed more
clearly using image-processing techniques.

5.1

What is image processing?

Image processing differs from image editing or manipulation, where all or part of
the image is changed intentionally for a specific end purpose. However, these
differences may be blurred at times (Holm 1995, pp.194-201). The most simplistic
example of image editing is when applying an unsharp mask or filter to a digital
image to give the image sharper clarity using Adobe Photoshop.

Image processing is the concept of rearranging a digital image file to make it more
pleasing (or interpretable) to the human eye without reducing the amount of ‘data’
(bytes or pixels) in the image. This is made possible as the computer (unlike the
human eye) can interpret digital information quantitatively. To do this the image
is transformed from a three dimensional image (as is visible to the human eye) to
a spatial or two-dimensional image made up of binary numbers (see section 5.4
for further explanation). By transforming the image into a series of numbers,
mathematical calculations can then be performed, thus enabling various functions
(using filters) to be carried out on the image.

Generally, image processing is used for two purposes;
1.

to improve the visual appearance of images to the human view; and

2.

to prepare images for measurements using the features and structures
present in the image.

‘Computer-based image processing and analysis uses algorithms based on human
vision methods when possible, but also employs other methods that seem not to
have counterparts in human vision’ (Russ 1999, pp.6-7).

Image processing and digital imaging techniques are used for many applications.
In conservation, they have been used to ‘reconstruct’ or ‘enhance’ digital images
of historical works, to obtain information which otherwise would have been lost

37

or obscured. In the field of preservation and conservation, the use of these tools
includes:
•

the application of a median filter to a digital image of a painting and ‘digitally’
filling in dark cracks. This removes fine cracks from the digital image of the
painting (Russ 1999, p.208).

•

calculating the topography of a digitised cuneiform tablet to measure changes
on the surface of the text (Barbu 1999, p.10).

•

the use of electronic sensors with digital image processing to improve the
legibility of ancient texts found on the Dead Sea Scrolls. This was done using
multi-spectral image analysis (Johnston n.d.).

•

the use of a confocal laser scanning microscope (CLSM) to digitally
reconstruct Archimedes Palimpsest, a tenth century parchment that had text
and diagrams which had been obscured by another text written over the top of
the original (Christens-& Bernstein 2001, pp.202-205).

•

the use of image-restoration algorithms (Revival) to blur edges of moving
objects, as in a moving image such as a video (Chong 1998, p.1-7).

5.1.1

Image processing functions

The simplest way that image processing functions can be performed is through the
use of available software programs using tools such as filters. IPTK and
OPTIMAS are examples of two such software programs.

Image processing functions are performed to enable qualities found in the digital
image file to be determined by:
•

pattern recognition.

•

image enhancement.

•

obtaining measurements (in the image file) to extract certain types of
information. This is known as an image operation, which uses algorithms to
locate data that make up parts of the image.

To perform image processing the original deteriorated image (in this case a
cellulose acetate negative) must be transformed into a digital image file. The case
studies used during this research thesis utilised a flatbed scanner to transform the
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negative from a pictorial image to one composed of discrete pixels of digitally
quantitised brightnesses. This enabled image-processing functions to be
performed. The number of grey values in the original negative (determined by
variations in metallic silver deposited on the film to form pictorial information)
was transformed into digital data (or information).

All the information present in the original negative is required to successfully
implement image-processing techniques. This can be achieved by scanning at the
maximum resolution, to ensure that all the information (or dynamic range)
available in the original negative is captured. See section 5.3 for further
information regarding resolution.

5.1.2

Using image processing as a preservation tool

To utilise image processing techniques as a tool to digitally restore deteriorating
cellulose acetate negatives, conservators need to overcome the technical and
language barriers associated with understanding any digital system. According to
Frey and Reilly (1999, p.15) ‘The lack of communication between the technical
field and institutions remains a formidable obstacle’.

To undertake image processing, the conservator needs to have a basic
understanding of image processing tools, as well as knowledge of the general
digital terminology used in image processing. Understanding the language used in
image processing can be particularly problematic for the conservator, as much of
the technical information available on this topic is aimed at those already familiar
with this ‘digital’ language. This is made even more difficult as much of image
processing is based on complex mathematics, which can be difficult for the
conservator to interpret if they do not have a deep understanding of, or a
background in, mathematics or computer programming. As such, it is important
for a conservator if are unfamiliar with these concepts to collaborate with
someone with a background and knowledge in image processing. Collaborating in
this manner will enable the information to be translated in a digestible form, easy
for the conservator to follow.
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The conservator should gain a basic understanding of the general concepts and
terms used in image processing techniques. This should be achieved prior to
undertaking a project implementing the use of such digital technology. They
should have an understanding of the issues affecting image quality and the impact
of image manipulation. The conservator should also have a basic understanding
of:
•

The intended use of the digital image as this will impact on resolution and file
size captured or generated.

•

An understanding of the relationship between pixels and grey values, and
how this affects image quality.

•

The effect of compression and file formats to image quality. The greater the
degree of compression the greater the loss of image fidelity.

•

Histograms.

•

An understanding of image processing and the use of filters.

Image processing involves using various image capturing and illumination
devices, all of which affect the image quality and how the information is rendered.
The conservator should carry a clear understanding of how this is achieved
without compromising the image. The conservator should also have some
knowledge on the various to image capturing devices available.

5.2

Utilising digital technology to manage a collection

The success of utilising digital technology as a preservation tool will improve if
the conservator has an understanding of the aforementioned issues. Prior to
utilising any type of digital technology as a strategy (in this case for a collection
of cellulose acetate negatives) it is imperative that the purpose or goals of the
project and the intended use or uses of the digital file are carefully considered.
Although it is not always possible to foresee the use of digital image files in the
future, careful consideration of potential uses should be given as this will
determine the level of scanning required. This also impacts on the costs likely to
be involved for the project.
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One of many decisions that must be made will be the type of resolution required
for each image and an understanding of the limitation of the resolution chosen.
This decision will need to be made prior to beginning any digitisation. Although
not always possible, an attempt should be made to ascertain the likely uses of the
digital file. If this can not be determined, the negatives should be captured at the
maximum optical (the physically limitations of the CCD or charge-coupled device
resolution possible after considering all the constraints on the institution. This will
ensure that any digital files created can serve as surrogates for the original
negatives once they have deteriorated. However, other issues, not only those
relating to the image file size, need to be considered to ensure the long-term
survival and availability of the digital files in the future (see chapter six).

As previously mentioned, the conservator should have some basic knowledge
prior to undertaking any digitisation or image processing. By implementing the
case studies during this research thesis it was determined that as a minimum (even
when collaborating with those skilled in digital systems) the conservator should
be able to:
•

understand the term resolution and its limitations,

•

understand the concept of a pixel and grey values,

•

calculate pixels to determine resolution and file size,

•

understand the use of and implementation of histograms,

•

have an awareness of the various image capture devices, and how they are
used,

•

understand the difference between a lossy and lossless compression ratio and
how this impacts on various file formats use and size; and

•

have a basic understanding of filters and how they are used in image
processing.

To understand these issues the conservator needs to learn a new language,
uncommon in the field of conservation. The terms and concepts will be discussed
briefly in the proceeding pages.
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5.3

Resolution

The term resolution is used to describe the amount of information (or data)
expressed as pixel values in the image. There is a direct correlation between the
resolution and the image size, and an indirect correlation between the resolution
and the image quality.

Capturing (or scanning) an image at different resolutions will affect the resolution
and hence the size of the digital image file. Selecting insufficient resolution may
limit the use of the digital application. Resolution must be determined based on
the intended use of the digital file, and not driven primarily by the funds or
storage space available (it is acknowledged that funds and storage space are
important, particularly when dealing with large collections but these should not be
the primary determinants). Other factors, such as the importance of the material
and its priority within the institution, also need to be considered (these are
discussed in chapter six).

If the size of the image is accurately calculated most (if not all) of the information
in the original negative can be captured. This information if known as the dynamic
range (or the total tonal grey values) present in the image. Although the dynamic
range can be captured, it does not account for variations in film speed and silver
morphology, all of which affect contrast and tonal range in the original silver
halide negative and the digital image file created (Frey & Reilly 1999, pp.20-21).

Resolution and the size of the digital image will determine the amount of time
required to view, retrieve, and process the image and the amount of storage space
required. All which impact on the time and cost involved in digitising a large
collection of negatives.

5.4

Pixels and Grey Values

A digital image is not made up of pictorial information (as viewed with the eye),
but rather of variations in brightness or grey values, which are represented by
pixels. The number of pixels depend on the amount of ‘grey values’ present in the
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original image. The range of grey values is known as the dynamic range (Baxes
1984 pp.21-27, 33-34).

Each pixel is represented by a series of binary numbers known as bits. These are
represented by numerals—either 1 or 0. These numbers relate to either a light or
dark pixel that make up the image. There are 0-255 varying grey values that can
be represented in the image, white is 0 and black is 255. The numerical values
between 0-255 vary in grey values (tones) between white and black (Cost 1997,
pp.3-4).

The number of pixels present in the digital image determines the resolution and
file size, and indirectly determines the sharpness of the image. The bit depth of the
capturing device and the number of channels in the image will also affect size.
This will be discussed further in Section 5.4.1.

A digital image is formed on an electrically charged microchip (usually made of
silicon) which has a light-sensitive surface. The chip is designed as a ‘mosaic’ and
contains hundreds of thousands of discrete minute areas that act as photoreceptors.
Each is capable of registering pictorial information, from the image being viewed
or captured, and is called a pixel or a picture element, see Figure 5.1.

The silicon charge-coupled device (CCD) converts the image into an array of
electrical charges that are proportional to the intensity of the light falling on each
pixel or light-sensitive square (Stroebel, et al. 1986 p.409).

Figure 5.1. How an image is made up of varying grey pixel values.
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Hundreds of thousands of pixels can be found in a 5cm region of any image. As
light falls on the chip, each pixel generates electrical signals that are proportional
to the illuminance. The greater the number of separate (or discrete) pixels possible
per unit area of a chip, the higher the potential image quality (Stroebel, et al. 1986
p.409).

The term resolution has been described in a number of ways, depending on the
manner in which the image is being viewed. These include terms such as pixels
per inch (ppi), dots per inch (dpi), and lines per inch (lpi). Although resolution is
commonly referred to as dpi (dots per inch) this is technically incorrect and
confusing (D’Amato 2000, p.12). The correct descriptions to refer to resolution
are:
•

ppi, used to describe to on-screen or digital resolution. It should be used when
creating an image file,

•

dpi, to be used when referring to a printers resolution (printing dot);

•

lpi, to be used when referring to a printing technique, such as offset.
(Colet 2000, pp.6-7).

5.4.1

Channels and Bytes

The number of channels and bytes present in an image is another factor that
determines its size:
•

A greyscale or monochromatic image has a single channel.

•

A full colour image has three (RGB) channels−one for the red, one for the
green, and one for the blue. As it has three channels it will hold three times
more information than a greyscale (single channel) image.

•

Images that are printed (offset) are converted to four (CMYK) channels − one
for cyan, one for magenta, one for yellow, and one for black.

The number of bits or bytes will depend on the number of channels present. For
example, in an 8 bit greyscale image, each pixel can accommodate 8 bits. Eight
bits is equal to one byte, and can have 0-255 possible grey levels with the number
of each value (0-255) depending on values in the original image. For example, an
RGB image can be represented as a 24 bit image consisting of three 8 bit

44

channels−one channel for red (R), one channel for Green (G) and one channel for
Blue (B). In this case one pixel equals three bytes (Cost 1997, p.5).

Those pixels that straddle a boundary effectively average the brightness levels of
two adjoining regions and can have an intermediate brightness that depends on
how the pixels lie with respect to the boundary. This means that a high lateral
pixel resolution and a large number of distinguishable grey levels are needed to
accurately locate boundaries (RUSS 1999 p.19).

The digital image file size and storage space required for a digital image file can
be determined by calculating the final file size using either of the following
methods (Williams 2000, p.9):
1.

Pixel dimension X number of channels = file size.

2.

Dimensions in inches X resolution per inch X number of channels = file
size.

5.4.2

Pixels and Bytes

The term pixels and bytes can be used interchangeably for greyscale digital
images. For example in an 8bit depth image, one pixel equals one byte. However,
as images are usually made up of large numbers of pixels, it is easier to represent
these vast numbers of pixels as megabytes (MB), or as kilobytes (KB).

A simple calculation can convert the number of pixels present in an image to the
number of megabytes (MB). This is based on 1MB representing or being equal to
1000 Kilobytes and 1KB representing or being equal to 1024 Bytes (Mueller
1996, p.692).

5.4.3

Greyscale image

To calculate a single channelled grey image, multiply the height and width (in
inches) of the original negative by the intended resolution or the resolution being
used:
•

Dimensions in inches X resolution per inch = number of pixels
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Example one
5 (inches) X 300 (dpi)=1500 pixels
4 (inches) X 300 (dpi)=1200 pixels
∴1500X1200= 1.8 million pixels

Based on this calculation capturing (by using an 8bit scanner to produce a single
channel greyscale image) all the information present in the original 4x5" negative
will result in a digital image made up of 1.8 million pixels.

5.4.4

RGB

For RGB digital image files, multiply the size of each of the channels, calculated
in example one, one by three to represent each RGB channel. The same 8bit
image in colour will produce an image with 5.4 million pixels.

Example two
1500 X 1200=1.8 million pixels (this represents the size of one channel)
∴1.8 X 3 = 5.4 million pixels or bytes

Using this theory, the number of pixels in any given digital image can be
calculated if certain parameters, such as the size required, resolution capabilities
of the image capturing device, and/or the number of channels are known.

5.4.5

Calculating Pixels

The size and resolution of the digital image file required for the final image can be
determined or calculated by the number of pixels required prior to scanning or
capturing the original image. Calculations can be carried out using the following
formula (Colet 2000, pp.6-7):
8 bits = 1 byte=256 levels per channel
16 bits = 2 bytes
24 bits = 3 bytes

46

5.5

Histograms

A brightness histogram is an important tool used in image processing. A
histogram graphically shows or plots the frequency distribution for an 8bit image
of grey values ranging from 0-255 (for an 8bit image). The plot shows the number
of pixels represented in the image having each of the 256 possible brightness
values.

The histogram shows peaks corresponding to the most common brightness values
across the image. The horizontal axis represents the number of possible grey
levels in the image, and the vertical axis shows the number of pixels (or counts) at
the same grey level.

The valleys between the peaks show brightness values that are less common in the
image. Empty regions at either end of the plot represent where there are no pixels
with those values. The histogram represents an easy to read indicator of the image
contrast and brightness distribution, or dynamic range (Baxes 1984, p.178).
However, the image brightness in an image may not always carry the full 0-255
grey value range available (Russ 1999, p.234).

Figure 5.2. Histogram of a greyscale image.
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The histogram represents (and shows) the mean, median, and total number of
pixels. The mean represents the average grey value of each pixel in the image, the
median, the middle grey value from the range of grey values available in the
image, and the total number of pixels. For example, the histogram represented in
Figure 5.2 shows that there are a total of 524,288 pixels in the image and that 128
of these pixels are the middle (the median) grey value represented in that image.

Histogram Equalisation
Histogram Equalisation is an example of a function of image processing. It can be
used when the original grey values do not cover the full range of possible grey
values. To ensure all the grey values are represented, those grey values can be
stretched or altered by evenly distributing them. This is effected by spreading out
the displayed grey levels in the peak areas, and by selectively compressing them
in the valleys, so the same number of pixels in the image show each of the
possible brightness levels. This function is used to broaden the range of grey
values in the image in order to increase or decrease the contrast range within the
image. This is performed to make the image more visually pleasing (Russ 1999,
pp. 233-242).

5.6

Image capture device

Negatives are typically digitised (or captured) using a scanner (flatbed, film/slide,
or camera). A flatbed scanner was used during this research thesis. It consists of a
‘box’ that contains a sensor and a light source that sits at the bottom of the
scanner. It can be used to scan reflection media (such as prints). To capture a
photographic negative or a transparency, the scanner sensor, which sits on the
bottom, but the light source used is stored at the top in the lid. In both cases the
angle of illumination is at 90° to the plane of the negative.

Scanners for the consumer market can scan (in the reflection mode) large format
negatives from 300 to 1200 pixels per inch. A 35mm slide scanner can capture
2500 to 3500 pixels per inch (Russ 1999, p.32). Scanners are slow if the image is
large and contains a lot of information or a large dynamic range.
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A significantly larger array of pixels are available from a flatbed scanner when
compared to a digital camera, however, a flatbed scanner was utilised for the case
studies (outlined in this research thesis) because of its accessibility and cost to
many institutions. A flatbed scanner is easier to use, and is also of relatively low
cost when compared to a digital camera capable of capturing similar image quality
and resolution. It also does not require the specialist lighting equipment and
photographic experience and knowledge needed to operate a ‘high-end’ (for
example Phase one) digital camera.

Flatbed scanners use a linear solid-state detector array and typically can scan an
area at least A4 size, although scanners that can capture A3 size are available.
While usually used for desktop publishing, scanners can be readily adapted to
scan cellulose acetate negatives (Russ 1999, p.31). Adaptors, holders, and
templates are available that enable scanning to be effected by holding a variety of
film formats, such as 35mm and 120, enabling them to be scanned in batches.
This enables scanning, colour calibration, and quality control checking to be
achieved more quickly. These formats (35mm or 120) can be either scanned in
strips or placed in mount holders, which makes for quicker scanning. An example
of this type of scanner is the Nikon Coolpix film scanner.

5.6.1

Bit depth in scanners

Scanners can typically scan at various bit depths; 8 bits, 12 bits 14 bits, or 16 bits.
Some scanners will scan at a higher bit depth but will reduce (‘internalise’) the bit
depth when the scan is completed. For example, the flatbed scanner used for the
case studies (outlined in chapter nine) scanned images at 14 bits, and internalised
them to 8 bits once it completed scanning. This is typical of these types of desktop
scanners, usually used for printed material (for desktop publishing) where 8 bit
scans are generated.

As mentioned earlier, the bit depth at which the scanner captures the image affects
the amount of information obtained, thereby affecting the image quality. A
greyscale image captured using a 12 bit scanner has a greater number of grey
values than those obtained from a scanner that captures at 8 bits. This is due to the
number of possible grey values increasing from 0-255 values (for an 8 bit) to 049

4096 values for a 12 bit scan. There is another increase when a 14 bit scanner is
used, resulting in 0-16,384 possible grey values being recorded. These values are
expressed in terms of 214 212, or 28.

Although 8 bit scanners are adequate for most applications, these images result in
slight degradation in the image quality. This is visible at the boundaries or where
two grey values meet (Russ 1999, p.19). Although not tested during this research
thesis, it is anticipated that this may limit some image processing applications
where greater image quality is required to perform a specific function.

5.6.2

Scanners and Image Quality

Problems can also arise during the scanning process that may affect image quality
and present problems for image processing. This includes the introduction of
noise which are referred to as artefacts in the digital image (Williams 2000, 6).
The problems that may result are:
•

Pattern noise may be exhibited in the sensor and if all the detectors along the
row are not performing identically. This results in a striping effect to appear in
the image, as the sensor moves (scans) across the picture. If the scan motion is
not perfectly smooth it can also produce striping in the opposite direction
(Russ 1999, pp.31-32).

•

Illumination problems and ‘drop-off’ in intensity may occur near the edges of
the scanned area because of the short length of the light source may result
(Russ 1999, p.32).

•

Problems may occur associated with the instability of the light source
resulting from a lack in ‘warm-up’ time. The light source should be allowed to
become stable prior to using the scanner. This is particularly important when
capturing colour images, where stability and consistent colour can be hard to
obtain. However, greyscale images can also be affected. To overcome this
problem the negative can be scanned a number of times to allow the light
source to warm up, thereby giving consistent measurements when the final
image is generated (Russ 1999, p.32).

•

Misregistration, or the detector not being aligned correctly may cause
problems with capturing the image (Russ 1999, p.32).
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5.7

File Formats.

It is important when using digital technology (to produce surrogates for
deteriorating cellulose acetate negatives) to give consideration to the file format
chosen. A file format that saves images as raw uncompressed image files should
be selected and seen as a long-term strategy. This assists with ongoing access to
the image file in the future, particularly when undertaking emulation, and
migration. These are discussed in more detail in section 6.20.

The type of file format needs to be determined prior to commencing any
digitising, and should be based on the needs of the institution and the intended use
of the digital file. Currently there are a number of image file formats available that
can be chosen and only some accord with industry standards (Frey 2000a, pp.5-8).

The number of file formats that can be used to save digital images include PSD
(Adobe Photoshop Document), BMP (Bitmap), PDF (Portable Document
Format), TIFF (Tagged Image File Format), and JPEG (Joint Photographic
Experts Group). For long-term access to these image files, formats that are in the
‘open public domain’ (such as TIFF and JPEG) rather than those that are
proprietary and software specific, should be chosen.

TIFF and JPEG, which are in the open public domain, are not proprietary formats,
and are supported by a number of computer platforms. Generally ‘if several
software packages are allowing the use of a file format, the format will probably
be in existence for quite a while’ (Frey, 2000a p.7). Choosing a file format used
by a number of large institutions will also help ensure that the image file will be
able to be accessed in the future.

When using digital technology as a long-term strategy (such as for the purpose
proposed in this research thesis), the following criteria should be used when
selecting a file format:
•

The format should be operating system independent,

•

It should be in the open public domain,

•

The file format should not be proprietary or specific to a software program,
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•

The file format should have been in use for some time. This is particularly
important as currently no standards exist that stipulate any ‘best’ file formats
for the long-term preservation of digital files (Frey 2000a, p.2).

Careful consideration also needs to be given to the type of compression being
undertaken when the image is saved to a particular file format. This will also be
based on the possible use of the digital file in the future.

5.7.1

Compression

The degree or level of compression occurs to an image once a file format is
selected. The type of compression that occurs is dependent on whether the file
format chosen is a lossy or lossless format. Lossy is a compressed format, whilst
lossless has no or limited compression (Frey and Reilly 1999, p.37). Compression
issues must be addressed when embarking on a digital image project.

Lossy compression does not reconstruct all of the individual pixels. Much higher
compression ratios can often be achieved for images if some loss of the exact
pixel values can be tolerated. JPEG is an example of a lossy format.

Lossless compression enables the exact reconstruction of all the individual pixels
values. This method is often referred to as image coding rather than compression.
TIFF is an example of a lossless format. Current lossless compression does not
significantly reduce the amount of data, making it possible to reproduce the
original image file from a compressed file.

5.7.2

The effect of compression

Lossy compression eliminates very small grey values in order to reduce the
amount of storage space needed. However the compression process produces loss
in the quality of the reconstructed image. All lossy methods of compression
introduce some alteration into the image. Alteration is particularly noticeable at
the boundaries or the point at which two different grey values meet within the
image. To resolve this problem, one solution may be to store the image as a
compressed (lossless) format or to leave it uncompressed.
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Image compression can create problems as it packs (compresses) as much
information about the image into the smallest possible memory in order to save
valuable memory. Grey values, which straddle the boundary of two brightness
values, are averaged. This average depends on the pixels found on either side of
the boundary. As a result, data (known as pixels) in the image, which have a
minimal impact on how the human eye views and interprets the image, are
selected and removed (Russ 1999, pp.18-19).

For quantitative image processing these small pieces of data (which have been
removed and may include grey values that are not visible) may have an impact on
the end result. This is because the edges (where the two grey values meet) may be
broken, added, shifted, and/or the colour and density values altered. This may
eliminate fine details in the image, which are valuable for image processing
functions.

Figure 5.3 illustrates how compression can affect an image. Figures 5.3 and 5.4
illustrate two USAF (1951 test pattern) glass slide targets that were scanned using
a Linotype-Hell Saphir Ultra2 flatbed scanner. Figure 5.3 was saved as a lossy
format and show how artefacts affect the pixels surrounding the bars, which have
degraded and are visible.

These artefacts are reduced in figure 5.4, were it was saved as a lossless format.
The artefacts not only disrupt the image but can also cause problems when
sophisticated image processing techniques are applied to the image.
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Figure 5.3. The image (test pattern) saved as a JPEG (lossy) format. The pixel boundaries or edges
are degraded (artefacts) where the edges meet.

Figure 5.4. The image (test pattern) saved as a TIFF (lossless) format and the artefacts are
reduced.

New compression schemes (such as wavelets), using another type of compression
algorithm that does not produce the artefacts of JPEG-compressed files, have
been suggested by the industry. However, data on how successful these prove in
the long term is not yet available (Frey 2000b, p.15).

Image compression, particularly for large images, reduces the amount of storage
space required. Prior to scanning, the file format should be thoroughly reviewed to
reduce the risk of choosing a compression format that may limit the use of the
digital file in the future. Although this is difficult to determine (as it is uncertain
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which formats will be available in the future) Frey and Chapman (2001) believe
that, of the formats currently available, TIFF is the most ‘archival’ (likely to be
around in the long-term). This is due to it being a lossless format, which has been
used in many digitisation projects.

5.8

Image processing

To apply image-processing techniques, the conservator needs to have a basic
understanding of the following terms:
•

Spatial Domain; this is how the human eye views a two dimensional image.

•

Frequency Domain; this is how the image is represented in terms of the
magnitude and phase of the brightness values. The brightness values are
where a dark and light area meets along an edge.

•

Brightness value used to describe an image in the spatial domain.

•

Phase or orientation; used to describe an orientation in the frequency domain.

•

Noise; non-image forming grey values in the image.

•

High pass image filters which accentuates high frequency details; and

•

Low pass image filters which reduce high-frequency details.

See section 5.11 for further information regarding the terms outlined in this
section. Understanding these terms is important, as image processing is a complex
area of specialisation, although it is simplified though tools using software
programs. These programs allow functions to be implemented without requiring
the conservator to have an indepth knowledge of the mathematics involved behind
the software program. This makes using image processing accessible as a strategy
for digitally ‘restoring’ deteriorated cellulose acetate negatives.

5.9

Software

The ease of operation and accessibility due to low cost was the criteria applied to
selecting an appropriate software program for this research thesis. Based on this
criteria, the following three image processing software programs were examined:
•

OPTIMAS 6.5,

•

Image Processing Tool Kit (IPTK) v.3; and
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•

Interactive Data Language (IDL).

IDL was assessed at the beginning of the research but was not examined in any
detail; OPTIMAS and the Image Processing Tool Kit could perform the functions
required, and carried the advantage of that they were menu driven (graphical user
interface), whereas IDL was not. The graphical user interface made the programs
more user-friendly for the conservator. This has been outlined in more detail in
section 5.10.5.

A fast computer that enables fast image processing and has sufficient RAM
(Random Access Memory), to handle large file sizes is required. Additional RAM
is also required to s Adobe Photoshop and the operating system.

A number of image-processing software programs are available and have varying
operational functions and levels of sophistication. Many of these functions are not
required for the application outlined in this research. For the conservator (without
an IT background or unfamiliar with such programs) a program that is simple to
use and adequate for the application required should be selected. It was important
that the case studies outlined in this thesis, utilised software programs that were
easy to use, affordable, and accessible.

5.10

Image processing filters

A number of common filters were examined during this research to determine
whether they could be used to characterise, eliminate, or isolate the distorted
substrate in the original deteriorated negative. Median filters and Fourier
transforms (FT) were the main filters examined in the case studies.
These filters were chosen after initial examination determined they could be
useful for the function required. See sections the 5.10 and 5.12 outlines of how
these filters operate. To determine whether a particular filter is appropriate for the
desired application, filter options should be discussed and examined with
someone skilled in image processing. This is particularly important for the
conservator, as they may not have the knowledge required to understand how
different filters process the image.
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Filters are shortcuts implemented (or driven) through a pull down menu using a
software program. For example, filters enable particular image processing
functions to be performed by the operator with ease. Filters, also known as masks
or convolution kernels, are made up of a series of numbers. These are applied or
calculated in image processing to selectively highlight frequencies and
orientations within the image (Russ 1999, pp. 354-355).

Filters allow one calculation to be performed by the operator using a particular
filter, without the need for multiple calculations. For example, if a function
requires four individual calculations to be done to obtain a result (function), a
filter can apply these four calculations in one function. This is due to all
calculations being programmed and implemented into the filter. The software
programs chosen for this research thesis have a number of built-in filters.

Where a readily available filter does not exist to perform a required function, it
can be customised (built) or developed using a programming language in order to
implement the desired calculation (function). However, this was not examined
during this research, as existing filters in the software examined (OPTIMAS and
the Image Processing Tool Kit) were sufficient.

5.10.1 Median filters
Applying a Median filter to the image results in minimal edge degradation,
allowing the application (use of this filter) to be repeated. The Median filter
usually looks for edges in the image, which results in the image becoming
softened or slightly blurred. This is due to the filter only allowing low frequencies
to pass through (Baxes 1984, p.50). This can be problematic and unpredictable,
resulting in the image looking worse after the filter is applied. Where image
quality is important, as in the case of producing surrogates for deteriorating
cellulose acetate negatives, the median filter may be an inappropriate application.

Median filters work on the principal that certain kinds of noise (in the digital
image) can be reduced or removed by eliminating ‘corrupted’ pixels and replacing
them with ‘reasonable’ value pixels (Russ 1999, p.175). These pixels (‘corrupted’
and ‘reasonable’) are the median value of the neighbouring pixels, thereby
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causing minimal distortion to the image. Applying a median filter does not change
the values in uniform or gradually varying regions, but rather erases any large
variations that are smaller than the radius of the neighbourhood.

Since many Fourier transform (FT) (see section 5.12) images are grainy,
particularly at high frequencies, the direct application of a rank filter to the
magnitude image may cause other artefacts to appear in the image (Russ 1999,
p.347).

5.10.2 Rank Levelling
The rank filter, such as an Olympic filter, is a common filter available using the
two software programs. The rank filter looks at the surrounding pixels, and
rearranges the pixels values according to brightness. For example, if the
background is darker than the feature, it finds the darkest pixel in each
neighbourhood and replaces the value of the original pixel in the image with the
darkest brightness value (Russ 1999, p202).

This is a useful filter when the surface of the image is irregular, as it locates or
detects texture on the image. However, rather than locating physical texture, this
operation locates variations in pixel brightness (which usually represent texture).
In its simplest form, the operation looks for differences (known as range) between
maximum and minimum brightness values in the area or neighbourhood. If the
area is flat or uniform then the range is small (Russ 1999, p.199).

5.10.3 Surface Topography
Examining the surface topography on the original deteriorating negative (through
filters to examine the digital image) was not examined during the case studies.
This was due to the topographic information not being able to be recorded by the
flatbed scanner, as it is the manner in which the light source (in a flatbed scanner)
operates using a 90° angle of illumination, which does not record this information.
However, by using a device (known as a stylus instrument) such as a profilmeter,
topographical information from the surface of the cellulose acetate negative may
be captured. This device may prove useful for future research, although it was not
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in examined during this research thesis. This is because it did not fit within the
stated criteria of examining options that were readily accessible to cultural
institutions, particularly smaller institutions. The cost and availability of this type
of instrument would be considered prohibitive.

5.10.4 Use of other software programs
Although two software programs were examined, others are available, such as
IDL. IDL was examined in the initial stages of this research project and was
developed by Research Systems (Boulder Co. USA), costing $2500AUS. It was
seen as a potentially useful tool for the case studies, particularly as it was a
relatively low cost program. However, although IDL had similar image processing
functions to the other software programs (OPTIMAS and IPTK), it was not menu
driven. IDL was command driven (which requires code to be written to perform
the required functions) and therefore was not as user friendly than the other two
software programs. As such it was deemed unsuitable for the case studies.

Initial examination of the IDL program showed that it could be useful in the
future. Although it would only be useful if time and technical skills (in
programming) were available to write the commands required. It appeared
promising as it had been used for Barbu’s (1999) research in capturing the surface
topography of a cuneiform tablet. However, in that application the image was
captured using another image capture device (camera) and not a flatbed scanner.
This enabled the object to be lit by varying angles of illumination, accentuating
certain features for image processing, unlike the flatbed scanner.
Iatia-‘Phase contrast’ was also briefly examined during this research to see if it
could be a possible solution. However, at the time this research was being
undertaken, the software was in the developmental phase. Access to the software
was not possible as Beta (first trial) testing was being conducted.

5.11

Spatial Domain and Frequency Domain

A spatial image portrays a digital image file as an array of pixels, where as a
frequency image portrays it as a frequency space domain. Although the frequency
space domain shows the information in a different way to that in the spatial
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domain, the information is the same. For example, to perform a Fourier
transform function, using image processing, the digital image must to be
converted from a spatial domain image to a frequency domain image. Converting
the image from a spatial domain image results in an image which is made up of
frequencies or grey values.

Converting the image into a frequency space makes small changes in the image,
resulting from a filter operation, easier to observe. This is due to the fact that
images are composed of many basic high and low frequency components. High
frequencies occur where rapid brightness transitions are prevalent and low
frequencies where slow transitions occur (Baxes 1984, p.23).

5.11.1 Spatial Filtering
Spatial Filtering is a separation of frequency components into a two-dimensional
image (known as base of data). These frequency components are spatial
frequencies that relate to the rapidity in change in grey levels over a certain spatial
distance. For example, the spatial frequency is the rate at which the brightness
change occurs within the image and therefore, constant brightness is represented
by low spatial frequencies (Baxes 1984, p.47).

The highest frequencies are found where a sharp edge is present, such as where
black pixel meets the white pixel. Thus the meeting point, known as the boundary,
creates a frequency that can be used to generate an image in which only the low or
the high frequency components are shown. This is known as a spatial filtering
operation (Baxes 1984, p.47).

Processing an image in the frequency domain is useful for removing certain types
of noise (by applying large convolution kernels), enhancing periodic structures
and locating defined structures in images. It is more efficient to perform these
calculations (or functions) in the frequency domain than in the spatial domain.
This is due to the amount of data that can be moved around (Baxes 1984, p.4849).
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5.12

Fourier Transforms

The case studies utilised the Forward Fourier Transform (FFT) functions
available through OPTIMAS and the Image Processing Tool Kit (see Chapter 10).
Fourier transforms were chosen as they are one of the more ‘useful tools in
image-processing’ and have been used for restoration in other applications (Ritter
and Wilson 1996, p.189).

Fourier transform is an operation that breaks down an image, made up of an array
of pixels, into fundamental spatial frequency components to enable analysis or
filtering operations to be performed (Baxes 1984, p. 177). This can be effected by
decomposing the image into variations in brightness (by using every possible
frequency and orientation) and adjusting their magnitude and phases to match the
original image. These operations are performed in frequency space rather than in
the original array of pixels (or spatial domain).

Fourier transforms (FT) are useful tools for isolating periodic structure or noise
(Russ 1999, p310). Fourier transforms (FT) involve calculations (image maths)
applied to the image in order to reduce the magnitude or brightness values. These
are reduced either partially or to zero whilst leaving the phase (orientation)
information alone. This is important when determining where information appears
in the image.

Peaks (in the values) can be removed by setting the magnitudes at a particular
location to zero and by not altering any of the phase information. There are many
ways to specify and to apply this reduction, however it is more practical to specify
a range of frequencies and orientations numerically. This can also be done
directly using the magnitude or the power spectrum display of the Fourier
transform image. This function is performed by selection areas on the digital
image by drawing circles (or pie shape regions) to allow specific peaks in the
power spectrum, corresponding to periodic information, to be selected (Baxes
1984, p.63).
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The Power spectrum is a frequency domain image that has had its grey values
amplified using a power function (mathematical entity). In the frequency domain
image the magnitude of gradually varying brightness (as a function of position in
the original image) is plotted in the centre of the array and high frequency
information (rapidly varying brightness with position) is plotted as the radii
increases outwards (Russ & Russ 2000, p.22).

5.12.1 Frequencies in the Spatial Domain
Frequencies (in the digital image) are made up by the contrast or edge gradients
between pixels making up the image. These can be represented at varying angles
and orientations can be altered.

Figures 5.5-5.6 illustrate how an image with high and low frequencies is
represented in an image (in the spatial domain image). The high frequency image
results when an image has lots of edges, whilst the low frequency image has few
edges.

Figure 5.5. Vertical High Frequency Image

Figure 5.6. Vertical Low Frequency Image

The orientation of these will determine where they sit in the frequency domain.
For example, when changing the angle in the spatial domain, a different
frequency domain will result when an FFT is performed. An FFT performed on
the same image at a 90° angle will result in a single horizontal line. However,
when the FFT is performed on an image with a 45° angle (selected phase and
orientation) the result is quite different (see Figure 5.8). Different spatial domain
frequency orientation is displayed when the image is viewed in the frequency
domain image.

62

Figure 5.7. Vertical 45°angle High frequency image.

Figure 5.8. FFT of Vertical 45°angle High frequency image.

The Forward Fourier Transform (FFT) is probably the better known and the most
used of the Fourier transforms (Russ 1999, p.306). However, application of FFT
is limited to images that are multiples (numerically) of two in size. This is due to
the manner in which the function (equation) to perform the operation is
calculated.

To perform and implement an FFT, the image or pixel dimensions of the digital
image must be a ‘power of two’ (a mathematical concept) (Russ and Russ 2000, p.
22). However, it is unlikely that many images would be an exact ‘power of two’.
Therefore a new image must be created (if the existing image is not an exact
power) to implement the FFT function. Converting the image to a ‘power of two’
can be done by changing the canvas size of the original (digital) image. This can
be done by padding out the area surrounding the original image to the next larger
‘power of two’ (see Figure 5.9).

To perform FFT functions in the case studies used during this research, a ‘new’
image was created using Adobe Photoshop. Photo editing tools were used to
‘cut’ and ‘paste’ the digital image (of the original negative) into a new canvas
sized to a ‘power of two’. The non-image area (surrounding the outside of the
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image, inside the canvas) was ‘padded out’ with the mean grey values represented
in the digital image. This is shown in Figure 5.9, where the original digital image
had a canvas size of 600x491 pixels.

Figure 5.9. The ‘new’ canvas has been ‘padded out’ to produce a canvas size that is a ‘power of
2’. The canvas now measures 1024x512 pixels.

Choosing a mean value (for this padded area) results in a limited number of
frequencies represented which do not modify the maths (or calculations) involved
in implementing an FFT function. However, there is no level of control in
selection or isolating these areas to determine grey values, which becomes
difficult. Perhaps more importantly, it is difficult to determine which frequencies
represent areas of the original image, and which represent the (new) padded
canvas.

Although changing the canvas size to perform an FFT is possible when dealing
with a large number of negatives, there is a disadvantage that performing this to
each image becomes time consuming, which increases the cost associated with the
project.

5.13

Summary of Chapter 5

The conservator needs to understand that there is a direct correlation between how
the original image (negative) is digitally captured, and the resolution and the file
size of the digital image. The number of pixels (or grey values) represented in the
digital image determines the resolution and the file size. The image can be
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compromised by the file format chosen, due to the level of compression, when the
digital image is saved. When using digital images as a conservation or
preservation tool, the image file format chosen should be in the open public
domain and should be a lossless (which involves no or limited compression)
format.

A histogram can be a useful tool in determining the distribution of grey values in
the image and whether information (known as noise) has been lost or
compromised during the scanning or capturing process.

Software programs make it easy for the conservator to implement imageprocessing techniques to digitally restore deteriorating negatives through the use
of filter functions. The use of menu driven graphical user interface software
programs, such as OPTIMAS and the Image Processing Tool Kit (IPTK), enables
the conservator to use built-in filter functions to alter a digital image. Choosing a
user-friendly software program makes it easier for the conservator to understand
and implement this type of image processing. Filters make it possible to apply
these functions without the need to understand the complex mathematics
(structure) involved in performing these operations. OPTIMAS and IPTK were the
two software programs utilised during the case studies and are discussed in
chapter ten.

It is important that examination of image-processing tools is carried out in
collaboration with someone who has the appropriate expertise in this field. This
will ensure that the appropriate application is chosen to utilise and implement the
most effective and user-friendly software available. This is particularly important
if the conservator is unfamiliar with image processing, which is likely given that it
is not typically taught in conservation training programs in Australia.

The issues and terminology discussed in this chapter needed to be understood
prior to implementing the mage processing tools used during the case studies
(outlined in chapter ten). Digitising deteriorating cellulose acetate negatives (in
this manner) also opened up a range of other issues involving the management of
the digital image files; these are discussed in the next chapter.
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CHAPTER SIX
MANAGEMENT ISSUES
The previous chapters outlined some of the basic knowledge and terminology
required by the conservator when considering the use of digital technology. This
information, which has been widely published, is readily available and hence is
easily learnt. However, there also needs to be an understanding of issues
surrounding the ongoing management of digital image files: the long-term
implications of creating digital files and organisational commitment to the use of
digital technology must be considered carefully prior to commencing any
digitising project. The organisation should particularly consider:
•

The need for ongoing resources (funds and expertise),

•

The need to ensure ongoing access to digital files, and

•

Potential problems associated with software and hardware compatibility and
readability.

When considering the use digital technology for dealing with deteriorating
cellulose acetate negatives, the reasons for choosing it as a strategy need to be
clearly defined. This is similar to the approach taken with any of the other
strategies or options currently available for dealing with negatives affected by the
vinegar syndrome. Factors that need to be considered are:
•

The size of the collection,

•

How the collection is used,

•

The purpose of using digital technology, and its advantage over other
strategies,

•

The role and purpose of the institution and the purpose of the organisation,

•

The level (resolution) of digitisation possible,

•

The funds available; and

•

Whether it is a short-term (access) or long-term (preservation) strategy.

All these factors should be defined by the institution, and incorporated into a
Preservation Management Plan with input from key stakeholders. The
implementation of a Preservation Management Plan will ensure that all the issues
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relating to the organisation are addressed before any digitisation process begins,
and ‘well before scanning of the first picture’ (Frey 2001, p.167).

Institutions need to fully understand their own requirements (for digitising), and
cultivate a shared responsibility for the collection within various departments
across the institution, as well as with outside stakeholders.

A Preservation Management Plan must be tailored to meet the particular needs of
the institution. As Rodney Start, Manager of the Imaging Unit from Museum
Victoria states (n.d) ‘Digital images need to be tailored for individual projects or
institutional requirements. What works for one may not necessarily work for
another’ (‘Australian digitisation projects’ 2000).

When considering digitisation as a long-term strategy careful consideration must
be given to ensuring that decision makers or managers are not ‘seduced’ by the
relatively low cost of scanning equipment and software, and the number of file
formats available. Not tying digitisation solutions to the needs of the organisation
can result in images being generated that have with limited uses, and therefore do
not meet the long-term expectations of the organisation.

This chapter sets out some general guidelines and considerations that should be
incorporated in a Preservation Management Plan. The plan should be set up prior
to embarking on the use of digital technology. It is by no means a definitive
outline of all the issues that need to be considered, but it does provide some
outline of those issues which have been addressed in detail by a number of
individuals over the years. These include published papers by Kenney and
Chapman (1996), Ostrow (1998), Frey and Reilly (1999), Brown (2000), and
D’Amato (2000).

6.1

Preservation strategy

A preservation strategy for collecting institutions should be a major component in
any digital preservation management plan. This is particularly important if
digitisation is being used as a long-term preservation tool, to ensure that images
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on negatives prone to deteriorating (such as cellulose acetate) are available in the
future.

Digitising a collection of negatives at the highest possible resolution and storing
the digital files appropriately is not enough for a long-term solution. Digital files,
unlike the original cellulose acetate negatives, require ongoing management. They
can not be stored away and forgotten, and later accessed when required, as the
technology to view these images may not remain available. Access can not be
assured without a best practice management plan being designed, implemented,
and maintained (Frey and Chapman 2001).

A preservation strategy will help ensure that the original material (negatives) and
the digital surrogates are managed effectively and that they are available for
access in the long-term.

6.2

Preserving two collections

A written preservation policy or strategy can be a useful tool in determining the
needs of the collection, the institution, establishing the necessary stakeholders,
and establishing a shared responsibility for the project. For both the original
cellulose acetate negatives and the digital surrogates, it should include:
•

The reason for digitising,

•

The condition of the original cellulose acetate negatives, and

•

Who holds ongoing responsibility for the original cellulose acetate negatives
and surrogates.

A preservation strategy should include provisions to safely store and access the
original cellulose acetate negatives (which may or may not be deteriorating) and
the digital surrogates (produced from the negatives).

The preservation strategy should clearly define and include the purpose for
digitisation−whether for access, preservation, or both. It should also include
details on whether the aim of digitising is to preserve the image and original
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negatives and provide long-term access to the surrogates, by ensuring ongoing
access to the digital file.

Managing one collection is a large enough task; however, the problems become
more complex when two different types of collections are involved (original
negatives and digital files). As such, the preservation strategy should include
whether one of the collections has been selected as the priority for the institution
and how resources (staff, funds, and time) will be allocated. The needs associated
with each collection (the original and the surrogate) are quite different and may
vary according to the value placed on it by the institution. As such, the
preservation needs of each collection must be addressed in the preservation
strategy. For example, some institutions may place high intrinsic value on the
original cellulose acetate negatives, whilst others will only be interested in the
content (images). The value of each needs to be clearly defined by the institution
(based on that institution’s role) and the type of collection involved (Colet 2000,
p.2-5).

The preservation strategy should be established before digitising begins, and
should incorporate the following:
•

The scope and size of the collection and project,

•

The short-term and long-term goals of the project,

•

Identification of how the digital images will be used, whether-for access or as
long-term surrogates of the original negatives, and

•

The level of digitisation and the technical expertise and equipment that will be
required for the project.

These factors will be reliant on an understanding of the type of collection
involved and the particular needs of the institution. This is where the goals of the
institution (as outlined in the mission statement or strategic plan) and the
preservation needs of the collection, become critical.
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Many museums, libraries, and other archiving institutions see digital imaging as a
solution to the dilemma of providing unrestricted access to their high-quality
document collections while simultaneously preserving those collections within
secure, environmentally controlled storage (D’Amato 2000, pp.1-2).

The significance or value of the collection should also be determined, and a
criteria to assess its value established (Brown, 2000). Consideration must also be
given to the original negatives, which may involve retention or disposal
depending on the institution. Defining the role of the digital surrogate within the
collection, and whether the original or digital, holds the true intrinsic value must
be established. This process should also establish the role of the original cellulose
acetate negatives. This may involve disposal of the negatives, if severely
deteriorated, or they may be retained.

The conservator should aim to find a balance between utilising digital technology
as a preservation tool and the ongoing preservation of the original cellulose
acetate negative (‘RLG-OCLC Report’ 2001, p.18).

The remainder of this chapter outlines roles and responsibilities that should be
incorporated into a preservation strategy and in developing a Preservation
Management Plan.

6.3

Managing the project

The framework of a digitising project and the roles and responsibilities within the
project should be determined once a preservation strategy (outlining the objectives
and the stakeholders) has been established. A project manager should be identified
who can more narrowly define the aims of the project, the goals, expectations, and
equipment and expertise required.

Ideally someone from within the organisation should perform the Project Manager
task, as it requires a comprehensive understanding of the aims of the organisation,
and must ensure that the aims and goals of the organisation are implemented
during the project (Colet 2000, pp.8-10). If a project manager from within the
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organisation does not have all the skills, external expertise may be obtained.
However, the core function of the digitisation project should be determined in
collaboration with staff employed by the institution. This would be known as a
hybrid system of managing the project.

A hybrid system utilises the expertise available from within the organisation,
drawing from external expertise where required, and which is not available from
within the organisation. A hybrid system serves two main functions, one that uses
both expertise from within the organisation and from outside (Colet 2000, p.7);
1. To ensure that external expertise is sought where needed and as required, and
2. To ensure that internal staff are involved and able to obtain training (where
required) thereby expanding on their own knowledge and that within the
institution.

A vendor project manager or a computing manager, should also be appointed
(Colet 2001, p10 & Brown 2000 pp. 1-10). This may be a separate person who
works in collaboration with the Project manager, or the Project Manager may
perform both functions.

The role of the vendor manager is to operate and manage the technical issues
associated with digital equipment and also be responsible for locating appropriate
staff and expertise where required (Colet 2000, p.10).
In at least two Australian institutions2 the photographic departments managed the
technical details involved in digitally capturing images. The technical departments
worked in the vendor management role, managing the operation of equipment
such as scanners or cameras to capture the image.

The photographic departments at both these institutions had made the transition
from traditional photographic copying to the use of digital technology. As such
they had the basic infrastructure in place along with the technical expertise to

2

Gained from personal experience while working at the National Library of Australia–February to
June 2000, and the National Gallery of Victoria–September 2000 to August 2002.
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assist with a digitising project. The benefit of involving the photographic staff in
this manner ensures that much of the technical knowledge is retained within the
institution. However, due to the expense in setting up a digital imaging service
capable of capturing a high-resolution image, this may not be possible for smaller
institutions.

6.4

Establishing Stakeholders in the project

One of components key to the success of a Preservation Management Plan is a
clear identification of stakeholders and their separate responsibilities and goals
(Frey, 2001, p.166). ‘Curators, preservationists, imaging experts, and potential
users of the images should be consulted concerning what they consider an
adequate level of detail and colour fidelity’ (D’Amato, 2000, p24-25).

Digitising often involves a number of departments (specialist areas) within an
institution. Adopting and cultivating shared responsibility (within the institution)
will help ensure that the long-term goals of the project will be maintained.

Although this will vary between institutions, responsibility for utilising digital
technology (used to produce surrogates of deteriorating cellulose acetate
collections) should be shared by:
•

Management, at all levels including the director and/or CEO,

•

Conservation and preservation staff,

•

Curatorial staff,

•

Collection managers, including librarians, and or archivists,

•

Registration staff,

•

IT departments,

•

Finance or Accounting departments,

•

Software and hardware developers and suppliers,

•

External consultants, and

•

Users.
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A representative from all these areas should be involved in the early stages of
determining whether digital technology should be used and to determine the
requirements.

6.5

Quality and Production managers

The purpose of a quality and production manager is to establish and maintain
image quality standards set out in the beginning of the project. (Colet 2000, p.11).
The role of the quality and production manager should be separated from that of
the scanner operator. For some institutions the project manager may undertake the
quality and production manager role. To ensure that the objectives of the
institution are maintained, ideally the responsibility of this role should be held by
the institution and in-house staff. External consultants may be required to provide
additional expertise in some areas, especially to assist and train in-house staff.

6.6

Role of conservators and/or preservation staff

The involvement of preservation and/or conservation staff in any digitisation
project is vital to its success, particularly if the project involves collection it
should have a preservation component.

Conservators and preservation staff will need to assess the collection and deem its
suitability for image capture prior to commencing digitising. Most often,
conservators recommend digitising a collection of deteriorating cellulose acetate
negatives for preservation reasons. In most cases conservators, along with
curatorial and collection management staff are the first to come across the
deterioration problem, usually after a survey has been done on the collection or
during access and retrieval for a specific purposes.

Due to the problems associated with ‘off-gassing’ of deteriorating cellulose
acetate negatives, occupational, health and safety (OH&S) issues may need to be
addressed. Conservation and preservation staff are best placed to offer advice on
the most appropriate manner in which to handle and store this material.
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Preservation Services staff, Jeong-Reuss and Engram at the National Library of
Australia, concluded that ‘the involvement and contribution of preservation staff
in planning and setting-up digitisation projects cannot be emphasised strongly
enough’ (2002 p.234).

The technical expertise required to become involved in a digitising project
(outlined in chapter five) may seem daunting for some conservators trained in
more traditional fields. However, it is imperative that they are involved in some
capacity, as they can often assist in identifying potential problems relating to the
collection prior to the project commencing. Their involvement will also enable
them develop knowledge and skills in digitisation (if it is not already present) as
the role of digital technology will continue to impact on the field of conservation.

Although it was not in the scope of this research thesis, it would be of interest to
the conservation community in Australia to record the number of digitising
projects that have been suggested or recommended by members of the
conservation or preservation department. This may be a potential research area in
the future.

6.7

External Consultants and Expertise

Digitising projects requires a high level of expertise and knowledge. However, the
project should not be limited in terms of the expertise available within the
institution. A digitising project should be seen as an opportunity to extend the
knowledge and skills within an institution and to enhance in-house training.

Prior to embarking on a digitising program it is unlikely that any institution would
currently have all the skills and knowledge required. Employing the services of
external consultant in areas where expertise is lacking should be considered, even
when it appears that all the components or knowledge may be available in-house.
Consultants may add value in:
•

Assisting with identifying cellulose acetate deterioration if there is no in-house
expertise available,

•

Assisting with the purchase and/or set-up of equipment,
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•

Advising on appropriate capturing methods,

•

Calibrating various computer and digital imaging systems,

•

Establishing protocols regarding digitisation and colour-management; and

•

Establishing an archiving system or database to enable access to the images

The implementation of a hybrid system should be encouraged as, this will build on
and improve the knowledge and skills within the institution. As Colet (2000, p.9)
outlines, outside contractors should work on-site with in-house staff to enable
skills and technical expertise to be gained. A view supported by Jill Wilson,
Manager Information Resources at the State Library of Victoria, ‘Digitisation inhouse has been very beneficial and cost effective and staff have been provided
with the opportunity to increase their skill level’ (‘Australian digitisation projects’
2000).

Arguable, the most effective model (according to the author of this thesis) for
providing the required expertise, is by developing in-house training programs (in
collaboration with outside consultants) through a hybrid system, see section 6.3.
This will ensure that staff are actively involved in and have ownership of the
project, but are able to build on their knowledge base through outside input.

6.8

Funding

The cost of equipment, its maintenance and the expertise needed to support it, is
perhaps the most prohibitive cost involved in the use of digital technology, as it
involves the ongoing purchasing, upgrading, maintenance, and/or hiring of
hardware and software for the project. As Ostrow (1998, pp. 9-10) points out
‘Digitization projects are major initiatives that consume large staff and financial
resources and can continue to do so long after the initial projects have been
completed’.

The equipment required to undertake the case studies is outlined in chapter ten. In
assessing which equipment was used, the decision had to take into account the
amount of funding available to carry out the studies. In general terms, the
following hardware and software was required:
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•

Scanner,

•

PC, including keyboard, CPU, monitor, printer ,

•

Operating system,

•

Software: Microsoft word, Adobe Photoshop, Outlook, OPTIMAS, Image
Processing Tool Kit, upgrades were required,

•

CD-ROM (Compact Disk-Read Only Memory) drive,

•

Compact disks,

•

CD writer, in order to store the images,

•

Storage device, extra internal hard drive and extra RAM was required and
purchased to operate multiple software programs. An extra internal hard drive,
for temporary storage prior to archiving was also required,

•

Modem,

•

E-mail and Internet access; and

•

Resolution test targets and calibration targets.

As an example, the small-scale project undertaken during the course of this
research involved the purchasing of hardware and software, which was
approximately $11,000. This cost did not include access to expertise in image
processing (external consultant), ongoing maintenance of the digital files,
upgrading software, or reformatting the digital files in the future.

Ideally, cellulose acetate negatives are stored in stable low temperature and low
RH environment, in an archival box, or, in the worst case they are stored in an
acidic box in an uncontrolled and fluctuating environment. The costs associated
with storing cellulose acetate negatives are low when compared to the
‘overwhelming’ (Colet 2000, p.13) and ongoing costs involved in producing and
maintaining a digital surrogate (‘RLG-OCLC Report’, 2001 p.20).

It is important when securing funds for a digitising project that the long-term
issues involved with maintaining the image files are addressed, and potential
migration, software, and hardware problems that may be encountered in the future
are included.
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Although not a great deal is known about the costs of preserving complex digital
objects over time, there is an accepted wisdom in the library community that
digital preservation will require ongoing resource commitments−potentially more
than for traditional materials, but certainly different (‘RGL-OCLC report’ 2001,
p.20).

Colet (2000, p.7) emphasises the need for someone to secure appropriate funding
for a digitising project. Depending on the institution, in many cases the role of
sourcing that funding may fall to the project manager. If funds were not available
internally, external funding options would need to be investigated. For example,
grants such as the Community Heritage Grant (Australia) can assist with the setup of a small-scale project. This may cover the cost of employing someone to
undertake research, cataloguing, or purchasing a piece of equipment or software
costing under $5000 (the maximum amount given by the grant). However, as
indicated by the estimated cost provided for the case studies (section 6.8) a greater
amount of funding would be required to set up a digitising project. In particular,
extra funds would need to be secured for long term maintenance, to ensure
ongoing access to the digital images created during a large-scale digitisation
project. The services of an outside consultant to secure the appropriate funds may
be appropriate if comprehensive knowledge of funding options and how to secure
them is not available in-house.

This need for equipment and the cost implication of using digital technology must
be addressed in the initial preservation strategy. At this time, digitisation should
also be weighted against other available options, especially as the cost greatly
increases as the size of the collection increases. In Australia, the lack of funds
along with the lack of expertise is a major constraint or obstacle for institutions in
dealing with their deteriorating cellulose acetate collections (‘Cellulose acetate
project stage one: final report’ 2000, p.37). To some extent this lack of expertise
has been addressed through the Cellulose Acetate Project’s ‘Register of
Expertise’, which lists resources that can be drawn upon by any institution.
However, lack of funding remains a constraint for many institutions when the
‘real’ costs are assessed.
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6.9

Information Technology (IT)

A digital project is by its nature reliant upon the expertise and staff of either the IT
department (within the institution) or an outside IT provider. As such, IT
resources should be one of the main stakeholders consulted prior to any digitising
being undertaken.

The role of IT is to advise whether the institutions computer system has the
capabilities to support a digitising project and then to support the application of
those digitisation tools. This may involve resolving network issues, devising
appropriate storage systems for the data, assisting with archiving, retrieval of the
digital files, and the ongoing testing and maintenance of the software and
hardware, to ensure the images remain retrievable.

If an IT department does not exist within the institution, IT responsibilities will
need to be out-sourced and appropriate advice sought. Generally, the larger the
project (in terms of resolution required and the number of items to be digitised)
the greater the IT infrastructure required.

6.10

Scanner operator/technician

Operators trained in handling collection material and in operating the scanner
should be employed. In some instances training may be required to ensure that
material is handled correctly, to minimise damage to the original negative (Colet
2000, p.19). Maintaining this operation in-house ensures that the collection
material (original negative) is handled safely and does not leave the control of the
institution. If this expertise does not exist in-house, an adequate solution may be
to employ consultants with relevant experience to train in-house staff with
scanning and handling.

The scanner operator’s role may also include post-processing or image processing
of the digital file. This may need to be undertaken in consultation with the IT
department. The image will need to be stored (saved) in a predetermined location
that will vary depending on whether it is to be retained for short-term or long-term
use.
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6.11

Preparing the collection for digitisation

Prior to scanning, the negative must be retrieved from its usual storage location,
and its physical condition assessed. During this time the negatives may also need
to have an identification number assigned and any relevant information (such as
provenance, production date, maker etc) linked to this record in preparation for
scanning. In some cases, this would be the role of conservation or preservation
staff. However, other staff, such as registration staff or librarians may have this
responsibility.

Conservation and preservation staff should set guidelines in place to ensure that
staff and outside consultants are adequately trained in handling and preparing
original cellulose acetate negatives during scanning and retrieval.

6.12

Metadata

Metadata is simply a term used to describe ‘data about data’, or information
associated with the image and the creation of the digital file. Metadata should be
easy to read and can be stored in three ways (Frey 2001, p169):
•

In the header of the digital file,

•

In the file name and directory structure (as was used for this research project);
and

•

In a separate database.

Creating meaningful documentation will enable digital files to be accessed and
used in the future, especially when files are being transferred during reformatting
or migration. Required documentation should be specified at the commencement
of the project and should include:
!

Assigned identification (Identifier),

!

Title, Subject and Description,

!

Full documentation of the creators name and date of creation,

!

File properties and format versions, for example, TIFF 6.0,

!

Any post-processing information, if applicable; and

!

Identifying intellectual property rights.
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Metadata can be recorded in a number of ways, for example Frey (2001, p.169)
suggests that ‘although labour intensive, structuring of data in SGML (Standard
Markup Generalized Language) format is considered to be the best way to store
information’. Frey goes on to suggest that XML (Extensible Markup Language)
may replace HTML as the main mark-up language. Dublin Core is regarded as the
most established existing standard for resource discovery metadata at the
collection level, using SGML or XML (Frey 2001, p.169). The National Library
of Australia includes Dublin Core in its guidelines for the Creation of Content for
Resource Discover Metadata, along with the guidelines set out in the Australian
Government Locator Service (n.d).

Incorporating metadata can often be a difficult and time-consuming component of
a digitising project. As Julie Faulkner, Library Digitisation Project Manager at
ATSIC (Australian Institute of Aboriginal and Torres Strait Islander Studies)
points out ‘Initial difficulties have been deciding on metadata and how to
apply/embed it as it needs to be decided upon at an Institute wide level’
(‘Australian digitisation projects’ 2000).

Administrative assistants should be assigned to create and maintain metadata and
should ensure that information is continually updated. This information should
include any post-processing, image processing, cataloguing or ‘accessioning’
information. Colet (2000 p.11).

As funds are usually limited and scanning is a repetitive task, the scanning
operator could undertake the creation and maintenance of metadata during
scanning. This approach is supported at the National Library of Australia (JeongReuss and Engram 2002, p.230). A workflow that includes different duties being
incorporated into the scanning operation keeps the task of scanning more
interesting and hence limits the likelihood of error. It also addresses a number of
OH&S concerns, such as the repetitiveness of the scanning operation.

80

6.13

Components of the Imaging system

Components of hardware or software required for the project need to be assessed
by the institution and incorporated, as a set of guidelines, into the Preservation
Management Plan. The level and quality of digitisation required will be
dependent on the intended use of images (Triantaphillidou and Jacobson 2001,
p.160). These factors (along with the amount of funding available) will have a
material impact on the decisions made, such as whether the image will be
captured using a flatbed scanner or a ‘high-end’ digital camera.

The type of imaging (capturing) system selected will be determined by the
required image quality and size, the number of negatives to be digitised, and the
acquisition speed needed to process the images.

An imaging system should incorporate either separate or integrated devices,
known as hardware and software for processing, and include;
•

Acquisition and Image processing,

•

Compression, used to reduce the storage space required for the image,

•

File format and storage, and

•

Viewing, Display and Printing.(D’Amato 2000, p.6).

Image acquisition systems, such as scanners, should be fully tested before starting
the project. This can be carried out using available test patterns, and a number of
sample scans of the negatives should also be taken.

Guidelines regarding the most appropriate hardware, software and file formats
will not be covered in detail in this thesis, as these are dependent on the issues
already outlined in this chapter. However, as Colet (2000, p.1) suggests ‘one
should digitize at the highest level of quality affordable to minimise the need to
re-digitize’. This approach is supported by Colin Webb at the NLA (2000, pers.
comm., May).
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6.14

Image Quality

Image processing can result in a loss of image quality at the time of capture and
during subsequent processing. Estimating the degree of acceptable loss, and the
degree of likely loss should be carried out before the digitisation strategy is
decided upon (Frey 2001, p.168). The institution should ensure that the
importance of image quality is fully understood and steps have been included in
the Preservation Management Plan to ensure that the greatest image quality
available can be captured at the time the digital file is created.
Factors that can affect image quality include:
•

The quality of the original negative,

•

The quality of the intermediate reproduction (if one exists),

•

The manner in which the negative is digitised and the parameters which have
been selected,

•

Image processing and compression algorithms chosen,

•

The use of image-processing, such as reformatting, resampling or reduction of
quantisation levels,

•

Hardware and application software used to view the image,

•

Quality and configuration of the monitor or printer used to view the image;
and

•

The viewing environment (D’Amato 2000, p.4).

It should be noted that not all of these factors can be controlled. Determining what
the expectations of the project are may help in setting the parameters for image
quality: ‘It can be helpful to ask the user whether their expectation are met when
comparing the digital master with the photographic original’ (Frey 2001, p.168).
For example, there are currently a number of digital image files in institutions
which were created using early version formats, such as video-disks. These were
not of the highest quality, as technology at the time did not allow for optimal
image quality to be captured. There are also poor quality images, which have
resulted from them being saved using a lossy compression file format. Although
the files are still available, they are usually only suitable for ‘documentation
identification’ (web access) and not for publication or to be used as a preservation
surrogate for the original.
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Image quality should be measured and maintained both during the conversion
process to a digital image, and during subsequent processing and migration.
Measuring image quality, using known patterns or test patterns or targets, can
often be automated and incorporated into the scanning process and performed
infrequently (D’Amato 2000, p3). The impact this has on the time involved in
digitising material is minimal and it is often carried out when a large number of
items are digitised (D’Amato 2000, p3).

To reduce the risk of poor image quality, a high-quality digital master image
should be archived as a raw image file at the time of capture (Frey 2001, p.168).

6.15

Speed

Transmission speed and the amount of time allocated for scanning and acquiring
relevant information associated with the image (metadata) should be a primary
consideration when embarking on digitisation.

Access and retrieval time (of the digital image) will have a significant influence
on project costs. Costs will be greater if images need to be available within a few
seconds, or on-line, when compared to being available within a few minutes or
hours if offline (Frey 2001, p.170).

The speed at which images are viewed and scanned will be determined by the
needs of the institution and will depend on the original image size. What is
deemed acceptable needs to be determined before digitising begins, as this may
impact on the level of digitisation at the beginning of or during the project.
As noted by the Australian War Memorial, ‘Quality (level) of resolution may
affect our future actions. Speed of technological change and growth of public
expectations’ (‘Australian digitisation projects’ 2000).

6.16

Quality control

As with any copying program, once a surrogate image has been produced it must
undergo a quality control inspection. This will ensure that all the efforts put into
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scanning and digitising are being undertaken using strict guidelines, hence
reducing the incidence of errors. These guidelines should be set out at the
beginning of the project and incorporated into the Preservation Management
Plan. Digital images can be calibrated and inspected in batches using available
calibration tools, to make the task of calibration easier.

6.17

Lighting, Ventilation and Viewing

The work environment should have appropriate ventilation and lighting. Airflow
and ventilation is important as this will ensure that any acetic acid build up in the
work area, resulting from deteriorating negatives, will be reduced.

Lighting should be appropriate and a neutral colour space installed to provide an
optimal environment for making any adjustments to the digital image. Halogen,
HMI, strobes, and voltage regulators should be installed to control fluctuations
occurring during scanning (Colet 2000, p.12).

A lightbox should be used to view the cellulose acetate negatives, in order to
compare them with the digital image. To prevent any fingerprints forming on the
negatives over time (resulting from poor handling) and to prevent acetic acid
reacting with skin or eyes and causing irritations, latex or cotton gloves should be
worn at all times when handling the negatives.

6.18

File Formats

It is important with any digitising project that the file formats and size of the
images required are established in conjunction with and after considering the role
of the institution and collection. A selected file format should be flexible,
powerful, and able to accommodate a wide range of compression techniques.
Multiple numbers of file formats are available, but the format chosen should be
non-proprietary and officially published by an international standard making
organisation. It should also be widely supported by computer software
applications (Brown 2000 p.8), for example it should not be dependent on any
particularly software to read the file.

84

Acceptable formats include JPEG and TIFF, both which are openly available and
in the public domain. Consideration also needs to be given to compression ratios
(as mentioned in section 5.7.2).

According to Frey (2001, p.169), ‘Of the currently available formats, TIFF is the
one that can be considered most archival’. TIFF is recommended as it is seen as
being a versatile, platform-independent and an open file format which is nonproprietary (Frey 2001, p.169).

Selected file formats should meet the requirements for authenticity by preserving
the content (data and structure) of the record and inherent content information.
The formatting of digital records should also have significant information value to
preserve the look and feel of the information (Brown 2000). The software and
format combination, and whether it will allow metadata to be converted in the
future, should be given consideration.

Organisations in Australia digitise on a variety of formats and for different
purposes. This is evident when reviewing comments made from a number of
institutions that provided information to the Australian Digitisation Projects
(2000). This website was set up under the NLA Australian Libraries Gateway
program to keep up with developments in digitisation and to enable those in
Australia (undergoing digitisation projects) to share their experience and
expertise. Although not all the organisations had completed a formal digitisation
policy prior to beginning their project, those that had were doing so internally or
were in the process of setting up guidelines.

6.19

Storage and transfer mediums

The storage media chosen for storing digital files should be appropriate for the
amount of information (image data) being stored, the quantity of data, and the
physical size of the storage facility.
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Storage and transfer mediums (or devices) include CD-R (compact disk- read
only) and CD-RW (compact disk read write), DAT tape (digital audiotape),
Internet, Intranet, and mass storage systems with a networked dedicated server.

Ensuring that an appropriate system is considered at the beginning of the project
is as important as deciding on which scanning equipment is purchased. Cost, file
sizes, and access requirements will help determine what is the most appropriate
storage for the project. The format chosen should meet the requirements of the
institution and its long-term goals; these will vary between institutions. For
example, the Centre for Archaeology UK uses DAT (Digital Audio Tape) for
storing preservation copies and CD-R for security and working copies (Brown
2000). This may not be appropriate for a large image archive due to the large
number of CDs that would be required, but it was chosen as an appropriate
storage format (based on the needs) for this institution.

When selecting a relevant storage format, (in this case a CD-R) Brown (n.d.)
posed the following questions:
•

Is the format supported?

•

What amount of information can be stored?

•

How difficult is it to alter or erase the information?

•

Is it in wide use at the institution and at other institutions?

•

How does the stability of the material rate over time?

Media and supporting software and hardware which are mature and hence stable
and which are well established in the market place (Brown 2000) should be
chosen (rather than cutting edge technology that is still changing). This will
ensure that the media, software, or hardware has been used and supported for a
number of years and has proven itself as ‘reliable’.

This view is supported by Frey (2000a p.13) who states that:
‘Much has been written about the stability of digital storage media, and several
reports and test results are available. However, standardization in this area is still
lacking, and it is often difficult to compare the results of different tests’.
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The longevity of the media chosen will ensure that access to the digital files
(created) is continued. An important consideration is of that of who has
responsibility for this function. According to Brown (2000), media should have a
proven life span of at least 10 years. He also believed that a greater longevity
might be irrelevant due to technological obsolescence or physical deterioration of
the media itself.

6.20

Preservation of the Technology

One of the major problems associated with digitising projects is technological
obsolescence and maintaining the ongoing availability and compatibility of
software and hardware. Unlike cellulose acetate negatives, which are accessible
and can be viewed even after fifty years (although their physical condition may
vary); digital files require ongoing maintenance to ensure the information is
available over time especially in light of the constantly changing technological
environment. This view is supported by Frey (2001 p.170) who believes that
‘New versions of software products have a lifetime of at most a year, and
computer hardware seems to become outdated in the time between ordering and
receiving the hardware’.

Digital files remain at risk of becoming obsolete due to technological changes and
incompatibilities. This potential inoperability in terms of the software remaining
able to read and convert file formats created by another similar package, may lead
to information loss in the future. There are currently no guarantees that digital
files will be able to be opened in the future, particularly when dealing with
proprietary formats. Current “guaranteed” conversion usually applies to backward
compatibility with recent software, and not to future implementations nor to past
software versions.

A compounding issue is that the storage media is susceptible to physical damage
resulting in informational loss or compromised files. As such, they ‘require active
and regular maintenance of the data’ (Frey 2001, p.167). Along with software and
storage media, hardware and operating systems can also become obsolete which
can impact on the long-term preservation of the digital file. Inoperability problems
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can manifest themselves when opening files created or stored on an earlier version
of software or storage device. Converting from the latest version of software to
the most recent (format or software) in order to view them is usually possible.
However, converting a file created on a much earlier version may be problematic.
An example of this limitation (with emerging technology such as software and
hardware) can be seen when attempting (today) to locate a WORM player to view
images stored on a video-disk. Functioning WORM players are now relatively
rare.

Brown (2000) suggest ‘that though some manufacturers promise a 200 years
security of data preservation of their product, according to general
recommendations the computer data on CDs have to be copied every ten years on
average to ensure their secure preservation’.

To ensure that files are available in the future, images and associated metadata
need to be regularly transferred, updated, or converted. As Triantaphillidou and
Jacobson (2001, p.164) noted ‘It is impossible to rely on the hardware and
software (H/S) used to read, write and store the digital images being available in
the future’.

Determining a strategy that would ensure changes in hardware and software
would not adversely impact accessibility to the image is imperative. Although the
ideal solution would be to collaborate with software and hardware manufacturers
to determine the strategies this is not yet a practical reality. As such, defining,
testing and considering all the potential pathways is required prior to digitising. to
ensure digital images are available in the future.

Migration is a widely recommended and adopted strategy and involves the
transfer of images from one hardware or software configuration (or generation) to
another (‘Managing electronic records’ 1997, p1). This is done whilst preserving
the associated features and minimises the risk of compromise. File names and
content information may be lost if the migration strategy is not appropriate. In the
United Kingdom, the Centre for Archaeology has chosen to implement a
preservation strategy based on migration, using the minimum number of possible
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“archive” file formats necessary to manage data created, and where possible using
standard formats (Brown 2000 pp.3-19).

Emulation relies on the development of software that is designed to copy the
operation of an obsolete hardware platform and operating system, originally used
to create the file. Some emulators have been developed for specific hardware
platforms, but technical problems make it difficult to emulate data across all
platforms.

A refreshing program can also be used, once the life expectancy of the storage
media is reached or will be superseded. In this case the preservation master (that
has been created during the refreshing process) can be checked and used to access
the digital information.

6.21

Copyright

Regardless of the aim of the project and the purpose of the digital files, copyright
ownership of the original images need to be established at an early stage. This is
particularly important when the future use of the files has not been determined,
and those uses may hold some impact for future legal ownership claims.

6.22

Security

The issue of security is important; particularly when a substantial investment has
been made in terms of the time and funds devoted to the creation of the digital
image files. Securing images will afford protection from:
•

files becoming compromised or altered,

•

viruses or ‘hackers’ infiltrating the database or archive and altering or erasing
information, and

•

disasters destroying the collection; for example, flooding or fire.

To protect information stored on an external storage device (such as a compact
disk), images could be produced as Read-Only files, or could have a similarly
reliable write protection mechanism to prevent informational loss (Brown 2000).
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A tier structure, similar to that produced for the preservation copying of
traditional formats (such microfilm and motion picture) should be considered for
digital image files. This involves the creation of three (typically in traditional
copying programs) copies or generations. If resources (funds) allow, three digital
copies of the image file should be created for various purposes (uses). These, copy
1 and 2, should be stored in separate physical locations (Brown 2000) to ensure
they are secure. These copies could be known as:
1. the Preservation master,
2. the Security master; and
3. the Working copy.

6.23

Standards

Due to the rapid changes in technology over the last ten years, the establishment
of digitisation standards has proved difficult. According to the National Library of
Australia, ‘The emergence of standards is likely to be slow in the area of
strategies intended to maintain access to large collections of digital resources,
such as migration and emulation’ (‘NLA Standards activities’ 2002).

Although outright standards regarding the long-term preservation of digital image
files do not exist, the Joint Information Systems Committee (JISC, UK) has
recently established a digital preservation focus on the ‘development of practices,
policies, and strategies for the preservation of digital material’ (Brown 2000).

In Australia the NLA monitors the development of archiving models with an
emerging standard, such the Reference Model for an Open Archival Information
System (OAIS). It is also involved in working on ‘best practice guidelines’ on a
number of digital archiving issues with a number of other organisations. These
include the RLG/OCLC Digital Archive Working Group, and the Council of
Directors of National Libraries (CDNL) (‘NLA Standards activities’ 2002).
6.24

Auxiliary Benefits

There are generally other benefits associated with digitising collections. These
include:

90

!

The development of professional skills and infrastructure within the institution
through training,

!

The development and support of research; and

!

The promotion of access and appreciation by the public of both the original
and the surrogate (digital) image (Brown 2000).

6.25

Summary of Chapter 6

Regardless of the purpose or level of digitising chosen to create surrogates, great
importance needs to be given to the long-term management of digital files.
Digitising projects require the long-term management of, and financial
commitment to both the original negatives and the digital surrogate. To ensure
that the needs and goals of the institutions (regardless of size) and are clearly
defined, incorporating all these issues into a well thought out Preservation
Management Plan is essential.

As the cellulose acetate substrate undergoes physical change over a period of time
(making it difficult to view), digitisation may offer a solution for accessing these
images in the future. However, provisions need to be made in a Preservation
Management Plan for the preservation or disposal of the original (cellulose
acetate) negatives.

The plan should also include guidelines for the ongoing management of the digital
images, along with information on the most appropriate method of capturing,
storing, and archiving the images. The roles, expertise, and number of staff
required for the project should also be included. Additionally, standards or ‘best
practice’ methodology (as they relate to the institution) should be followed
whenever possible. Although the strategies outlined in this chapter include are
being undertaken predominantly by larger institutions (such as the NLA) the
principals discussed are applicable to smaller institutions. This author (of thesis)
acknowledges that this will be limited by the availability of funds, expertise, and
equipment.
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To test the effectiveness of a Preservation Management Plan, a pilot project
should be set up prior to digitisation the cellulose acetate negatives. This will
assist in resolving any problems prior to embarking on a more expensive project.
The issues and decisions made will be determined and influenced by the role of
institution, the collection, the collection management policy at the institution, and
funds and resources available.
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CHAPTER SEVEN
SURVEYING: DETERIORATION IN AUSTRALIA
The scope of cellulose deterioration in Australia was assessed through a
questionnaire devised as part of this research in collaboration with the National
Library of Australia (NLA), see Appendix 1. The questionnaire was undertaken as
part of the Cellulose Acetate (CA) Project, an initiative by the NLA. The author of
this thesis was the principal researcher in the first stage of Cellulose Acetate (CA)
Project. The aim of the project was to determine the extent of cellulose acetate
deterioration in Australia, and to gain an insight into the strategies being used to
manage these collections.

Using a questionnaire, information was obtained from a number of cultural
institutions regarding their holdings of cellulose acetate collections. Information
was sought and obtained regarding a number of cellulose acetate formats,
however only the results pertaining to cellulose acetate negatives are discussed in
this thesis.

The responses to the questionnaire found that 4x5 inch negatives were the most
common format showing signs of deterioration. As a result, this format was
chosen for the case studies examined in this research thesis. This section outlines
some of the findings from the questionnaire.

7.1

Survey methodology

The questionnaire was devised with input from a work group team at the National
Library of Australia. The workgroup consisted of staff from Preservation
Services; Hilary Berthon, Colin Webb, Lydia Preiss, Kevin Bradley, and
Angeletta Leggio, the principal researcher. The questionnaire was drafted by the
principal researcher and refined through discussions with the work group. The aim
of the work group was to ensure that the questions were specific enough to
provide meaningful information.
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The principal researcher determined which institutions were most likely to
provide responses to the questionnaire. A number of the institutions were selected
at random, based on the likelihood that they would have holdings of cellulose
acetate material. These institutions were then telephoned by the principal
researcher to discuss their cellulose acetate holdings and to determine their
appropriateness, ability, and willingness to provide meaningful information to the
questionnaire. Institutions were also chosen on the basis that they required both
regular and/or infrequent access to their collection, and provided a variety of
services to their users.

Institutions were selected from all states of Australia and had varying functions,
sizes, and collecting priorities. Institutions were chosen to include a large
demographic area, as well as an institutional spread. The work group suggested
that all the State Libraries should also be selected for their participation.
Institutions were chosen on the basis that they were;
•

Likely to hold cellulose acetate material,

•

Representative of a geographical area (state) of Australia; and

•

Able to provide useful information.

Results from the questionnaire provided information on the types of formats
(negatives) most at risk of deteriorating and the strategies being used to manage
these collections. The questionnaire and results were compiled over a five-month
period, starting in February 2000.

The survey was undertaken with the support of staff at the National Library of
Australia and Screensound Australia (Research and Engineering Group), who
provided information and feedback during the project. The State Library of
Victoria piloted the questionnaire prior to it being distributed.

Forty questionnaires (in printed hardcopy) were mailed to the directors of thirtyeight selected institutions (see appendix 2), along with a cover letter requesting
their participation. A date for returning the questionnaire was also provided.
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The questionnaire was also available and could be completed online via a link at
the NLA project website <http://www.nla.gov.au/preserve/ca.html>.
The principal researcher telephoned all the institutions to confirm they had
received the questionnaire after it had been sent, and to offer assistance with its
completion, if required. The follow up telephone call, and numerous calls in many
cases, helped ensure the questionnaires were returned and included meaningful
data.

7.2

Results

Thirty questionnaires, of the forty mailed out, were returned. The questionnaire
responses (see appendix 3) indicated that most (28 of 30 institutions) of the
institutions surveyed had holdings of cellulose acetate materials. Two institutions
responded that they were uncertain if their collections contained any cellulose
acetate. Of the twenty-eight institutions, twenty-five had holdings of cellulose
acetate negatives produced between 1925-1970. These were likely to be cellulose
acetate (from question 2A), see appendix 3. It was estimated that in these twentyfive institutions there were a total of 3.6-6.5 million negatives, of which 1.0-2.0
million could be cellulose acetate. These estimated ranges were taken from
responses to questions 15 & 16, where respondents were asked to nominate the
range of quantities of negatives held. Further to that, twenty-two institutions had
noticed either one or more signs of deterioration within these collections (from
question 20).

The signs of deterioration noticed included the vinegar odour, and/or the negative
being ‘'wavy’, ‘channelled’ or ‘wrinkled’, indicative of physical distortion of the
cellulose acetate substrate. The presence of an odour (acetic acid) was the most
common sign of deterioration (20 responses), followed by signs of waviness (17
responses), wrinkling (17 responses) and channelling (15 responses).

Of the twenty-two that reported signs of deterioration, most (17) had seen
problems with black-and-white negatives. It was difficult to conclude whether this
was a result of black-and-white negatives being the most common format in
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collections, or whether they were more susceptible to deterioration than colour
negatives.

7.3

Number of negatives deteriorating

Although respondents were asked to provide estimates of the percentage of
deteriorated cellulose acetate within their collections, only twelve responded to
this question. Their estimates ranged from 2-75% (from question 23).

By calculating the midpoints of these estimated ranges an estimate of the total
number of negatives, the total number of cellulose acetate negatives, and the
number and percentage of deteriorating negatives held by these twelve collections,
was obtained. These have been included in the table below (data taken from
questions 15a, 16, and 23). These are estimates only and do not give a definitive
number of holdings.

Total Number of

Holdings of

Deteriorating

Negatives

Cellulose Acetate Cellulose Acetate Acetate

(any medium)
3,820,001

% of Cellulose

Deterioration
1,115,250

162,856

15%

Although fourteen respondents reported problems with more than one format
eight noted deterioration with only one format. Generally, these collections had a
smaller number of cellulose acetate negatives with holdings of between 50,000125,000 (from question 15A).

Overall the largest number or respondents (17) found problems of deterioration
with 4x5-inch sheet film. It could not be determined from the questionnaire
responses whether 4x5" format negatives were more prone to damage, or whether
this was due to large holdings (or the most common format) within collections. It
was also unclear whether this was also due to the greater surface area involved
with this format size, rendering them more susceptible deterioration when
compared to another formats (such as 35mm). Based on these results 4x5-inch
sheet film was the format found within institutions to be the most at risk of
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deteriorating. This supports anecdotal evidence and the personal experience of the
author of this thesis, who has found similar problems within this format in a
number of Australian collections.

7.4

Summary of Chapter 7

Through the NLA survey (questionnaire) it was determined that a significant
number of collecting institutions around Australia had holdings of cellulose
acetate negatives that were displaying signs of deterioration. Although not a
definitive number, from the results obtained, 15% of cellulose acetate collections
held within institutions may be deteriorating as a result of the vinegar syndrome.

The questionnaire (used for the survey) determined that the most common sign of
deterioration was the physically distortion (referred to as channelling) of the
cellulose acetate negative substrate and a distinctive vinegar odour. The
questionnaire also found that 4x5 inch format negatives were the most common
format found to be deteriorating within collections surveyed. As a result, the case
studies undertaken in chapter ten focused on this format.
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CHAPTER EIGHT
SAMPLE NEGATIVES AND PRELIMARY EXAMINATION
This chapter outlines the tools and equipment used in preparing the images which
were examined in the case studies discussed in chapter ten.

Similar 4x5 inch format cellulose acetate negatives, produced and processed
during the 1980s, were examined in the case studies. As these negatives were the
same film stock and substrate, they displayed similar deterioration features. These
negatives were chosen so that the case studies could focus on one type of physical
feature (channelling).

Selecting one type of deterioration feature for image processing was required to
increase the probability of locating similar characteristics in the negatives. This
was important since the deterioration features varied between negatives.

8.1

Sample negatives

Deteriorating cellulose acetate negatives used for this research were sourced over
a number of years from Australian and the USA by the author of this thesis. The
negatives did not belong to an institutional collection. They (negatives) were
produced by different manufactures (unknown) as they had a variety of notch
codes (used by the manufacturer to describe the film). The specific cellulose
acetate derivative (CDA, CAP, CAB, or CTA) of each negative was also
unknown.

The selected deteriorating cellulose acetate negatives chosen for the case studies
were physically distorted (channelled); However, the anti-halation dyes (see
section 1.1 had not reformed. The negative did not have any other deterioration
features.
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8.2

Examination through the microscope

Prior to scanning two deteriorating negatives were examined under magnification
to:
•

Determine if the deterioration varied on each side of the negative; and

•

To digitally capture the image for image processing.

8.2.1

Method

Each negative was examined using transillumination (transmitted light) under two
separate microscopes. Each microscope was mounted with a digital camera, see
Figure 8.1. By changing the polarisation of the light source, a variety of
illumination angles could be used. This (examination) was done to determine if
the physical distortion (channelling contours) on the negatives could be better
represented by changes in illumination, thereby giving more information for
image processing.

The negatives were captured using a:
•

Zeiss macroscope with X6 magnification, with a Zeiss AxioCam digital
camera attached, and

•

Olympus BX 50, microscope at X40 magnification with a 3 chip CCD JVC
video camera attached.

Figure 8.1. Set-up of the Zeiss macroscope and Zeiss AxioCam digital camera. The camera is
mounted to the top of the microscope and connected to the computer. The monitor was used to
view the area being examined under magnification.
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Figure 8.2 illustrates the image, with the emulsion facing away from the sensor of
the digital camera and towards the light source below, as it appeared under
magnification. In Figure 8.3, where the emulsion is facing towards the sensor, the
negative appears differently when the same area of the image is examined.

It is evident after examining Figures 8.2 and 8.3 that the manner in which the
cellulose acetate substrate deteriorates and distorts (as a result of the vinegar
syndrome) affects each side of the image in different ways. This causes the
surface topographies to differ on each side of the negative. Both images were
captured using the Zeiss AxioCam digital camera mounted to the Zeiss
Macroscope at X1.2 magnification.

Figure 8.2. Emulsion facing down X1.2

Figure 8.3. Emulsion facing up X1.2

Figure 8.4. Detail of an area of the image captured using the Zeiss AxioCam digital camera at X6
magnification. This area is the maximum field of view available.
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Figure 8.4 illustrates how the negative appeared under X6 magnification, and how
the cellulose acetate substrate is physically distorted resulting in a dark line across
the image.

After examining the image (under a number of magnifications) it became apparent
that the area captured was too small to provide enough quantitative data for image
processing. As a result, the use of this imaging system was not examined further
and the negatives were scanned instead, see section 8.3.

8.3

Negatives used in the case studies

Five deteriorated cellulose acetate negatives were scanned; However, only the
following three images were used during the case studies (outlined in chapter ten).
The three images were of the same subject matter; however, the manner in which
they have physically deteriorated and how this affected the image differs.

The cellulose acetate negatives were scanned in early 2000. At that time they were
physically distorted (due to the vinegar syndrome) and had channelled and had
taken on a distinctive vinegar (acetic acid) odour. However, since the time that
they were scanned they have further deteriorated and the anti-halation dyes have
reformed, resulting in blue coloured negatives.

Figure 8.5. The negative identified as 1-1.1
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Figure 8.6 The negative identified as 2-1.1

Figure 8.7 The negative identified as 3-1.1

8.4

Summary of Chapter 8

By examining the negatives it became clear that the variances in topographies,
due to distortion, on each side of the negative could be problematic during image
processing. As the negatives did not have a uniform pattern to the way in which
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the negative deteriorates; making it difficult to apply one filter to all of the
negatives.

It was also unclear whether these physical differences (between the emulsion and
non-emulsion sides) would result in information from the opposite side being
captured during the scanning process, thereby making it difficult to separate the
artefacts, or data, from the deteriorating substrate from the image.
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CHAPTER NINE
IMAGE CAPTURE: PRELIMARY TESTS
Five deteriorated 4x5 inch cellulose acetate negatives (with similar deterioration
properties) were scanned using a Linotype-Hell Saphir Ultra2 flatbed scanner
driven by an Apple Macintosh G4 with 400MHz (CPU speed) and 512MB RAM
on a Macintosh operating system 9.1. This scanner was chosen for two main
reasons:
1.

Accessibility; and

2.

Cost. It was a mid-price ($3500) scanner, affordable for most institutions.

9.1

Scanning Tests

Negatives were scanned using a 14 bit Linotype scanner that internalises to 8 bits,
and which had a maximum optical resolution of 1200 dpi and a density range of
3.3 (log units).

Negatives were placed in a plastic template (or holder) to hold them down flat
during scanning. Although the template was useful (in this instance) it could be
problematic if used on negatives that were brittle. This is due to the manner in
which the negatives are inserted into the holder, which took some practice, and
may cause brittle negatives to break if not inserted correctly.

One negative was scanned twice, once with the emulsion facing the sensor and a
second time with the emulsion facing away from the sensor. Each negative was
scanned in both reflection and transmissive modes. Histograms were then
generated from the digital images to determine whether there was a variation in
image quality and the amount of information recorded depending on which
direction the emulsion faced. A histogram was used to determine the amount of
information recorded.

104

9.2

Determining which side of the negative to scan

The degree of physical distortion (represented as information or data) is not
always visible with the human eye, but can be represented by the histogram.
When an image is digitised, unwanted information or noise can become apparent.
This exists due to random unwanted energy fluctuations being captured (within
the systems) during the production of the image (Frey and Reilly, 1999). This
noise can be captured digitally, and can compromise the image for image
processing functions.

A histogram was used to determine whether any unwanted variations in the
surface topography of the negative (observed under magnification), was recorded
as noise. The histogram indicated that more pixel values were present when the
negative was scanned with the emulsion facing away from the sensor. This
indicated that other information (noise) over and above the original image, was
being included in the scan, see Figure 9.5. When the histograms were compared, a
slight difference in mean was observed.

Since the mean represents the average pixel or grey values, the mean for Figure
9.2 (scanned with the emulsion facing the CCD or sensor) is 67.40. Compared to
Figure 9.4, where the histogram shows the image (with the emulsion facing away
from the CCD) is represented by a mean of 70.56. Although these represented
means only varied slightly, it indicated that there was some information being
recorded during the scanning. This increase in noise (approximately 4.5%)
resulted in a slight compromise to the image. This was due to the density values
on the non-emulsion side (facing the detector) being picked up and recorded by
the CCD or sensor. This is illustrated in the diagram below.
Light sensor
Emulsion

Base

Base

Emulsion

Detector
Figure 9.1. Position of emulsion in relation to the light sensor and detector in scanner, depending
on which side the negative is placed on the glass platen.
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Therefore, the histogram with a mean of 67.40, figure 9.3 (where the emulsion is
facing the CCD) has recorded all the important information or data in the image
and has not been compromised by noise.

From this information it was concluded that to render all the information, or
dynamic range (available in the original negative), the negative should be placed
face down on a flatbed scanner, with the emulsion facing the sensor. This would
ensure optimal image quality. For image processing, ‘copy’ or surrogate negatives
do not give all the data required that scanning the original negative would provide.

Figure 9.2. Image with emulsion facing CCD

Figure 9.3. Histogram of Figure 9.2

Figure 9.4. Image of emulsion away from CCD

Figure 9.5. Histogram of Figure 9.4
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9.3

Scanning for Image Processing

Based on the information obtained as set out in the previous page, negatives
(Figures 8.5-8.7) were scanned with the emulsion facing the sensor and stored as
both 8 bit 0-255 grey scale images and as 24 bit three channel RGB images.
Negatives were scanned using the reflection (Figure 9.8) and transmissive (Figure
9.6) modes. These images (scanned in the two modes reflection and transmissive)
differed visually, but also differed in terms of the amount of information or grey
levels recorded by the scanner’s sensor (CCD).

Figure 9.6. Negative scanned in transmissive mode

Figure 9.7. Histogram, Figure 9.6

Figure 9.8. Negative scanned in Reflection mode

Figure 9.9. Histogram, Figure 9.8

The negative scanned in the reflection mode shows (Figure 9.8) only the
distortion of the substrate with no pictorial information (image) being recorded.
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This is because no transmitted light passed through the negative. As a result the
dynamic range or grey values were lessened, resulting in a histogram with a
reduced mean. This can be seen when it is compared to the histogram of the
image scanned using transmitted light (9.7). The mean represented in Figure 9.9
(reflection scan) displayed a value of 33.67. The mean of Figure 9.7 (transmissive
scan) had a value of 70.06. Illustrating how the image scanned in the reflection
mode did not render or capture all the information present in the original cellulose
acetate negative. Since none of the pictorial values (image) are represented it is
inadequate as a surrogate or as a preservation tool.

9.4

Use of surrogate or ‘copy‘ negatives

Scans were produced of ‘copy’ negatives that had been made (by direct contact)
from the original deteriorating cellulose acetate negatives. These copy negatives
were scanned as it was considered in the initial stages of the research that the
physical distortion of the cellulose acetate negative could interfere with the image
quality. As the negative was unable to sit flat on the glass platen of the scanner,
there resulted an uneven illumination. This conclusion was a function of having
little understanding of how the digital image was being captured and how image
processing would alter the image.

The ‘copy’ negatives produced digital images that did not represent all the visual
features (or data) in the image required for image processing. This was because
the information that differed between the cellulose acetate substrate (which was
raised) and the image, which was flat, was not represented. Therefore copy
negatives were not used for image processing.

The use of a digital camera (although it may have the resolution required) was not
considered as an alternative means of capturing these negatives as it was
considered that this may beside the resourcing scope of some smaller institutions
(and the criteria set for this research project). Operating a digital camera that can
capture the optimal resolution or dynamic range possible requires specialised
equipment and technical knowledge regarding colour management, lighting, and
photography. Cheaper digital cameras available today, aimed at the amateur
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market, usually do not have the resolution required for producing the resolution
required for a surrogate copy to be used for preservation purposes or for image
processing.

9.5

Use of histograms to determine pixel variations

Histograms were also used to determine if there was any difference in the data
recorded when a ‘copy’ negative was scanned compared to that of an original
deteriorated negative. It was anticipated (based on the previous test) this would be
the case. The histograms below (Figures 9.10 and 9.11) represent an image called
‘orig’.

Figure 9.10. Histogram of copy negatives

Figure 9.11. Histogram of deteriorating
negative.

The histograms showed a small difference in the mean; However, a greater
difference would have be expected, as the original negative would have more
contrast than a ‘copy’ negative. However, these histograms show that the copy
contained more pixels than the original negatives. Upon further investigation it
was found that this was a result of the images being scanned at different
resolutions, and problems that occurred when the image file was named. When a
copy of the image was saved, a file name was automatically given to the image
file by the software, listing the name ‘copy’ in the file name extension. This
caused confusion regarding the correct name of the file.
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9.6

Saving Image Files

After the scanning was complete, each digital image was saved on the hard drive
as a TIFF image with a specific name. The name included an identification
number that denoted which original negative had been captured.

For example;
Sample 1-1.1, this was image 1, scan 1: scanned emulsion facing the sensor. It
was saved as trans scan orig 1.1.1.tif
Sample 1-1.2, this was image 1, scan 1:scanned emulsion facing away from the
sensor. It was saved as trans scan 1.1.2.tif
Sample 2-1.1, this was image 2, scan 1: scanned emulsion facing the sensor. It
was saved as trans scan orig 2.1.1.tif
Sample 2-1.2, this was image 2, scan 1: scanned emulsion facing away from the
sensor. It was saved as trans scan orig 2.1.2.fit
Sample 3-1.1, this was image 3, scan 1: scanned emulsion facing the sensor. It
was saved as trans scan orig 3.1.1.tif
Sample 3-1.2, this was image 3, scan: scanned emulsion facing away from the
sensor. It was saved as trans scan orig 3.1.2.tif

This file naming system was determined at the beginning of the process and used
to identify the type of scan being undertaken; for example Scan 1 indicates the
image was scanned the first time. The greyscale digital images were
approximately 25MB in size, and the RGB images 75MB.

Low spatial resolution scanning produced digital TIFF files that were re-sized and
saved as a JPEG image to produce a smaller size image. This enabled the images
to be processed faster. It was anticipated that if initial results were successful the
application could be performed on the larger TIFF image, and any differences
could be picked up at that point.

For quick processing and to eliminate variables being introduced by the use of
colour and the need for colour calibration, only the greyscale images were used in
the case studies.
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9.7

Storage

Images were stored in an internal hard drive on the Macintosh (PC) connected to
the scanner. The images were then transported to another personal computer that
was used for the image processing. This was done by ‘writing’ the images to a
CD-RW. The images stored on the CD were then copied onto a COMPAQ
DESKPRO (PC), where the image processing was performed.

9.8

Summary of Chapter 9

By examining the original cellulose acetate negative under magnification, and by
performing a number of basic tests and using a histogram, the conservator was
able to determine the best method of digitally capturing (scanning) the original
negative.

Examining the negative under magnification showed that each side of the image
of a deteriorating cellulose acetate negative was affected differently by the
channelling resulting from the vinegar syndrome.

By using a histogram it was determined that to digitally capture all the
information or dynamic range present, in the original negative, the negative would
need to be scanned with the emulsion facing the sensor, and scanning would need
to be done using the transmissive mode.

This chapter demonstrates the importance of having some basic knowledge in
how digital systems operate, to ensure that the optimal image quality is being
captured at the time of scanning. Having this knowledge enables decisions, such
as the best method of placing an image on the scanner, to be made confidently and
appropriately. The ability to utilise a histogram also enables a project manager to
pick up irregularities that occur during the image capture process. Careful
consideration also needs to be given to how image files are named when they are
created and saved. This is particularly important when a large number of images
are being generated.
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CHAPTER TEN
CASE STUDIES: USE OF IMAGE PROCESSING TOOLS
This chapter sets out the case studies undertaken as part of this research thesis.
They were undertaken to determine whether image-processing tools could be used
to digitally remove areas of image (digital) which have resulted from physical
distortion. The aim of image processing was to determine whether digital
technology could be used to separate the physical distortion of the substrate from
the pictorial image. It was also the aim of these case studies to investigate the
issues involved in utilising image processing and digital technology, as discussed
in the first part of this research thesis.

The term restoration, referred to in this chapter, is used to describe the removal of
channelling on the digital image file, in which the image quality is improved.
Available filter operations (outlined in section 5.10) were applied to the digital
image (captured of the original deteriorating cellulose acetate negative). All
operations and functions in this chapter were performed digitally on the digital
image, and not to the original cellulose acetate negative.

The case studies utilised two software programs, OPTIMAS 6.5 and the Image
Processing Tool Kit V.3.0, a personal computer (PC) from a CD. Image
processing was conducted on a COMPAQ Pentium 166MHz PC with 160MB of
RAM and a Microsoft Windows 95 operating system. As discussed (in section
5.9), these two packages were selected because the software enables menu-driven
graphical user interface filter operations to be performed on digital images using a
limited number of steps, enabling the operator to perform these functions quickly
and easily.

The use of an angle bracket (>) throughout this chapter has been used during the
case studies to indicate the next sequence, or action, required via a pull down
menu located on the tool bar of the software program. The manner in which the
filter operations are performed are outlined in this chapter and have been
displayed as screen captures. As the operations are similar, the steps have not
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been repeated for each case study, but rather any variations are been mentioned in
the relevant section.

Visualising small changes represented in the frequency space are difficult to view
on a monitor; these are even more difficult in print. As such, the Figures
represented in this thesis have been included in a CD, which is located at the back
of this bound volume.
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10.1

CASE STUDY ONE: USING ADOBE
 PHOTOSHOP


As a preliminary exercise, some basic image processing tools, which were
available through Adobe Photoshop were examined and are outlined in this
section.

The aim of this case study was to become familiar with the concept of filter
functions and the Adobe program. This was carried out because the use of
filters, and what they are actually doing to the image, is an unusual concept for the
conservator. This case study was a good introduction to gain an understanding of
the use of filters and their affect on pixels.

10.1.1 Median, Olympic, and Sobel filters
This case study utilises less powerful image processing filters (in comparison with
the Fourier transform) to determine whether these would be sufficient in digitally
reducing or smoothing the effect caused by the physical distortion. The following
filters were applied to the ‘copy’ negatives (which did not have any topographical
features) scanned in transmissive mode.

Aim
To apply filters to the digital image to reduce or obscure the channelling resulting
from the physical distortion of the original deteriorating negative.

Procedure
Median, Sobel and Olympic filters were applied to the digital image, named 1.1.1,
which was scanned using the transmissive mode. The filters were applied using
the Image Processing Tool Kit ‘and Adobe Photoshop. Operations were
performed in Adobe Photoshop according to the following sequence:
Filter>Rank>Median (to apply Median filter)
Filter>IP* Process>Olypmic (to apply Olympic filter)
Filter>IP* Process>Sobel-Mag (to apply Sobel filter)
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Figure 10.1. Resulting image after median filter applied to digital image, image is now softened
and blurred.

Result of using Median filter
The image after a Median filter was applied, resulted in the channelling being
reduced (making it less obvious); However, it resulted in the image quality being
softened overall. This occurred due to the manner in which the edge pixel grey
value relationship is rearranged by this filter.

Figure 10.2. Resulting image after Olympic filter applied to the digital image.
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Result of using Olympic filter
The use of an Olympic filter has similar results as the median filter. Although the
image rendered, after the Olympic filter was applied, was not as soft or blurred as
Figure 10.1, it the median filter was still compromised. The image quality was
worse than prior to the filter being applied, which was due to the manner in which
the filter operation arranges the pixels.

Figure 10.3. Resulting image after a sobel-Mag filter was applied to the digital image.

Result of using Sobel filter
A Sobel filter was applied to a scan (in transmissive mode) of a cellulose acetate
negative using the Image Processing Tool Kit. This was done for two reasons;
Firstly, to determine whether the filter could identify edges of the (pictorial
information) in the negative; Secondly, the filter was used to determine if the
edges of the cellulose acetate substrate (raised due to cellulose acetate
deterioration) could be accentuated. However, as can be seen in Figure 10.3, it
was not successful, and as a result the areas which were part of the cellulose
acetate substrate could not be determined.
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Summary of Results
All the filters applied to the digital file resulted in the overall image being
softened and blurred; thereby compromising the pictorial image when viewed.
This would be inappropriate for a collection of negatives, as it would result in
images being less legible than prior to image processing.

The filters (Median, Olympic, and Sobel) were selected because initially, they
appeared useful. However, the filters examined proved inappropriate for this
application (of digitally removing channelling). In part, the filters selected were
based on insufficient knowledge and the problems associated with learning and
understanding a new language and concepts of image processing.

10.1.2 Image arithmetic
Two negatives were scanned; one with the emulsion facing the sensor and the
other with the emulsion facing away from the sensor. The image scanned with the
emulsion facing away from the sensor, was digitally rotated and flipped, and the
image then subtracted from the other image.

Aim
To determine whether subtracting the image, from itself, would remove the visual
effects of distortion (channelling) in the digital image.

Procedure
The experiment was conducted using the ‘copy’ negatives named trans scan orig
1 600 (of image 1-1-1), see section 9.5 for examples of naming convention, 600
indicates that it was scanned at 600dpi.

The negatives were scanned in transmissive modes, and then saved. One image
was subtracted from the other using Adobe Photoshop. Image 1-1.2 was
scanned with the emulsion facing away from the sensor to enable an image to be
captured with the channelling affecting the image in a different manner to that on
the opposite side.
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The image (1-1-2) was then digitally ‘rotated’ (edited) in the PC using Adobe
Photoshop. This was done using the rotation tool following this operation
sequence: Image>Rotate Canvas>Flip Horizontal. The purpose of this was to flip
the image digitally so that the image was corrected and in the same orientation as
image 1-1.1.

1.

Open Adobe Photoshop program to perform operation

2.

Open TIFF image >trans scan orig 600.tif

3.

‘Open’ Image>Calculations

4.

Subtract image 1 (source 1) from image 2, the flipped image (source 2).
See Figure 10.4

Figure 10.4. Screen capture of the dialogue box indicating where source 1 and source 2 are
located. An image file must be selected in these boxes labelled source 1 and source 2. to perform
calculations using Adobe Photoshop.

118

Result of subtracting using image arithmetic
Figure 10.5 illustrates the resulting image from the subtraction performing this
operation, and results in problems associated with aligning and registering the two
images. This is evident when a close up of the image (Figure 10.6.) is shown.

Figure 10.5. Problems with registration of the two images.

Figure 10.6. Registration problem evident when area of image is examined.
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The resulting image was compromised due to problems associated with the
registration of the two images. This problem may also be attributed to differences
(or noise) occurring during scanning between the image where the emulsion was
facing away from the sensor (as mentioned in section 9.2). This may have
occurred during the scanning process where a slight difference resulted in a small
due to amount of diffraction occurring, as the light passed through the emulsion.

10.1.3 Constructing images (or negatives) without pictorial values
Images (without pictorial values) were constructed in order to obtain an image
that did not have any image or pictorial areas. This was done to determine
whether applying image processing to an image without these (pictorial) values
would render better results due to the limited number of grey values.

Aim
To construct an image illustrating the channelling (representing physical
distortion in the negative) without any pictorial (image) values by piecing together
an image using photo editing tools available through Adobe Photoshop.

Procedure
This composite image was compiled using Adobe Photoshop from nonpictorial content areas of the deteriorating negative. Areas located along the top
part of the negative, that had uniform grey values (and not image areas) were
added together to make up as new image (canvas). These areas were ‘cut’ and
‘pasted’ into a new canvas.

The edges of this new image, where the various sections met, were blended using
another filter, in the following sequence; Filter>Blur>Blur, to soften the edges,
see Figure 10.7. A median filter was then applied to the resulting image (Figure
10.8) to further reduce the channelling (see Figure 10.8). This was applied to
determine whether the appearance of the channelling could be reduced without
affecting the area in the background of the digital image (which was not
channelled). As had occurred in the previous demonstrations, this resulted in an
overall softened image.
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Figure 10.7. Image composed from non-channelled areas of original image.

Figure 10.8. Composite image with edges softened using a blur filter.

Figure 10.9. Composite image with soften edges and a median filter applied.

Result of applying a filter to an image without any pictorial values
When comparing the two images (Figure 10.8 and Figure 10.9), it is evident that
some of the channelling has been reduced. However, as was the case with the
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other filters, the overall image was softened and appeared extremely blurred
where the median filter was applied.

Summary
Performing these case studies using Adobe Photoshop allowed the researcher
(of thesis) to become familiar with the use of basic image processing and editing
tools. It also enabled insight into, and practical investigation of, some of the
theoretical knowledge explored in earlier chapters.

One of the problems that arose from this case study was the complexity of
learning the language associated with digital images and the use of these filters.
Understanding what is occurring or being conveyed conceptually (by the filters),
and how the image is actually affected, can differ. For example, when the Sobel
filter was selected, its identification of edges was interpreted (by the researcher) as
a physical edge and not the edges of the pixels (by the filter). Although this
concept was understood, it was not an intuitive way of relating to the term (for
someone from another discipline). Someone without a computer science
background, such as a conservator, is likely to interpret information regarding the
use of filters in a different manner.
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10.2

CASE STUDY TWO: OPTIMAS 6.5

This case study examines the use of OPTIMAS software. OPTIMAS, which uses
a logarithmic implementation to calculate and perform the FFT function. It is
considered a powerful image processing program produced by Media Cybernetics,
L.P. OPTIMAS can be used on a Windows 95, or Windows 98 platform and
performs optimally on a computer that is Pentium-based (or better) and has at
least 32 Megabytes of RAM (OPTIMAS Online Help).

OPTIMAS 6.51 software costs approximately $6000-$7000, and is used in
conjunction with a Protection key to run the program’s applications. Although it
can operate without the protection key, calculations cannot be performed. An
earlier version of the program (OPTIMAS 5.1) enabled the program to be
operated in ‘demonstration mode’ without the use of a protection key. The
software also comes with a companion book, on-line help, and technical support
to assist with its application.

According to the manufacturers (Media Cybernetics) OPTIMAS ‘provides both a
convenient Windows interface for working graphically with images and its own
comprehensive programming language for generating OPTIMAS-based
applications’. Although this was found to be true in some areas, some applications
involved a number of steps to (operations) to perform a particular function.

OPTIMAS is able to be applied to a number of image formats and can display
multiple images simultaneously, in different image frames or windows. After
loading the images into OPTIMAS, the images can undergo image processing for
enhancement or analysis, either manually or by using filters. This emphasises
features and/or corrects problem resulting from noise.

OPTIMAS allows multiple images to be viewed and manipulated at various
degrees of magnification. An image frame must be opened at all times, and the
program automatically opens an image frame when it is being used. This frame
can be minimised (on a monitor) to remove it from the screen.
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To perform arithmetic operations on an image, the Region of Interest (ROI) has to
be selected and ‘drawn’ on the digital image. The ROI indicates the area of the
image that requires processing or analysis. Due to the manner in which
mathematical algorithm are used to perform FFT functions, the image must be a
power of two.

Figure 10.10 illustrates how an image is affected if the region of interest (ROI) or
image size is not an exact ‘power of two’. As a result only the image in the ROI
was altered when the FFT function was performed on the image.

Figure 10.10. Result of FFT when ROI is not applied to the entire image area.

Although OPTIMAS has the capability of directly acquiring images from a video
source or directly from a camera, the images used in the case studies were
acquired using a scanner and saved as TIFF images on a CD-RW.

OPTIMAS was chosen for the case studies, because it allowed customising via
programming to be implemented enabling functions not available through the
built in filters to be performed. Although this function was available, it was not
examined as part of the case study as the FFT function was rapidly available using
a filter.
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10.2.1 Procedure for using OPTIMAS
Figures 10.11 to 10.16 sets out the procedures for performing FFT functions using
in-built filters in OPTIMAS. This example was used to perform an FFT function
on a padded image (digital) of a deteriorated cellulose acetate negative (Figure
10.20) which was 4256x128 pixels in size. The name of the image file was:
padded image plus channelling.tif

STEPS 1 & 2
1. Open an image in OPTIMAS
2.

Select “File Open Options”. This sets up the parameters for the OPTIMAS
image window, in which an image is placed into prior to working on it.

Each image window in OPTIMAS has its own properties, for example, bit depth,
colour space, and calibration. In OPTIMAS go to: File > File Open Options.
Figures 10.12 to 10.14 illustrate step two, and show how options available
through each of the dialogue boxes differs.

Figure 10.11. Step 1 (screen capture)

Figure 10.12. Step 2 (screen capture)
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Figure 10.13. Step 2: Active Range dialogue box

Figure 10.14. (Step 2: View Range
dialogue box

3. Open image (to be worked on) File> Open Image File
4. Open filters dialogue box: Image > Filters
5. Open FFT dialogue box: Select the “2D FFT” filter, then Select “Open
Control”

Figure 10.15. Step 4: opens the filter options

Figure 10.16. Step 5: selecting the FFT filter

Within the FFT dialogue box set “gamma” to 1.0 and then Select “Forward FFT”
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Figure 10.17 and 10.18 illustrate how the FFT differs when the gamma is
changed. Gamma is the term used to describe brightness and contrast in an image,
expressed as a power law (a mathematical entity). It is used to describe and
control image contrast in an image, predominantly in the mid-tones or grey values
(‘Bits, noise & Problems’ 1999, pp.6-7).

Figure 10.17. Resulting FFT image when gamma is set to 1.0

Figure 10.18. Resulting FFT image when gamma is set to 3.0
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By changing the gamma, the contrast in the image is altered. For example in
Figure 10.17, where the gamma has been set to 1.0, it has a lower contrast value
than that shown in Figure 10.18, where the gamma has been set at 3.0. The higher
the gamma, the greater the contrast.

Figure 10.19. Resulting image after FFT function applied to the image.

6. Save the Forward FFT (resulting image)
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10.2.2 Performing FFT functions using OPTIMAS
To implement an FFT function, the image dimensions must be a ‘power of two’.
However, as few images have these dimensions, the canvas size must be altered
prior to performing the FFT function. To create this new image that is a ‘power of
two’ in size, Adobe Photoshop can be used to create this new canvas to make
an image that is 1024x512 pixels in size. To do this without compromising the
image, the original image was ‘pasted’ into it a new canvas as described in 5.12.1
and shown in Figure 5.9.

The white border (in the new canvas) surrounding the image was selected and
filled with grey values set at a 128 grey value level. This grey value was chosen as
it was the median value of the total grey-level range (256), and as such would not
adversely affect the outcome of a FFT.

Figure 10.20. New ‘padded’ canvas of original (deteriorating negative) after it was selected and
pasted into a new canvas.

Aim
To determine whether the differences, represented by a padded 1024x512 image
scanned in the transmissive mode and a padded image scanned in the reflection
mode, could be subtracted from each other to isolate the appearance of
channelling. This was based on the principal that channelling appears differently
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when viewed in the two modes. The FFT of the transmissive scan was subtracted
from the reflection scan.

Operation using OPTIMAS 6.5
To perform the operation follow the same steps outlined in section 10.2.1:
•

Open unprocessed channelling image

•

Perform a Forward Fourier Transform (FFT) on the image. Close the FFT
dialogue box

•

Remove specific frequencies using median filter

•

Re-open unprocessed channelling image

•

Perform a Forward Fourier Transform, leaving the FFT dialogue box open

•

Open the following: Image > Arithmetic Ops…

•

Choose “Subtract” from the “Function” menu, from within the Arithmetic
Operations dialogue.

To perform an FFT operation using OPTIMAS, the unprocessed FFT image
window needs must continue to be active. From this window, select from the
“Source Images” field within the Arithmetic Operations dialogue, and select the
image window to be subtracted with/or from the other image.

Figure 10.21. FFT of Padded image scanned in Reflection mode
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Figure 10.22. FFT of Padded image scanned in transmissive mode

Figure 10.23. Padded reflection FFT image subtracted from transmissive FFT image

After subtracting the ‘processed’ FFT reflection image from the ‘processed’ FFT
transmissive image, perform an Inverse FFT on the (still) active subtracted FFT
image. Do the following:

Go back to the FFT dialogue box and select the “Inverse” function. This will
invert the subtracted FFT image back to its original spatial domain.
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Figure 10.24. Inverse padded FFT of subtracted image (Figure 10.23).

Figure 10.25. Padded original image for comparison with Figure 10.24.

The frequency spectrum image performed in OPTIMAS is the result of
subtracting the reflected FFT frequency spectrum (image) from the transmitted
FFT frequency spectrum (image).

Results
After performing an FFT operation, on an image that is a ‘power of two’, by
‘pasting’ the image into a new canvas using Adobe Photoshop, this will
enable an FFT function to be performed.

Scanning the negatives by using the two illumination scanning modes,
(transmissive and reflection) represents the channelling (distorted areas) in the
image in a different manner. However, subtracting these two frequency spectrums
from one another does not result in the channelling being (digitally) removed or
reduced without the overall image being compromised and blurred.
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10.2.3 Isolating the FFT using OPTIMAS
The FFT operation was performed and frequencies erased to determine if
frequency values could be selected.

Aim
To determine whether it was possible to isolate frequency values in the image,
(using the FFT function) by erasing frequencies to determine whether values
represented in the FFT could be isolated.

Procedure
•

File>Open image File (Padded trans orig 1024x512.tif)

•

To apply a filter: Image>Filters>2DFFT, click ‘Open Control’, this opens the
2DFFT dialogue box. Select Forward FFT

•

To view frequencies, increase gamma to 5.000 and click ‘Gamma’, then use
the Magnify tool

•

To select frequencies >‘Retouch’ in the dialogue box>Paint. This opens up the
painting tool. To return to the retouching option, right-hand mouse click.

Figure 10.26. Frequency image (FFT) in OPTIMAS with some frequencies erased. Erased
frequencies were located in the centre region of the frequency image.

OPTIMAS is a linear implementation (of frequency) which makes these
frequencies difficult to view. To improve how the frequencies are viewed, they
can be magnified or the gamma can be increased. Increasing the gamma will
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increases the contrast making the frequencies easier to view when the FFT is
performed.

Results
Figure 10.27 illustrates one pixel or frequency being selected using the paint
option. It is difficult to view the frequency distribution due to the manner in which
OPTIMAS implements the frequencies (linear).

Figure 10.26 illustrates how one small pixel (in the centre) erased manually
(digitally) using the ‘Retouch’ tool available in OPTIMAS is portrayed.
Performing the FFT function on the image results in frequency image in Figure
10.27.

Figure 10.27. Frequency or FFT (in the centre) after frequencies erased.

Figure 10.27 illustrates how by removing the frequency, areas representing
channelling are erased. However the manner in which the frequencies are selected
are random, and as such it is difficult to determine what values are represented by
particular the frequencies in the image. This results in pixels being removed, but
areas of white remaining (seen Figure 10.28).
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Figure 10.28. Resulting inverse FFT of Figure 10.27 where frequencies erased. Frequencies
removed with a brush size of 1; brush size options available with the Retouch tool.

The randomness at which frequencies are selected is evident when the number of
frequencies erased (manually) are exaggerated, increased, and selected arbitrarily.
The result can be seen in Figures 10.29 and 10.30 and has a visual impact on the
image. The frequencies (removed) were selected from different areas of the image
as seen in Figures 10.29 and 10.30. In both examples, a number of frequencies
were selected and erased using the ‘Retouch’ tool in OPTIMAS. The brush size
used was varied from the example in Figure 10.27, to cover a larger area.

Figure 10.29. Result of randomly erasing frequencies removing frequencies in the image.
Frequencies (4) were removed with a brush size of 3.
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Figure 10.30. Result of removing frequencies at random affects the image. Some frequencies (4)
were removed with a brush size of 3.

Summary
Utilising OPTIMAS to select frequency values in an image is difficult due to the
manner in which the frequency spectrum is displayed. Selecting, locating, and
isolating certain frequencies within the image is difficult, as they are not easily
visible when viewed in OPTIMAS.

It is difficult to locate specific frequencies in the image that relate to channelling,
as the digital image incorporates all the grey values in the image regardless of
their position in the spatial domain (image). As such, the use of FFT functions
and the removal of frequencies (by erasing them from the frequency spectrum) did
not prove successful as a tool in isolating the channelling.
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10.2.4 Reducing the appearance of physical deterioration using OPTIMAS
This section refers to the digital reduction of physical deterioration represented in
the digital image.

Aim
To determine if the FFT of an image (that was physically distorted- displayed as
channelling) varied from one that had physical distortion visually reduced using
image editing tools in Adobe Photoshop.

Procedure
•

An area of the digitised 4x5″ negative (scanned in transmissive mode) was
selected to obtain Figure 10.31.

•

To reduce the amount of image obscured as a result of distortion, areas
representing channelling areas were manually reduced using image editing
and Stamping tools in Adobe Photoshop. Pixels were edited out in areas
affected, then using the stamping tool, the pixel was replaced with a similar
grey value pixel which did not contain any of the information represented by
the channelling. Image SAVED As >FFT of head with removed channelling
using stamp tool.tif.

•

Using OPTIMAS 6.5 an FFT filter was applied to both images to obtain a
frequency image of each.

Figure 10.31. Digital image of the original

Figure 10.32. Image area after channelling

negative

visually reduced using image editing tools
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Figure 10.33 illustrates how the frequency image appears when an FFT operation
is performed on the original image (using OPTIMAS). Figure 10.34 illustrates the
frequency image performed on Figure 10.32 (using OPTIMAS).

Figure 10.33. FFT of Figure 10.31

Figure 10.34. FFT of Figure 10.32

Results
The resulting FFT images (Figures 10.33 and 10.34) illustrate that the frequency
spectrum representing each image differs when compared to Figure 10.34. Figure
10.33 has a greater area of larger central highlight regions. This indicates there are
a larger number of highlight frequencies (or grey values) in this image compared
to Figure 10.34, which has less highlight frequencies. This is a result of a number
of grey values (representing the channelling) being digitally removed.

138

10.3

CASE STUDY THREE: IMAGE PROCESSING TOOL KIT and

ADOBE
 PHOTOSHOP

The Image Processing Tool Kit (IPTK) uses logarithmic equations to calculate
and perform arithmetic functions (The Image Processing and Analysis Workbook,
Companion to the Image Processing Tool Kit V. 3.0.1996-99). It uses the Adobe
Photoshop interface and is produced and marketed by John and Chris Russ. The
software costs approximately $400AUS and is used in conjunction with Adobe
Photoshop. The software came with on-line help and technical support to assist
with its application. A companion book has also been published and is available to
purchase.

To implement IPTK within Adobe Photoshop, IPTK must be installed in the
“Plug-Ins” directory found in the Adobe Photoshop root application directory.

IPTK can also be used with the standard ‘Image Editing’ application that
accompanies the IPTK software-MicroFrontier's Digital Darkroom ®. It is
supported by the Photoshop ‘plug-in’ interface, thus removing the need to
purchase Adobe Photoshop. However, Digital Darkroom does not have some
of the built-in functions that are available in Adobe Photoshop. These include
the display of the histogram, the ability to separate colour channels, and some
image adjustments. To overcome this lack of functionality, ‘plug-ins’ that provide
similar functions have been written by the developers of IPTK (The image
processing and analysis workbook, companion to the image processing tool kit V.
3.0.1996-99).

The IPTK ‘plug-ins’ do not ‘make Photoshop or Digital Darkroom into a highperformance scientific image analysis program (The image processing and
analysis workbook, companion to the image processing tool kit V. 3.0.1996-99).
However, the software was deemed sufficient for the operations undertaken in the
case studies, and had the advantage of its low cost ($400).
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10.3.1 Image Processing Tool Kit FFT Procedure:
The following examples (as illustrated in Figures 10.35 and 10.36) set out the
procedures on how operations are performed using the Image Processing Tool Kit
via filters that are implemented through Adobe Photoshop.

The procedure outlined was used to perform an FFT function on a padded image
(digital) of a deteriorated cellulose acetate negative (256x128 padded image plus
channelling.tif). To implement this function thorough the Adobe Photoshop
program, the program must be opened prior to performing any operations.

1. Open the image (256x128 padded image plus channelling.tif ) in the Adobe
Photoshop program
2. Perform a Forward FFT on the image
3. Remove specific frequencies that represent channelling. Save this processed
FFT image
4. With the processed FFT image active, choose Filter > IP*2nd Image >Setup
5. Open raw FFT
6. With the raw FFT image active, choose: Filter > IP*Math > Subtract.

Step six subtracts the active FFT image from the processed FFT image, placed
temporarily in the computer memory. This temporary memory location was
implemented using the 2nd Image > Setup function. The resultant subtracted image
is placed in the active image window that had the raw FFT image.

7. To return to the original spatial domain image an “Inverse FFT” needs to be
performed. With the subtracted FFT image active choose: Filter > IP*FFT >
Filter+Inverse.
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Figure 10.35. Opening the image and selecting the filter function required.

Figure 10.36. FFT after filter operation performed on image in Figure 10.35.
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10.3.2 Performing FFT functions using IPTK
Aim
The aim of the experiment was to determine whether the differences represented
in a padded 1024x512 image (scanned in the transmissive mode) and a padded
image (scanned in the reflection mode) could be subtracted from each other to
isolate channelling.

Procedure
Perform the operation on images prepared for FFT functions as outlined in Case
Study 10.1.2−Preparing images for FFT operations. This operation was carried
using the Image Processing Tool Kit.

The same operation on the padded 1024x512 image (as above) was performed
using IPTK.
•

Open the image (256x128 padded image plus channelling.tif )

•

Perform a Forward FFT on the image

•

Remove specific frequencies that represent channelling. Save this processed
FFT image

•

With the processed FFT image active, choose Filter > IP*2nd Image >Setup

•

Open raw FFT

•

With the raw FFT image active, choose: Filter > IP*Math > Subtract

This step subtracts the active FFT image from the processed FFT image that was
placed temporarily in the computer memory. This temporary memory location
was implemented using the 2nd Image > Setup function. The resultant subtracted
image is placed in the active image window that had the raw FFT image.

To return to the original spatial domain image an “Inverse FFT” needs to be
performed.
•

With the subtracted FFT image active choose: Filter > IP*FFT >
Filter+Inverse.

142

Figure 10.37. FFT of Padded image scanned using Reflection mode.

Figure 10.38. FFT of Padded image scanned using Transmissive mode.

Figure 10.39. The resultant FFT image of subtracting the Figure 10.37 from Figure 10.38.

Figure 10.37 illustrates the power spectrum after an FFT function was performed
on the image. The image was created by ‘pasting’ (see section 10.2.2) Figure 9.8
(scanned in the reflection mode) into a new cavas. Figure 10.38 represents the
FFT of Figure 10.40, scanned in the tranmissive mode. These two FFT’s were
subtracted from each other to determine whether the FFT image representing only
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the channelling (the reflection mode scan) could be subtracted from the FFT
image representing the channelling and pictorial image (the transmissive scan).
Figure 10.39 illustrate the resultant FFT image of this operation (subtraction).

Figure 10.40. Original spatial image.

Results

Figure 10.41. Resulting ‘padded’ power spectrum of inverse FFT of the subtraction (Figure
10.39).

Figure 10.41 illustrates the resultant image when the FFT image (Figure 10.39) is
inversed. Although it was possible to subtract the FFT image (scanned using the
reflection mode) from that scanned using the transmissive mode, the image
quality is affected and the image appears slightly mottled.
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Summary
It was possible to subtract the FFT image of an image scanned in the reflection
mode, from that scanned in the transmissive mode (resulting in Figure 10.41).
However, the image quality was affected when IPTK was used to subtract one
FFT image from another. This can be seen when the spatial image (10.41) is
viewed.

Inverting the FFT image using IPTK helped to visualise the different grey level
(or values) to give a better understanding on how channelling seen in the spatial
domain image, is represented in the FFT power spectrum image.
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10.3.3 Isolating the FFT using IPTK
Aim
To determine whether it was possible to isolate values in the padded image (see
Figure 10.40) using a FFT to erase frequencies and determine whether values
represented in the FFT could be selected.

Procedure
Open Adobe Photoshop
•

Open the image which has had an FFT performed on it

•

Using the eraser tool in Adobe Photoshop erase some of the frequencies

•

Inverse the FFT, choose: Filter>IP*FFT>Inverse FFT

Figure 10.42. FFT image after randomly selected frequencies erased from the FFT using the erase
tool.

Results
Utilising IPTK to select frequency values in an image is easy due how the
frequencies are displayed in the power spectrum, which can be easily located.
However, it is difficult to select, locate and hence isolate certain frequencies
within the image. As a result the quality of the image (Figure 10.43) is
compromised. This is due to the manner in which frequencies in the image,
including to those that relate to the to channelling, are represented.
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Figure 10.43. Resulting inverse image of Figure 12.42 with frequencies in FFT erased.

Summary
Utilising IPTK to select frequency values in an image is relatively easy, due to the
way frequencies are displayed in the power spectrum, which can be easily located.
However, it is difficult to select, locate, and hence isolate certain frequencies
within the image. This is due to the manner in which frequencies in the image,
including to those that relate to the to channelling, are represented.

The digital image incorporates all the grey values in the image regardless of their
position in the spatial domain (image). As such, the use of FFT functions and the
removal of frequencies by erasing them (from the frequency spectrum) did not
prove successful as a tool in isolating the channelling. This illustrates the
limitation of the use of Fourier transform Functions, which although useful,
makes it difficult to locate specific frequency values.
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10.3.4 Reducing the appearance of physical deterioration using IPTK
Aim
To determine if the FFT of an image of the negative that was physically distorted
(displayed channelling) varied from one in which the distorted image had been
reduced using image editing tools using Adobe Photoshop.

Procedure
•

An area of the digitised 4x5″ negative (scanned in transmissive mode) was
selected to obtain Figure 12.44.

•

The amount of image obscured (resulting from channelling) in the original
negative were manually reduced using image editing and Stamping tools in
Adobe Photoshop. Pixels were edited out in the areas affected, and then
using the stamping tool the pixel was replaced with pixels of the same grey
value (minus pictorial information). Image SAVED As >FFT of head with
removed channelling using stamp tool.tif.

•

Using the Image Processing Tool Kit (IPTK) an FFT filter was applied to both
images to obtain a frequency image.

Figure 10.44. Digital image of the original

Figure 10.45. Channelling reduced using

negative.

image editing tools.
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Results
Figure 10.46 illustrates how the frequency image appears using the Image
Processing Tool Kit, after an FFT operation is performed on the original image.
Figure 10.47 illustrates how the frequency image appears with an FFT function is
performed on Figure 10.44 using IPTK.

Figure 10.46. FFT of channelling.

Figure 10.47. FFT of reduced channelling.

These two FFT images illustrate that the power spectrum representing each image
differs. The frequencies in Figure 10.46 are over a greater area or radii, than those
in Figure 10.47. This indicates that there are a larger number of highlight
frequencies or grey values in Figure 10.44 when compared to Figure 10.45 which
has less highlight frequencies. This results when a number of grey values
(representing areas of channelling) were digitally removed.
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10.4

Summary of Chapter 10

Performing theses case studies and using Adobe Photoshop allowed the
researcher (of this thesis) to become familiar with the practical use of basic image
processing and editing tools.

Performing a Fourier transform function (such as an FFT) to locate and select
frequencies in the image did not prove successful using either OPTIMAS or
IPTK. Although OPTIMAS and IPTK represented the frequencies within the
image in a different manner (OPTIMAS−in the frequency spectrum) and
(IPTK−in the power spectrum) neither enabled specific frequencies to be
individually selected, in order to remove them from the image.

These frequencies or values were not able to be determined as the FFT identifies
edge gradients (in the image overall) and can not distinguish between those edges
relating to the pictorial image and those representing the channelling. All the
frequencies are represented regardless of their position in the spatial domain.

The case studies were implemented on images that captured using a flatbed
scanner with a 90°angle of illumination. This did not enable topographical
differences (channelling), evident on the deteriorating negative, to be captured.
The limitations of capturing images in this manner was that they (images) were
composed of variant grey value pixels, with similar values, regardless of whether
they made up the pictorial image or represented the channelling. Therefore a grey
value brightness in the image has the same value as other similar grey value
brightness represented in the distorted areas of the negative. As such the use of
FFT functions to remove frequencies by digitally erasing them from the frequency
spectrum (using an erasing or ‘retouching’ tool) is not possible and hence did not
prove successful as a tool in isolating channelling.
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CHAPTER ELEVEN
DISCUSSION
This research thesis investigates not only the extent of deteriorating cellulose
acetate negatives in Australia, but also the use of digital technology to manage
these collections. Research examined the issues involved with utilising imageprocessing techniques and managing the creation and ongoing access to the digital
image files.

The extent of deterioration, as a result of the vinegar syndrome, was determined
through a questionnaire devised in collaboration with the National Library of
Australia. This was the first time a nation wide survey had been conducted on the
extent of cellulose acetate deterioration in Australia.

The questionnaire revealed that 15% of Australia’s cellulose acetate negatives
(based on those surveyed) were deteriorating. This is a large number of images,
which will be difficult to view as a result of the effects of physical distortion
(channelling). It also became clear through the questionnaire that any strategy for
managing deteriorating negatives would need to be cost-effective and accessible
to a range of collecting institutions, particularly smaller institutions in Australia.
The strategy required needed to be practical, accessible to smaller institutions, and
effective on a large number of negatives.

The need for an alternative and cost-effective strategy for managing these
collections prompted an investigation of digital technology through the use of
image processing (via the case studies). Although image processing had been used
for a number of other applications, no institution was utilising it for the digital
‘restoration’ of images in deteriorating negatives. It was considered that using
these techniques (image processing) to digitally select, isolate, or reducing the
affect of distortion of the image could be a successful strategy for managing
deteriorating negatives.
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In order for the conservator to utilise and perform image processing they need to
have some basic knowledge in the use of digital technology, an understanding of
the terms used, and how digital filters operate. Understanding the basic
terminology and concepts used in image processing (discussed further in section
11.4) were the greatest hurdles encountered during this research, as were
accepting technological limitations, and the management of multiple image files.
All digital projects are, by nature, wholly dependent on technology, and the
chosen technology will have a major impact on the success of the project.
Choosing appropriate hardware and software is important when using digital
technology as a preservation strategy. As with any real life project, the image
processing techniques utilised during the case studies were necessarily limited to
the technology and expertise available.

11.1

Specific terminology

Examining the use of filter operations to digitally remove or reduce the effect
caused by the physical distortion of the cellulose acetate substrate brought up a
number of other issues. One of the main issues that arose from undertaking the
case studies was the complexity of learning the language associated with digital
images and the use of filters – that is, understanding what was occurring
conceptually and how the image is digitally affected.

For example, the Sobel filter, as discussed in section 10.1.1, was selected based on
its ability to identify edges. The researcher of this thesis (the conservator) initially
interpreted this as referring to physical edges on the negative. However, it became
apparent that these edges were not physical in nature, but rather this term referred
to the edges of the pixels (or the boundaries) where they met. A term used with
digital technology in which a term used to or understood that may not be one
familiar to someone coming from another discipline, such as the conservator. As
such, it is important to collaborate with someone who has the technical skills
required to implement image processing, and an understanding of how filters
operate.
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11.2

Filter operations

The Fourier transform filter was chosen to digitally select, isolate and, or remove
channelling in the original image. These were represented as frequencies, in order
to visually reduce the effects of physical deterioration.

When the frequency images, Figures 11.1 and 11.2, are compared the manner in
which OPTIMAS and IPTK represent the image differs. This is due to the way in
which the FFT is implemented. The power spectrum displayed in IPTK allows
subtle frequencies to be more easily visually identified. This is not the case in
OPTIMAS, which displays a frequency spectrum. Viewing the FFT image is
easier, visually; using IPTK when compared to OPTIMAS.

Figure 11.1 Resulting frequency spectrum as represented in OPTIMAS.

Figure 11.2 Resulting frequency spectrum (power spectrum) as represented in IPTK.

The role of the frequency image is to represent the number of edge gradients (as
frequencies) which can be used to identify differences (for example, Figures 10.33

153

and 10.34). These frequency images differ when compared. Figure 10.34
illustrates the FFT of an image where the channelling had been digitally reduced,
and Figure 10.33 illustrates the original image without any removal. As a result
there is a reduction in edge gradients (or less highlight frequencies) in Figure
10.34. It is clear from this that any changes or alterations performed to the digital
image changes the grey values and the number of frequencies in the image.

It also became clear during the case study (see section 10.2.3) that the use of an
FFT function for the application (outline in this research thesis) would not be able
to isolate, select, or remove, channelling without compromising the image.
Although Fourier transforms are a powerful image-processing filter, the filter was
not able to select specific frequencies in the image that related only to the
channelling. This was regardless of whether OPTIMAS or were used and if the
FFT was easy to view.

For a conservator without a background in image processing, utilising software
and hardware that is user-friendly is advantageous. It is important that the
software program (and operations) selected for the project, are easy to use and
implement. Both software programs have a window interface that were similar to
how other programs, such as MicrosoftWord, operate using a pull down menu
and a tool bar. However, IPTK was implemented through Adobe Photoshop,
which was familiar to the researcher undertaking the case studies. This is the
benefit of using a program that is familiar and does not have to be learnt. For a
conservator who is only beginning to understand the concepts involved in digital
techniques, this is one less issue to understand and learn.

The implementation sequences or functions for using filters were easier and more
‘logical’ (or ‘intuitive’) for IPTK than for OPTIMAS. It was easier to visually see
what was occurring using IPTK, which was helpful in understanding the concept
being applied through the filter operation.

Although the method of capturing the images (used in the case studies) was
chosen for practical and cost reasons, it limited the types of filter operations that
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could be performed. For example, the scanners 90° angle of illumination was
unable to render topographical information, which is required to enable other
filters, available via the software, to be used.

11.3

Technical expertise

To fully realise the potential and extent of image processing techniques,
collaboration with those skilled in the mathematics involved in image processing
is an advantage. Obtaining technical information that can be easily understood by
the conservator is particularly problematic. This became evident during this
research thesis, as many of the articles written on image processing were far too
technical, and steeped in mathematical theory, which can present problems if
mathematics is not a strength of the project manager. Technical data on image
processing techniques is not written in a language aimed at the conservator. This
makes it difficult for a conservator to consider these techniques as a manner of
managing deteriorating negatives. Similarly, the computer (imaging) scientist may
not understand the problems the conservator is attempting to resolve. As such, it is
imperative that collaboration is established between those with the technical skills
and those with expertise in conservation.

Developing a closer relationship with other disciplines, to collaborate on projects,
is an issue that is currently being examined by a small number of organisations,
including the NLA through the ‘Cellulose Acetate Project’ and the ANICA
(Australian Network for Information on Cellulose Acetate3) discussion list. This
issue was discussed at a workshop on Digital Imagery for Works of Art (DIWA)
held in November 2001. The workshop recommended that ‘Computer Science and
Engineering departments should be encouraged to incorporate in their curricula
imaging problems of use to research scholars in the visual arts’ (DIWA Final
Report 2001).

Investigating the use of digital technology and the issues involved during this
research thesis made it clear that there is a necessity for the conservator to learn
and understand some basic concepts and terms when utilising digital images. The
3

http://www.nla.gov.au/anica/index.html
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need to have access to the appropriate technical expertise was also evident whilst
undertaking the case studies. Although having an understanding of a number of
key terms and basic concepts (outlined in chapter five) was required to begin the
project. The importance of having access to the appropriate technical expertise
was essential. Collaborating with someone with this knowledge (IT background
and experience in using image processing) enabled some of the problems to be
anticipated before they occur. For example, the amount of memory required to
operate numerous image programs is not something the conservator would most
likely know, as this is usually dealt with by IT specialists within an organisation.

Based on the experience of working through the case studies, utilising a Hybrid
system would be advantageous as it allows expertise to be brought in as required,
whilst maintaining decisions to be done internally (at the institution undertaking
the project by the staff).

11.4

Hardware and software

The case studies highlighted a number of other issues, not only those technical by
nature. Not only did it become obvious that an appropriate software program and
application need to be found, how images were generated and managed also
needed consideration. For example, it became evident that if someone unfamiliar
with image-processing software were undertaking a project, IPTK would be the
software of choice of the two outlined. Additionally it was determined early on
that although IDL software could perform a number of applications, skill in
programming would be required to do this. As such, it would be more effective
(cost and time) to utilise a software program that already exists, which does not
require a large amount of additional resources. This is particularly important as
creating digital images of large collections is resource (time and funds) dependent.

Similar to all digital projects, the case studies were limited to the hardware
(equipment) and software available. For example, negatives were scanned at the
scanner’s highest capable resolution (1200dpi). This was done to ensure optimal
image quality for image processing purposes, however it did not render all the
information possible in the original negative.
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11.5

File formats

TIFF and JPEG format conventions were used in the case studies. Images were
scanned and saved in a TIFF format, which was required to implement image
processing. Images required for other purposes were generated and re-sized as
needed and the original digital image was retained as a TIFF file. This image
(orig) was not altered in any way, so it could always be accessed and used without
any compromises. This approach ensures that images are available for a number
of purposes, and rescanning will not be required.

For example, once image processing was completed, the images were saved in a
JPEG format for illustration purposes (to enable inclusion into thesis). Using the
most appropriate storage format is important when digitising cellulose acetate
negatives, particularly when producing high quality surrogates for preservation
purposes. Problems can arise if negatives are scanned prior to them deteriorating,
and the digital files created are insufficient to be used in the future. Negatives can
deteriorate quickly, as seen during this research when the original negatives
deteriorated further over a two-year period.

Reducing the size of the image by using a lossy format (such as JPEG) is similar
to what occurs to images required for online access, or where the emphasis on the
digitising project is access rather than preservation. This enabled more images to
be saved and faster access to the images as the downloading time is reduced.

This is where clearly defined aims established in the initial stages of a digitising
project can help to ensure the correct file format and size, are chosen and adhered
to throughout the project

Ongoing access to the digital file needs must be assured. In the two years that this
research was conducted, access to the files created did not prove problematic. This
was most likely due to the use of standard image files (JPEG and TIFF) which
were supported by a number of software packages on the market.
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11.6

Access, Storage, and Transfer Mediums

As with any digital project involving a large number of image files, managing the
image becomes more complex once the number of images generated increases. A
well thought out ‘naming convention’ needs to be established at the beginning of
the project. For example, the naming convention used for this research
abbreviated the terms according to the type of mode used on the scanner -Trans
(indicating it was a transmissive scan) or Reflect (indicating in was a reflection
scan). One of the images scanned was saved and named the following; reflect
scan orig 1 600.tif. In this example, reflect scan indicated a reflection scan, orig
indicated a scan of the original deteriorated negative, 1 indicated it was sample
number one, 600 indicated it was scanned at 600 dpi, and tif indicated it was a
TIFF file format. What was initially thought as a good system, quickly became
unmanageable once multiple images existed.

Once images were processed (using image-processing techniques) they were
saved under another name, according to the image and the experiment. These
were then placed in file folders on the D drive on the PC according to the date the
image processing was conducted. However, it became clear that accessing these
images was problematic once a large number of images had been generated. For
example, to locate a file, each image had to be opened in Adobe Photoshop, in
order to be viewed, which was time consuming. This was due to the lack of
information in the file name, or the name was too long to view. However, the
amount of information given in the file name was not consistent. Although some
information was recorded in a separate logbook (in a hardcopy form), keeping
information that is intrinsically linked with the image is vital in reducing
confusion and incorrect information accompanying the image.

This lack of standardisation was a result of a number of factors. These included
software automatically including a name, for example, when digital image files
were copied after they were created, the word ‘copy’ was automatically included
in the file name of the copy generated. Also, there was no standard file naming
system established early on, as the problems encountered were not foreseen due to
the lack of experience in dealing with multiple image files. The naming of the
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image files and maintaining the relevant metadata became more problematic as
the number of images increased.

Tracking this information (metadata) would have been better managed if it was
stored separately but linked to the image. In OPTIMAS this was possible via the
dialogue box called file Info. However, this was not done at the beginning of the
project as most of the effort was given to creating and storing the image, and little
thought given to how to this auxiliary information would be stored.

The researcher undertaking this thesis, did not consider establishing an archiving
system in an ordered manner to ensure access to the relevant information
structure, as they did not think it would apply to such a small digital project.
However, through the case studies, this became obvious after twenty images were
created and image processing applied to those images, resulting in subsequent
image. At that point it was determined (through experience) that how these image
files are archived and accessed is extremely important, even for what seemed a
relatively small project.

Storing and transferring the images after they were captured also presented
problems due to the large image sizes generated. Images were scanned and saved
to a CD-R to enable them to be transported to another PC for image processing. In
this case, having a transportable storage medium was vital, particularly because
once the images were compiled into a folder containing a number of images, they
were difficult to transfer via e-mail due to their size.

11.7

Speed

Regardless of the purpose of performing Fourier transforms and other image
processing operations, it is important that these forward and reverse transforms
are performed quickly with minimum image quality loss. To ensure this occurs, a
computer that exceeds the speed and storage space usually required for basic
imaging functions, should be used. Due to the speed required for image
processing and viewing large image files, additional RAM (Random Access
Memory) was purchased for the PC (used during the case studies) to enable faster
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image processing applications to be performed, thereby reducing the amount of
time required.

11.8

Copyright and Security

Prior to beginning the project, copyright clearance was required to use some of the
images. Copyright of the image photographed in the original negative belonged to
a state collection in Australia. Permission was sought and given to utilise the
image and to include it in any publishing material.

Security is an issue in any digital project, and was a concern whilst undertaking
these case studies. This became apparent after a virus entered the PC externally
via an e-mail attachment. Fortunately, none of the images were compromised, and
the problem was resolved through the aid of anti-virus software (Vet Anti-Virus
Software). For large-scale projects with large amounts of funding and time
allocated this can be particularly problematic, as images can be lost or altered.
This may mean that the images generated can no longer be used for their intended
purpose and the funds spent on the project are wasted.

In all the filter operations performed during the case studies, the image quality
was poorer overall after the filter was applied. As a result of the image quality
being compromised, none of the digital images generated could be used as a
preservation surrogate for the original cellulose acetate negative. Although this
research was successful in investigating the issues involved in using digital
images and image processing, the filter operations examined were not deemed
successful as a preservation or conservation tool.

In summary, the case studies showed in practical terms how important it is to
devise a comprehensive management plan prior to commencing a digitising
project. This ensures that all the issues involved in this type of project are well
thought out and any problems resolved. Having a project manger aware of the
issues involved and an understanding of the reason for digitising, on board in the
early stages will assist in the project being successful.

160

CHAPTER TWELEVE
CONCLUSION
Cellulose acetate, used as a substrate for negatives, is prone to deteriorating. This
results in the negatives becoming physically distorted, and channels being formed
in the substrate, making the image difficult to view. The deterioration of cellulose
acetate is autocatalytic in nature and can not be reversed once it has commenced.

Currently, only a limited number of strategies exist to manage deteriorating
cellulose acetate collections. These include lowering the storage environment to
slow down the mechanism of deterioration, producing surrogates of the negatives
prior to them deteriorating, and removing the image from the substrate once it has
deteriorated.

A questionnaire, undertaken in conjunction with the National Library of Australia,
determined that a significant number of cellulose acetate negatives were
deteriorating in institutions around Australia. However, it also highlighted that the
options available for managing these collections were limited.

Utilising digital technology, as a preservation or conservation tool for
deteriorating negative collections, is a possibility. However, it involves more than
just creating a digital image. Whether the images are created for access or to
implement image processing, using digital technology must be regarded an
ongoing and long-term project. A number of complex issues are involved in using
digital images as a strategy for managing deteriorating cellulose acetate negatives.
These include the ongoing management of, and access to, the digital image files.

Over the last few years a number of discussion papers (Colet 2000, Frey and
Reilly 1999, and D’Amato 2000) have been written for conservators wanting to
learn, initiate, and manage digital image project in the conservation field. These
papers make it possible for the conservator to develop some basic knowledge in
the use of digital technology. However, the long-term management
(consequences) of these images must also be considered.
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Research and papers written on the use of image processing to digitally
reconstruct deteriorating cellulose acetate negatives are unavailable, and as a
result research undertaken in other disciplines needs to be examined. Unlike the
papers written on digitisation aimed at conservators, the papers relating to and
discussing the use of image processing techniques are complex and difficult for
the conservator to understand. It is therefore imperative that conservators wanting
to examine image-processing techniques, for the application outlined in this
research, need to collaborate with those from other disciplines that have the
appropriate expertise. This will ensure that the images are generated for the
project, and that the correct application and image capture method is determined
at the very beginning. .

To determine if image processing is useful as a conservation tool, the conservator
needs to gain an understanding of the methodology and terminology required for
undertaking a project involving digital image files. How digital images are
created, stored and accessed, must be understood, to enable conservators to fully
consider the project and the preservation needs of the collection. Collaborating
with other institution to digitise collections and share resources and costs may also
prove useful and the feasibility of this should be considered.

To ensure the long-term preservation of the images created, the expected
outcomes should to be well defined and clearly stated at the beginning of the
project. These aims should be incorporated and implemented through a
Preservation Management Plan. Determining and defining the aims of the project
should be incorporated into the service charter or mission statement of the
institution to ensure that all staff in the institution are responsible for the project’s
success.

12.1

Consideration guidelines for a digital Preservation Management Plan

The following guidelines have been developed and are based on the work
conducted during the case studies. They are based on the practical experience
gained (by the author) and after examining current issues and approached being
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undertaken regarding the long-term management of digital images in the
preservation field.

Giving considering to these guidelines when undertaking a digitisation project is
recommended and should be incorporated into a Preservation Management Plan.
These Guidelines have been suggested as projects vary and there are technological
changes over time. Although each digital project, regardless of the aim, will
differ, these guidelines can still be applied when making decisions.
♦ Set out the clear aims of the project, funds available, level of digitisation, and
appoint a project manager.
♦ Appoint a vendor project manager to operate and manage the digital
equipment, and locate appropriate staff and expertise. This may be the project
manager or a separate person.
♦ Utilise in-house expertise where it exists, such as the photographic and IT
departments, to advise on the technical details of the digitisation project. A
hybrid system, involving internal staff and outside consultants (where
expertise is not available from within the organisation) should be considered.
♦ Involve and communicate with Curatorial staff, Collection Managers, or
Archivists, prior to starting any digitising project to determine the needs of the
collection and the expertise or concerns of the staff.
♦ Involve and liase with preservation or conservation staff to ensure the
collection is kept safe and further damage to the collection is reduced.
♦ Train staff in handling collection material prior to the project commencing.
♦ Locate appropriate external consultants with the desired skills and knowledge
required for a digitisation program, and ensure that in-house staff are trained
and consulted where expertise is lacking.
♦ Locate and ensure funds are available for all aspects of a long-term digitising
project. This will include provisions for the cost of equipment, its
maintenance, and expertise to support it, and the future of the original
negative. Hardware and software that is readily available, performs what is
required, and is within the budget of institution or organisation should be
chosen.
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♦ Prior to starting any digitisation, consult with the IT department on the
capabilities available at the institution at the impact the project will have on
the organisation. Consult with out-side vendors if internal IT support is not
available.
♦ Ensure that someone has the responsibility of establishing and maintaining
image quality standards set out in the beginning of the project through the life
of the project and beyond.
♦ Ensure that protocols exist to create and maintain metadata.
♦ Ensure the ongoing availability and compatibility of software and hardware.
♦ Set up the workspace and workflow in a safe manner for staff and the
collection. This includes ventilation, lighting needs, addressing OH&S issues,
and proper care of the original material.
♦ Ensure that thought is given to the most appropriate storage system for the
digital files created. This should be done at the beginning, prior to capturing
images.

A flow chart has been included in section 12.2 summarising these points.

12.1.1 Pilot project
Regardless of the size of the project (a large-scale or small-scale project or
collection), a pilot project can be beneficial and is recommended. A pilot project
should be undertaken prior to implementing any digitising, to assist in
determining the most appropriate method of capturing, storing, and archiving the
images for the project, and to determine any potential problems.

12.1.2 Storage
Due to the nature of the cellulose acetate substrate, these negatives should be
stored in low-temperature and low relative humidity storage (ideally below 7 °C
and 30%RH) until a decision is made on whether they will be digitised. Cellulose
acetate negatives benefit by lowering the temperature in the storage conditions.

Incorporating the use of passive monitors to identify the level of deterioration
within the collection, access to low temp storage, and the level or quality of
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digitisation required should be determined by the organisation or institution, based
on their needs and the funds available.

Whether cellulose acetate negatives will be stored indefinitely (in appropriate
storage) or disposed after digitising will need to be determined by the institution.
This will be based on their needs and the purpose of their collection, and should
be carried out in consultation with preservation and conservation staff.

Digitising projects are dependent upon the expertise available, and an
understanding of the outcomes expected from the project and the digital images
that are generated. This can often be overlooked in the rush to start digitising. The
focus should not only be to find a solution to the problem at hand, but to devise a
strategy that manages the process of creating and managing access to the images
in the long-term. Regardless of the size of the institution and the number of digital
images created, a Preservation Management Plan is imperative. Establishing
guidelines, such as those outlined in this thesis, will assist in determining the
needs, purpose of creating digital image, and the outcomes expected, relevant to
the institutions for its collection.

The amount of information available regarding the different aspects of utilising
digital imaging systems is vast and at times can be overwhelming. This is made
even more problematic with technology and management ideologies evolving at
an ever-increasing pace. The amount of information available, and knowledge
required to understand and implement all aspects of a digital project is daunting
enough, particularly for the conservator. A pilot project is therefore invaluable, as
it is the ideal manner in which to, not only resolve issues regarding the intended
project, but to become familiar with terms and concepts used in digitising and
image processing.

If digital technology is to be effectively used as a preservation tool, its limitations
and possibilities need to be fully understood by the conservator. They also need to
be able to communicate how best to utilise this technology for the long-term
preservation needs of the collection. Having a basic knowledge and understanding
on which to build on will give the conservator the tools, from which to examine
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innovative uses of digital technology, to meet their needs, such as managing the
problems associated with large holdings of deteriorating negatives.

Although the use of digital technology in the application outlined in this research
was not successful, further investigation into other available filters, using a
different image capture device, may prove useful for future applications.

In any case, to ensure that future image processing applications are possible, and
digital images can be accessed regardless of the condition of the original cellulose
acetate negative (which may deteriorate over time), the digital image should be
captured to the maximum resolution possible (as determined by the institution).
Once captured the image should be protected from loss and the technology used to
create, store, and access the digital file monitored for any changes. This will
ensure that the digital images will be available for future applications of image
processing to reconstruct the digital image.
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12.2

PRESERVATION MANAGEMENT PLAN FLOW CHART
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12.3
•

Recommendations for future work

Investigating whether other image processing filters to determine whether they
can be applied to digitally remove channelling. Although the use of the
Fourier transform filter did not prove successful in selecting particularly
frequencies in the case studies outlined in this thesis, a number of other
available filters may prove useful and worth investigating.

•

Examining the use of other image capture methods may prove useful in
locating features, such as topographical information which will again enable
other image processing filters to be used. This is worth further research.

•

Examining the number of digitising projects evolving from the work
undertaken by conservation or preservation departments (via a survey) may be
worth future research. It would be of interest to the conservation profession at
large to determine how many have been involved in establishing the aims and
procedure being undertaken in digitising project within their institution. The
aim of this research may be to examine whether the aims of the project and the
guidelines set, if any, serve a preservation function. If not, would the
involvement of the conservator have resulted in a different outcome. To date
no research in Australia has been undertaken to determine whether the current
digitising strategies being undertaken around Australia, for managing
deteriorating cellulose acetate negatives, is meeting the preservation needs of
our cultural institutions.

•

Finally, worthwhile of investigation is whether there is a need within
conservation training programs to incorporate a subject regarding the use of
digital images in cultural institutions. This would include teaching basic
terminology, concepts relating to digital images and systems and the longterm management of generated digital files. This will become particularly
relevant as cultural institutions increase the use of digital images in the
preservation, conservation, and collection management field.
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APPENDIX 1
CELLULOSE ACETATE QUESTIONNAIRE

CELLULOSE ACETATE
PROJECT
QUESTIONNAIRE
We urge you to complete the questionnaire online at http://www.nla.gov.au/preserve/ca.html. Part 1 should be
completed. The National Library of Australia encourages you to also complete Part 2.- the additional details
which you provide in this section will contribute to the quality of the results. Please return this questionnaire by
5th May 2000.

Name of Institution:
Address:
Person completing questionnaire:
Position:
Telephone number:
E-mail:
PART 1
GENERAL (circle which applies)
1.
Do you have any cellulose acetate material in your collections?

YES

NO

UNSURE

Do you have any of these materials within your collections?
(circle which apply)
a.
Plastic or Flexible negatives produced between 1925-1970
b.
Motion Picture Film produced between 1923-1980
c.
Microfilm produced between 1940-1985
d.
Microfiche produced between 1940-1999
e.
Reel to Reel Sound produced between 1946-1964

YES
NO
UNSURE
YES
NO
UNSURE
YES
NO
UNSURE
YES
NO
UNSURE
YES
NO
UNSURE
If you have answered NO for Questions 1 or all parts of question 2: you have now completed this survey. Thank
you.

CONDITION
3a.
Has a survey been conducted on any cellulose acetate material in your
institution to determine its condition?
3b.
If YES, specify type of material listed in 2. (eg; flexible or plastic negatives, motion picture
film,
microfilm/fiche, reel to reel sound) that was identified as showing deterioration.

YES

NO

Complete 4a-4c if a survey hasn’t been conducted: (circle which applies)
4a.
Have you identified deteriorating cellulose acetate material?

YES

NO

4b.

YES

NO

4c.

Have you noticed any strange odours, especially a vinegar smell, in the
area where your cellulose acetate collections are stored ?
If YES for 4a or 4b, what type of material listed in 2. is stored in the area?

STRATEGIES
5.
What strategies have you been able to use
for your cellulose acetate collections?
(tick all which apply)

No strategies implemented
Copying (either print, film or digitisation)
Store cellulose acetate separately
Using cool storage
Using molecular sieves
Other (specify)
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6.

7.

What would help you deal effectively
with this problem? (tick all which apply)

What copying activities, listed below, does your organisation use for cellulose acetate materials?
(Indicate if done
in-house). (circle which apply)
Copying to film or
print
Digitising material

8.

Additional expertise and knowledge
Additional funding
More suitable options
No current problem with acetate collections
Other (please specify)

YES

In-house

Transferring sound material

YES

In-house

YES

In-house

Reformatting microfilm

YES

In-house

Are the activities listed in 7. for access purposes (for the public to view)
only, preservation purposes (used as a surrogate for the original) or Both?

Access
Both

Preserve
NA

ACCESS & STORAGE (circle which apply)
9.
Up to what % of your cellulose acetate collections could go into low access off-site storage?
0%
10a.
10b.
10c.
10d.
11.

2%

5%

10%

25%

50%

If you store cellulose acetate material in cool storage (below 16°C),
does the store belong to your institution?
Do you store other material with cellulose acetate in cool storage?

75%

100%
YES

NO

NA

YES

NO

NA

Optional: Please specify which institution owns the cool store you are using.
Optional: Please specify what types of cellulose acetate material listed in 2.
is stored in cool storage.
Please comment on the access requirements for your cellulose acetate collection including the
frequency with which material is accessed, how immediately this access is required, and the range of
access requirements for different material in the collection.

COMMENTS (please attach additional pages if required)
12.
What preservation strategy do you consider to be the most cost-effective solution for managing your
deteriorating cellulose acetate collections, and why?

13.
What issues/constraints need to be considered in developing a strategy for dealing with your
collection?

14.

Are you interested in becoming further involved in a collaborative project with the NLA, to develop
cost-effective solutions to deal with deteriorating cellulose acetate collections? YES or NO Comment,
and state what commitment you or your organisation may be able to give.

Thank you for completing Part 1 of this questionnaire. Details are confidential, but collated results
may be incorporated into a Masters thesis being undertaken at the University of Canberra as part of
the Conservation of Cultural Materials program, or for any purposes which the National Library of
Australia sees fit.
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PART 2
Complete only the sections in this questionnaire relating to cellulose acetate materials that your institution
holds. Ignore sections relating to materials that your institution does not hold. Thank you.
PLASTIC OR FLEXIBLE NEGATIVES
15a.

Estimate the number of negatives (on any medium) in your collection (tick which applies)

1-1000
25,000-50,000
500,000-750,000

1000-5000
50,000-100,000
750,000-1 million

5000-10,000
100,000-250,000
Over 1 million

15b.

How do you calculate the number
of negatives in your collection?
(tick which applies)

16.

Estimate % of cellulose acetate negatives in your collection.

0%

2%

5%

10,000-25,000
250,000-500,000

Number of individual items
Titles
Number of images per negative
Number of strips of film
Other (please specify)

10%

25%

50%

75%

100%

Unsure

17a.

At what temperature and relative humidity are your cellulose acetate negatives stored?

°C

%RH

17b.

If not known, are they stored in a controlled environment?

YES

NO

18a.
18b.

Are cellulose acetate negatives in your collection accessed?
If YES, how often is access to the collection?

YES

NO

Several times a day

daily

weekly

monthly

once a year

Other
(please specify)

18c.
18d.
18e.

Is immediate (within 36 hours) access required?
Are any of the cellulose acetate negatives on open access to the public?
Do you need immediate on-site access to the negatives?

YES
YES
YES

NO
NO
NO

19.

Has a condition survey been conducted on the cellulose acetate negatives?

YES

NO

YES

NO

Have you found plastic/flexible negatives in your collection that
show the following signs of deterioration? (circle below which apply)
wavy

smell like vinegar

wrinkled

channelled

If answer for 20. is NO, do not continue with this section of the questionnaire relating to plastic or
flexible negatives.
21.

Are the deteriorating cellulose acetate negatives: (circle which apply)

22.

What format is the deteriorating film? (circle which apply)

35 mm

Medium format
eg: 6x7 or 6x6 etc

4x5″″

8x10″″

Colour?

panorama

B&W?

Both?

Other
(please specify)
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23.
0%

Estimate % of cellulose acetate negatives showing signs of cellulose acetate deterioration.
2%

5%

10%

25%

50%

75%

100%

Unsure

24.
Complete only the sections in this questionnaire relating to cellulose acetate materials that your
institution holds. Ignore sections relating to materials that your institution does not hold. Thank you.
MOTION PICTURE FILM
24.
Estimate the number of motion picture film (on any medium) in your collection (tick which applies)
1-1000
25,000-50,000
500,000-750,000

1000-5000
50,000-100,000
750,000-1 million

5000-10,000
100,000-250,000
Over 1 million

10,000-25,000
250,000-500,000

**If you hold multiple copies (eg. preservation master, access copy) of a title, please answer the following
questions in this section just for the preservation master.**
25.
0%

Estimate % of cellulose acetate motion picture films in your collection.
2%

5%

10%

25%

50%

75%

100%

Unsure

26a.

At what temperature and relative humidity are your cellulose acetate films stored?

°C

%RH

26b.

If not known, are they stored in a controlled environment?

YES

NO

27a.
27b.

Are cellulose acetate motion picture films in your collection accessed?
If YES, how often is access is to the collection?

YES

NO

Several times a day

daily

weekly

monthly

once a year

Other
(please specify)

27c.
27d.
27e.

Is immediate (within 36 hours) access required?
Are the cellulose acetate films on open access to the public?
Do you need immediate on-site access to the cellulose acetate films?

YES
YES
YES

NO
NO
NO

28.

Has a condition survey been conducted on the cellulose acetate films?

YES

NO

29.

Have you found cellulose acetate motion picture films in your collection that
show the following signs of deterioration? (circle which below apply)

YES

NO

wavy

smell like vinegar

wrinkled

shrinking

If answer for 29. is NO, do not continue with this section of the questionnaire relating motion picture
film.
30.

Are the deteriorating cellulose acetate motion picture films
(circle which apply)

31.

What format is the deteriorating cellulose acetate motion picture film? (circle which apply)

8 mm

32.
0%

16 mm

Colour?

35 mm

B&W?

Both?

Other
(please specify)

Estimate % of cellulose acetate motion picture film showing signs of cellulose acetate deterioration.
2%

5%

10%

25%

50%

75%

100%

Unsure

Complete only the sections in this questionnaire relating to cellulose acetate materials that your institution
holds. Ignore sections relating to materials that your institution does not hold. Thank you.
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MICROFILM
33.
Estimate the number of microfilm (on any medium) in your collection (tick which applies)
1-1000
25,000-50,000
500,000-750,000

1000-5000
50,000-100,000
750,000-1 million

5000-10,000
100,000-250,000
Over 1 million

10,000-25,000
250,000-500,000

**If you hold multiple copies (eg. preservation master, printing master and service copy) of a title, please
answer the following questions in this section just for the preservation master.**
34.
0%

Estimate % of cellulose acetate microfilms in your collection.
2%

5%

10%

25%

50%

75%

100%

Unsure

35a.

At what temperature and relative humidity are your cellulose acetate microfilms stored?

°C

%RH

35b.

If not known, are they stored in a controlled environment?

YES

NO

36a.
36b.

Is cellulose acetate microfilm within your collections accessed?
If YES, how often is access to the collection?

YES

NO

Several times a day

daily

weekly

monthly

Once a year

Other
(please specify)

36c.
36d.
36e.

Is immediate (within 36 hours) access required?
Is cellulose acetate microfilm on open access to the public?
Do you need immediate on-site access to cellulose acetate
microfilm?

YES
YES
YES

NO
NO
NO

37a.
37b.

Is your institution reformatting cellulose acetate microfilm to polyester film?
If YES, are you producing 3 tier generation archival copies? (eg. preservation
master, printing master and service copy)

YES
YES

NO
NO

38.

Has a condition survey been conducted on the cellulose acetate microfilms?

YES

NO

39.

Have you found microfilms in your collection that
show the following signs of deterioration? (circle which below apply)

YES

NO

wavy

smell like vinegar

wrinkled

shrinking

If answer for 39. is NO, do not continue with the section of the questionnaire relating to microfilm (go to 42.)

40.

What format is the deteriorating microfilm? (circle which apply)

16 mm

41.
0%

42.

35 mm

105 mm

Other
(please specify)

Estimate % of cellulose acetate microfilm showing signs of cellulose acetate deterioration.
2%

5%

10%

25%

50%

75%

100%

Have you found cellulose acetate microfiche within your collections, showing signs of
cellulose acetate deterioration?

Unsure

YES

NO

Complete only the sections in this questionnaire relating to cellulose acetate materials that your institution
holds. Ignore sections relating to materials that your institution does not hold. Thank you.
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REEL TO REEL SOUND
43a.
Estimate the number of reel to reels (on any medium) in your collection (tick which applies)
1-1000
25,000-50,000
500,000-750,000

1000-5000
50,000-100,000
750,000-1 million

5000-10,000
100,000-250,000
Over 1 million

43b.

Does this figure include 16 mm Magfilm?

44.

Estimate % of cellulose acetate reel to reels in your collection.

0%

2%

5%

10%

10,000-25,000
250,000-500,000

YES

25%

50%

Note: Do not include disks known as Acetates in the figures above

75%

100%

NO

Unsure

45a.

At what temperature and relative humidity are your cellulose acetate reels stored?

°C

%RH

45b.

If not known, are they stored in a controlled environment?

YES

NO

46a.
46b.

Are cellulose acetate reels within your collections accessed?
If YES, how often is access to the collection?

YES

NO

Several times a day

daily

weekly

monthly

Once a year

Other
(please specify)

46c.
46d.
46e.

Is immediate (within 36 hours) access required?
Are cellulose acetate reel to reels on open access to the public?
Do you need immediate on-site access to cellulose acetate reels?

YES
YES
YES

NO
NO
NO

47a.
47b.

Are you transferring reels to another format?
If YES, please specify format you are using
(eg: cassette tape, CD-R, DAT, polyester reels, etc.)

YES

NO

48.

Has a condition survey been conducted on the cellulose acetate reels?

YES

NO

49.

Have you found reels in your collection that have become brittle
or are suffering form oxide shedding?

YES

NO

If answer for 49. is NO, do not continue with this section of the questionnaire relating to reel to reel material.
50.
0%

Estimate % of cellulose acetate reels showing signs of cellulose acetate deterioration.
2%

5%

10%

25%

50%

75%

100%

Unsure

Thank you for completing Part 2 of this questionnaire. Details are confidential, but collated results
may be incorporated into a Masters thesis being undertaken at the University of Canberra as part of
the Conservation of Cultural Materials program, or for any purposes which the National Library of
Australia sees fit.
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APPENDIX 2
INSTITUTIONS PARTICIPATING IN THE CELLULOSE ACETATE
SURVEY4
ACT Heritage Library
Albany Public Library and Local Studies Collection
Archives Office of Tasmania
Australian Broadcasting Corporation
Australian Institute of Aboriginal and Torres Strait Islander Studies
Australian National Maritime Museum (N)
Australian Museum (N)
Australian War Memorial
Botanic Gardens of Adelaide and State Herbarium Library
Cinemedia
City of Melbourne
Jewish Museum of Australia (N)
Library and Information Service of Western Australia
Macleay Museum (University of Sydney)
Museum and Art Gallery of the Northern Territory (N)
Museum Victoria
National Archives of Australia (Canberra, Melbourne, and Sydney offices)
National Library of Australia
National Museum of Australia (N)
Northern Territory Library and Information Service
Northern Territory Archives Services (N)
Performing Arts Museum
Powerhouse Museum
Queensland Museum
Queensland State Archives
Queen Victoria Museum (N)
ScreenSound Australia
State Library of New South Wales

4

Because a response from one of the listed institutions was received after data had been analysed,
data from this institution was not incorporated into this report; one institution returned two
questionnaires.
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State Library of Queensland
State Library of South Australia
State Library of Tasmania
State Library of Victoria
State Records New South Wales
State Records of South Australia
Tasmanian Museum and Art Gallery
University of Melbourne Archives
Victorian Archives Centre (N)
Western Australian Museum

*(N) Denotes institutions that did not return questionnaires
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APPENDIX 3 Results from NLA Questionnaire

The chart below indicates the states and number of questionnaires distributed
around Australia. Of the and forty questionnaires mailed out requesting

12
10
8
6

Q Sent
Q returned

4

QLD

NT

WA

SA

TAS

VIC

0

NSW

2
ACT

Number of Responses

participation in the project, thirty questionnaires were returned.

States

The chart below shows the results from questions 1, 2, 16, 25, 34, and 44. It
indicates the formats and whether they were held in the respondent’s collections.

Number of institutions

30
25
20
15

YES

10

NO
UNSURE

5
0
Any CA

Negatives

Motion
Picture Film

Microfilm

Microfiche

Reel to reel

Formats

Figure. Number of surveyed collections with (a) any cellulose acetate, and cellulose acetate (b)
negatives, (c) motion picture film, (d) microfilm, (e) microfiche and (f) reel-to-reel sound material
in their collections.
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Glossary
Artefacts
This term is used in this thesis to describe noise or unwanted pixel grey values
that do not relate to image information and affects image quality.

Autocatalytic
A chemical reaction that continues to ‘feed off’ internal (degradation) products to
continue the reaction. This reaction occurs when cellulose acetate negatives
deteriorate as a result of the vinegar syndrome.

Best practice
The continuous process of recognising and documenting strategies used to
undertake a task. This includes learning by providing and accepting feedback and
analysing the tasks that work and those that do not, in order to implement a better
strategy.

Binary number
Also known as bits, binary numbers are represented by numerals; either 1 or 0.
These numbers relate to either a light or dark pixel that make up the image. These
are not numerical values but rather indicate ‘on’ or ‘off’.

Bit/s
The smallest number of data represented by an ‘on’ (1) or ‘off’ (0) is known as a
bit, in a digital image the higher the number of bits the greater the tonal range.

Byte
A grouping of 8 bits is known as a byte.
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Canvas
The space (size) surrounding the original image which can be altered (‘resized’) to
produce a new ‘canvas’ or space that is a different size to the original image.

Charge-Coupled Device (CCD)
The CCD records the image on an array of photo sensors (usually a silicon chip)
and is used to detect and read light as an electronic signal. It converts the image
into an array of electrical charges, which are proportional to the intensity of the
light falling on the image and the light-sensitive square.

Channelling and Wrinkles
Terms used in this thesis to describe planar distortion of the cellulose acetate
substrate resulting from the cellulose acetate substrate (support) shrinking and
pulling away from the gelatine silver halide emulsion.

Composite
A new digital image composed or made up of distinct parts or elements of the
original (digital) image.

Compression
Image compression algorithms enable image information to take up the smallest
possible memory in order to reduce the amount of storage space required. The
most common type of compression is lossy (for example, JPEG) and lossless (for
example, TIFF). Lossless compression eliminates no grey values and can be
reversed to generate the original image without loss, whilst, lossy compression
eliminates very small grey values and cannot be reversed without some
degradation of the image.

Diffraction
The bending of rays of light when they pass by the edges of an opaque object (or
area). This makes the light appear deflected and produces fringes of parallel light
and dark colour bands.
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Direct contact (printing)
A 1:1 scale reproduction made from an image (negative in the case of the
examples outlined in this thesis) to produce another image (negative or positive).

Desktop Publishing
Historically referred to in the graphic arts industry to describe a publishing system
that includes a personal computer (PC), word processing software and computer
generated illustrations.

Digitally quantised brightnesses
The act of converting analogue data (light intensity) to a digital domain.

Dynamic range
The total tonal grey values (or density) representing the contrast and brightness
distribution in the image.

File Info
A ‘dialogue box’ in the software program (OPTIMAS or Adobe Photoshop)
which allows information regarding the image file to be recorded. This type of
information may include; the date a file was created, who created the file, the
image size, or any other instructions pertaining to the file.

Fourier transform (FT)
A mathematical operation where the function (for example, a 2 dimensional
digital image) is made up of sine and cosine wave components. The image is
represented by coefficients that indicate the magnitude and phase of each of the
components. As such, mathematical analysis (image processing) can be performed
on the image.
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Free acidity
Also known as base acidity. It is a way of measuring the total amount of acid
present in the cellulose acetate substrate and is the most sensitive indicator of the
onset of cellulose acetate deterioration.

Frequencies
Grey values represented as pixels that comprise periodic structures.

Frequency domain
An image representation of the Fourier transform.

Gamma
A term used to describe the brightness and contrast index of an image expressed
as a power law (a mathematical entity).

Histogram
A frequency distribution of grey values in an image displayed as a graphical
representation (using a plot).

Hybrid system
Utilising a combination of knowledge, technical skills, and expertise from within
the organisation with expertise from external sources or staff. External expertise is
used where knowledge or technical skills are not available from within the
organisation.

Internalised
Refers to operations applied within the scanner that occur automatically.

Inter-positive negative
A positive image made from a negative for the purpose of producing one or more
duplicate negatives.
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Kernels (Masks)
A group of pixels in a closely defined array, the spatial dimension of the kernel is
a square composed of an odd number of pixels (3x3, 5x5, 7x7. These can be
evaluated (or convolved) over successive portions of a digital image. It is also
known in most cases as a mask. For example, a convolution kernel is applied to an
image to alter its appearance.

Mask
See description of Kernels.

Mean
A term used to represent the average grey value, which is present in the digital
image.

Median
Used in two contexts:
1. Where the word median is written in Italics, it refers to the point chosen in the
image that represent the middle grey values from the range of grey values
available in the image.
2. Where this term is used and there are no Italics, it refers to the use of a Median
filter, which is an image spatial filtering operation based on an input pixel and
its eight neighbours.

Neighbourhood
A filtering process (usually used for smoothing or sharpening an image) that takes
into account neighbouring pixels of the pixel being filtered. These groups of
pixels are called a kernel, and the spatial dimension of the kernel is a square
composed of an odd number of pixels such as, 3x3, 5x5, 7x7.
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Noise
Random and unwanted energy in the system that degrades (or compromises) the
digital image. This random energy is associated with detection and reproduction
systems for example, the scanner or camera.

Periodic structures
Another term used in this thesis to describe noise.

Pictorial values
Tonal values that are present in the picture or image. In. negatives these pictorial
values are represented by silver halides that form the image.

Power spectrum
A frequency domain image that has had its grey values amplified using a power
function (mathematical entity).

Preservation copy
A copy produced for the specific purpose of being used to produce subsequent
copies. To ensure its long-term survival the ‘preservation’ copy should be
protected from damage by storing in a secure and stable environmental. It must
not be manipulated or altered and generally should only be accessed to make
copies and not for general viewing.

Quantisation
Converting analogue data to digital data.

Resampling
Uses algorithms to convert a digital image with a particular number of pixels in
each axis into a new digital image with more or less pixels in each axis. If the
image is made smaller information or data (pixels) is removed. However, data is
duplicated or interpolated using nearby pixel values if the image is made larger
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Restoring/restore
In the thesis referred to as reconstructing or ‘putting back’ the digital image in
order to improve the image quality. This enables the image to be viewed in the
original form intended prior to its deterioration.

Spatial domain
A two-dimension image viewed in the same manner that the human eye interprets
an image.

Spatial frequency
The change of brightness values from pixel to pixel. For example, where different
pixel values are closely spaced the brightness values change rapidly (known as
high frequency), where they are further apart the brightness value changes less
(known as low frequency).

Spatial resolution
A number of pixels representing a defined sampling region (image) captured by a
scanner or camera. For example, a 256x256 pixel region has a total number of
pixels equalling 65,536.

Tier structure
A tier structure that includes multiple (typically 2 or 3) layers or ‘generations’
above the other. Each successive copy of an image is known as a ‘generation’
(within the tier) and is used for a specific purpose.

Unsharp mask
An image processing operation performed using Adobe Photoshop to sharpen
a digital image.
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